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Preface

About This Book

This guide provides the information you need to:

e Configure and manage your MCR-MGT Management Module.

Intended Audience

This guide is for administrators who will be configuring the MCR-MGT Management Module.
Some prerequisite knowledge is needed to understand the concepts and examples in this guide:

e Ifyou are using an external authentication application(s), working knowledge of the
authentication application(s).

® Knowledge of TFTP may be required if this is the method you choose to use as the transfer
protocol of the MCR-MGT Management Module.

Contents of CD

The following documentation is included on the MCR-MGT Management Module Installation CD:
MCRI1900 Media Converter 19-Slot Chassis Installation Guide

SMI Media Converter Installation Guide

MCR-MGT Management Module User s Guide

MCR-MGT Management Module CLI Guide

MCR-MGT Management Module Installation Guide

Installation Guides for all supported Media Converter Modules

The following files are also included on the MCR-MGT Management Module Installation CD:
® MCR-MGTMIB file for SNMP
SetIP utility

® Firmware for MCR-MGT Management Module
® Firmware for all supported Media Converter Modules.
e Copyrights notices

MCR-MGT Management Module, User’s Guide, Version 1.7



Typeface Conventions

Typeface Conventions

Most text is presented in the typeface used in this paragraph. Other typefaces are used to help you
identify certain types of information. The other typefaces are:

Typeface Example

Usage

At the C: prompt, type:
add host

This typeface is used for code examples and system-
generated output. It can represent a line you type in, or a
piece of your code, or an example of output.

Set the value to TRUE.

The typeface used for TRUE is also used when referring to
an actual value or identifier that you should use or that is
used in a code example.

subscribe project subject

run yourcode.exec

The italicized portion of these examples shows the
typeface used for variables that are placeholders for
values you specify. This is found in regular text and in
code examples as shown. Instead of entering project,
you enter your own value, such as stock_trader, and
for yourcode, enter the name of your program.

File, Save

This typeface and comma indicates a path you should
follow through the menus. In this example, you select
Save from the File menu.

MCR-MGT Management Module

This typeface indicates a book or document title.

See About This Book on page 3 for
more information.

This indicates a cross-reference to another chapter or
section that you can click on to jump to that section.




Introduction

About the MCR-MGT Management Module

The following software features are available on the MCR-MGT module.

Accessing the MCR-MGT Management Module

The MCR-MGT Management Module can be accessed through any of the following methods:

MCR Web Manager, a (http/https) web browser
Menu, a window-oriented menu interface

CLI, a Command Line Interface option

SNMP

General Features

IPv6 support

[Pv6 Tunneling though an IPv4 network

Access via Serial, Telnet, SSH, HTTP and HTTPS.
DHCP/BOOTP for automated network-based setup
Dynamic DNS with DYNDNS.org

Domain Name Server (DNS) support

Display preferences (Date, Time, Temperature formats)
Backup/Restore module configuration automatically

Automatically update managed media converter modules to the current firmware version

Management Features

Console port enable/disable function

IP and Mac address filtering
Enable/Disable management services
Management session inactivity timer
Multiple Concurrent management sessions

View and gather link statistics

MCR-MGT Management Module User’s Guide, Version 1.8



Control Features

Control Features

® Remote logging via Syslog
® SNTP (versions 1, 2, 3, and 4 are supported)

® [Email alert notification

Security Features

Authentication using any of the following systems:

—  Local Authentication

- RADIUS

—  Kerberos

— TACACS+

- NIS

—  SecurID

— LDAP/Microsoft Active Directory

Ability to assign users access level rights to control their access
Idle timers, which close a connection that has not been active for a specified period of time
SSH-2 and SSH-1 connections

SSL/TLS connections.

Filter network services

Local event log with filtering per module basis

Additional Features for the MCR1900

Chassis temperature, voltage and fan monitoring
ECO power scheduler feature allows you to set power on/off schedules
Manually power slots off and on

Define a default power state for each slot

Additional Features on some media modules

Quality of Service (QOS)
® Bandwidth allocation via ingress and egress rate limiting

IEEE 802.1p tagged frame priority control

e [EEE 802.1p priority tag remapping
e [P TOS (Type of Service) priority for IPv4 Diffserv or IPv6 Traffic Class frames
® Congestion Service Policy through Weighted Fair Queuing or Strict Priority Queuing

VLAN Tagging
® Rate Limiting on ingress or egress packets

Enable discarding of tagged frames

® Enable discarding of untagged frames
® Removal of existing tag on frames
® Insert tag



Additional Features on some media modules

® Insert double tag

Other
® Unidirectional Ethernet
e Filtering of unknown multicast frames

® Filtering of unknown unicast frames



Setting IP Addresses

SetlP Utility

There a several different configurations methods available to configure the MCR-MGT Management
Module (Management Module). The most important part of setting up the network is assigning an IP
address to the Management Module, whether this is a static IP address, or enabling a DHCP/BOOTP
assigned address. The Management Module is pre configured with an IP address of 10.0.0.10 with a
subnet mask of 255.0.0.0. This will probably not be the IP address schema for your ethernet network,
therefore all of the Management Module configuration methods have the ability to change the IP
address on the Management Module. You should also assign a name to the Management Module to
make it easier to recognize. By default the Management Module does not require a user to login to
configure or manage the module.

This section deals primarily with three ways in which to assign an IP address to the Management
Module.

The easiest method to assign an IP address to your MCR-MGT Management Module is to use the
Perle SetIP Utility. The Perle SetIP Utility will allow you to assign an IP address and/or manage a
predefined Management Module. This utility can be found on the Perle CD that came with your
Management Module. Simply run the SetIP utility by double clicking on the SetIP.exe file. For
security reasons, the ability to set an IP address to a module is only available when the module is in a
factory default state. (i.e. has not yet been configured).

©) Perle SetIP Utility

] Refresh  Filter: (7]
Mame IP Address MAC Address Factory Default
MCR 1900 Lab 1 192.168,170.181 00-80-D4-12-34-57 Mo
MCR1900 Lab 2 192.168.170.182 00-80-D4-12-34-58 Mo
MCR 1900 Lab 3 192.168,170.183 00-80-D4-12-34-59 Mo
MCR1900-123456 10.0.0.10 00-80-D4-12-34-56 Yes

Assign IP address

Assign IP Address

X

(%) Assign IP manually

IP Address: [

() Assign IP using DHCP

[ Assign IP H Cancel

MCR-MGT Management Module User’s Guide, Version 1.8 8



Using CLI commands

Using CLI commands

Using a Direct Serial Connection to Specify an IP Address or to
Enable DHCP/BOOTP

You can connect to the Management’s Module’s serial console port using a PC with a terminal
emulation package, such as HyperTerminal or a terminal.

1.

Using an RJ-45 patch cable and a CISCO RJ45-DB9F-DTE Pinout adapter (Perle part number
04007040), connect your PC or dumb terminal to the console port on the Management Module.
See Appendix , "Console Port Pinout" for cabling diagram.

Using a PC emulation application, such as HyperTerminal, or from a dumb terminal, set the Port
settings to 9600 Baud, 8 Data bits, No Parity, 1 Stop Bits, and No Hardware Flow control.

Press Enter

You should now see a prompt that displays the model type and last 6 numbers of the MAC
address for that unit. for example, MCR-MGT-900634.

To set the IP address, type the following command:

set server internet <ipvé4address><netmask>

Press Enter

Where ipv4address is the IP Address being assigned to the Management Module and netmask
is the subnet mask to apply to the IP address. For example;

set server internet 172.16.4.90 netmask 255.255.0.0

To save the information to non-volatile memory, type the following command:

save
Save config to flash ROM y/n

Type,

y
Lastly, type:

reboot
Confirm reboot unit y/n

Type,

Yy
The management Module will reboot and the IP address will now take affect.

Alternatively, you can enable the DHCP/BOOTP option within the
Management Module.

1.
2.

Perform the steps above 1 through 4.
Using the Command Line Interface (CLI).
Type the following command:

set server internet dhcp/bootp on

Press Enter
Then type the following command:

save
Save config to flash ROM y/n
Type

Yy

Lastly, type:

reboot



Using CLI commands

Confirm reboot unit y/n
Type
y

Connecting to the Management Module’s Internal IPv6 address

The Management Module has a link local IPv6 address based upon its MAC Address. For example,
the link local address is:

Management Module MAC Address: 00-80-D4-AB-CD-EF
Link Local Address: FE80:0280:D4FF:FEAB:CDEF

Using Telnet or SSH you can connect to the Management Module’s IPv6 local link address and
configure the Management Module. By default, the MCR-MGT Management Module will listen for
IPv6 router advertisements to obtain additional IPv6 addresses.

10



Configuration Methods

Introduction

This chapter provides information about the different methods you can use to configure the MCR-
MGT Management Module (Management Module). Before you can configure the Management
Module, you must assign an [P address. See Chapter 2, Setting IP Addresses to find out how to
assign an IP address to the Management Module.

Configuration Methods Overview

Following is a list of methods for configuring the Management Module.
MCR Web Manager
CLI using Telnet/SSH or a Direct Serial Console Connection

Menu using Telnet/SSH or a Direct Serial Connection
SNMP using standard based SNMP tools

Features

Configure Management Module chassis parameters

Configure Network parameters

Configure User accounts and Authentication methods

Configure Alert levels, Email alerts, SMNP parameters and SMNP traps

Configure Access parameters

Configure Date and Time parameters

Configure the Security parameters

Backup and Restore configuration

Update firmware

Reboot the Management Module and any Manageable media converter modules or the Chassis

View and gather statistics while connected to the Management Module

MCR Web Manager

Connecting to the Management Module for the first time

By default, the Management Module requires no login information to gain entry to it. The
Management Module supports http/https with common browsers such as Internet Explorer (version

7

or higher), Firefox (version 3.5.10 or higher), Chrome (version 4.0.249 or higher) and Safari (version

4.0.5 or higher).

MCR-MGT Management Module, User’s Guide, Version 1.8
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MCR Web Manager

1. Open your web browser and type in the IP address of the Management Module that you want to
manage/configure and press Enter. For example: http://10.0.0.10 or
https://10.0.0.10

2. Ifyou successfully connect to the Management Module, either a MCR1900 screen or a SMI
Media Converter screen will appear.

MCR1900

MCR-100634 [» | Slot 4 A Hide Chassis

006L 4O

MCR-MGT

Slot 4 - CM-100-M2SC2

Copper Port | Fiber Port | Alert Log | Advanced | Slot
Name: CM-100-M25C2
Model: CM-100-M25C2
Description: Fast Ethernet Media Converter Managed Module 100BASE-TX (RJ-45) [100 m/328 ft.] to 100BASE-FX 1310nm multimode (SC) [2
km/1.2 miles]
Setup

Configuration Jumper: Auto ¥  Current Switch Settings...

The top portion of the screen (chassis view) will display the chassis and all modules detected. This
will include;

e MCR-MGT Management Module

® Managed Media Converter Modules.

e Unmanaged Media Converter Modules (if any exist).

® Unknown card - Slot powered off when Media Converter Module was inserted.

If any component has an active alarm (severity level “System Level Fault”, “Module level Fault” or

“Persistent Error”), a red triangle will show up on that component. If you place your cursor over the
triangle, the cause of the alarm will be displayed.

Moving your cursor over any module, will place a “magnifying glass” at the bottom of the module. If
you move the cursor to the magnifying glass, you will be presented with a magnified view of the
module in that slot.

Clicking on any module on the top portion will bring up the detailed information on the selected
module in the bottom half of the screen. If a selected module has active alarms, these will be
displayed in the middle of the page. The chassis view automatically refreshes every 30 seconds.

Configuration Methods 12



MCR Web Manager

SMI Media Converter

EﬂE MCR-MGT-200084 May 28, 2013 20:32:34 EDT
p 172.16.113.66 User's Guide | User: admin | Logout
MCR-MGT-900084 [» | Slot 2 SMI-110-52LC120 & Hide Chassis
Slot 2 - CM-110-S2LC120
Copper Port || Fiber Port || Alert Log | Advanced Slot
Name: CM-110-82LC120 ¥ Details
Model: CM-110-52LC120

Description: 10/100 Fast Ethernet Media and Rate Converter Managed Module. 10/100BASE-TX (RJ45) [100 n/328 f] to 100BASE-X 1550nm
single mode (LC) [120 km/74 4 miles]

CM-100 Media Converter Module

Hardware Setup
[cunﬁgumniunJumper:Amn #  Current Switch Settings }

Settings

The top portion of the screen will display the installed MCR-MGT module and the detected media
converter module.

If any module has an active alarm (severity level “System Level Fault”, “Module level Fault” or
“Persistent Error”), a red triangle will show up on that module. If you place your cursor over the
triangle, the cause of the alarm will be displayed.

Clicking on any module on the top portion will bring up the detailed information on the selected
module in the bottom half of the screen. If a selected module has active alarms, these will be
displayed in the middle of the page.

Configuration Methods 13



MCR Web Manager

Using WebManager

Click the MCR-MGT Management Module.

EﬂE MCR-100634 October 06, 2010 12:46:23 EDT
p 172.16.22 30 User's Guide | User: admin | Logout
MCR-100634 [» | Slot 4 R R R

LT
ee

F =
5 @]
nl A
o
o
o
o

. CxAD00 | Cx-A110 | . CxAD00 _ Cx-1110

Slot 4 - CI-ToeERSC2

Copper Port Flevanced Slot

Name:  CM-100.M25C2 MCR-MGT Management Module

Model: CM-100-M2SC2

Description: Fast Ethernet Media Converter Managed Module 100BASE-TX (RJ-45) [100 m/328 ft ] to 100BASE-FX 1310nm multimode (SC) [2
km/1.2 miles]
Hard Setup
MCR-MGT-900084 May 28, 2013 20:32:34 E[
perie P User's Guide | User: admin | Logo
MCR-MGT-200084 [» | Slot 2 SMI-110-S2LC120 G aeChanse

Chassis Info...

Bl CONSOLE

Slot 2 - CM-110-S2LC120 f A £ Refresh

Copper Port || Fiber Port | Alert Log | Advanced || Slot

Hame: CM-110-82LC120 ¥ Details
Model: CM-110-82LC120

- D |
Description: 10/100 Fast Ethernet Media and Rate Converter MaﬂaM‘glﬁimglrMamﬁ &m?&EAM(QQ%Ie

single mode (LC) [120 km/74 4 miles]

CM-100 Media Converter Module

(Hardware Setup

Confinuration lumnar: Aitn 8 Corant Switeh Sattinas ]

You navigate through the different configuration windows by selecting a navigation tab. Each of the
navigation tabs open to more options and windows.

4— Administration Button
I Alert Log Port Setup | | Status Advanced I<_ Navigation Tabs
|

Model: MCR-MGT
Uptime: 0 Days 1 Hours 9 Minutes 51 Seconds
MAC Address: 00-80-d4-10-06-29

Configuration Methods
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Command Line Interface

The Administration button will take you to the navigation Tree as shown below.

MCR1900-10062!
perie 172.16.54.106
Chassis View MCR1900-100629 » Management Module Wiew
v\n?_anageme"t LEEHES IMlanagement Module
ew
[2 Chassis Card Model: MCR-MGT1900
2 Metwork System Name: MCR1900-100629
2l Access MAC Address: 00:30:D4:10:06:29
B Users IP Address: 172.16.54 106/255 255 0.0
[E1 Alerts _ DHCP: Disabled
E] D?te and Time Default Gateway: 172.16.1.7
E "::’_'lsF"aV Formats nate and Time:  August 11, 2010 12:38:18 EDT
res Uptime: 0 Days 1 Hours 21 Minutes 36 Seconds

Firmware Version: 102 A1

Navigation Tree

Note: Remember to click on the Apply button to save your configuration changes.

Command Line Interface

Overview

The Command Line Interface (CLI) is a command line option configuration for the Management
Module. See the Command Line Interface Reference Guide for a full breakdown of all the CLI
commands and their functionality.

Access Platforms

The CLI is accessed by any application that supports a Telnet or SSH session to the Management
Module’s IP address, such as Putty, SecureCRT, or from a command prompt. You can also access the
CLI from a dumb terminal or PC connected to the console port of the Management Module.

Using CLI commands

To connect to the Management Module through the network to configure/manage it using the CLI
commands, do the following:

1. Start a Telnet or SSH session to the Management Module’s IP address; for example:
telnet 10.0.0.10

Press Enter
Alternatively, you can connect directly to the console serial port.

If Require Password is enable you will get a prompt to login, else you will get the following
command prompt.

MCR-MGT-<last six digits of your MAC address>#

You can start configuring/managing the Management Module by typing in commands at the prompt.
If you are not sure what commands are available, you can type a ? (question mark) at any time during
a command to see your options.

See the Command Line Interface Reference Guide for more information about the CLIL.
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Menu

Menu

Overview

The Menu is a graphical representation of the CLI. You can look up Menu parameter explanations in
the Command Line Interface Reference Guide. The only operations that the Menu does not support
are the downloading or uploading of files to/from the Management Module.

Access Platforms

The Menu is accessed by any application that supports a Telnet or SSH session to the Management
Module’s IP address, such as Putty, SecureCRT, or from a command prompt. You can also access the
Menu from a dumb terminal or PC connected to the console port of the Management Module.

Using the Menu
To connect to the Management Module through the network to configure/manage it using the Menu
Configurator, do the following:
1. Start a Telnet or SSH session to the Management Module’s IP address; for example:
telnet 10.0.0.10

Press Enter
Alternatively, you can connect directly to the console serial port.

If Require Password is enable you will get a prompt to login else you will get the following
command prompt.

MCR-MGT-<last six digits of your MAC address>#

5. Type screen, Press Enter

The following Menu will now appear.

User [admin [MCR-MGT-1060%63] 1.0 Telnet 5

Media Converter

Server

Network

Alerts

Time
Authentication
sers

Statistics
Gommand Line Mode

?: Help. Arrows: Move,. Enter: Select

To navigate through the Menu options, do the following:
1. Highlight a Menu option by using the keyboard up and down arrows to navigate the list.

2.  When the Menu item you want to access is highlighted, press the Enter key to either get to the
next list of options or to get the configuration screen, depending on what you select.

3. When you are done configuring parameters in a screen, press the Enter key and then the Enter
key again to Accept and exit the form.
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SNMP

4. Ifyou want to discard your changes, press the Esc key to exit a screen, at which point you will
be prompted with Changes will be lost, proceed? (y/n), type y to discard your changes or n to
return to the screen so you can press Enter to submit your changes.

5. If there are a number of predefined options available for a field, you can scroll through those
items by pressing the Space Bar or you can type 1 (lowercase L) to get a list of options, use the
up/down arrows to highlight the option you want, and then press Enter to select it.

SNMP

Overview

The Management Module supports configuration and management through common standard SNMP

Management Tools. You can use SNMP to manage or configure any installed Management Module

or Media Converter Modules. The standard SNMP default communities, “public” for read-only
access and “private” for read-write access are predefined on the Management Module and will allow
you access from any IP address. However, these predefined communities will need to match the
communities as configured on your Network Management Software/SNMP MIB browser.

Community=public, Permissions=Readonly

Community=private, Permissions=Readwrite

Accessing MCR-MGT using SNMP

1. Load the MCR-MGT.MIB file from the Perle Management Module CD-ROM or Perle website

into your SNMP manager.

Type in the IP address of the Management Module.

3.  You are now ready to start configuring and managing your Management Module and Media
Converter Modules using SNMP.

SMMP MIBs

- cm1110RateCony
--hj cm110RateCony
El_) mcrMagt

- [ merMatTable

B E moMgtEntry
- [ merMgtConfigTable
- E’g mcrMgtconfigEntry
% merMgtConfigSlatIndex

mcrMgtConfigStatus

@ merMgtCanfigEthSpeedDuplex
@ mcrMgtConfigEthCrossover
@ mcrMgtConfigConsolePortEnabled
@ merMgtConfigConsoleSpeed
@ mcrMgtConfigConsoleDataBits
@ merMgtConfigConsoleParity
@ mecrMgtConfigConsoleStopBits
@ merMgtCanfigConsoleFlowContral
@ merMgtConfigConsoleMonitarDSR
- [ merMgtledTable
(- [ merMgtEthStatsTable

<

Mame

- [ merSfpDmiModuleTable

mgtAdminGroup

QID

.1.3.6.1.4,1,1966.21.1.1.1.2.7

MIE

PERLE-MCR-MGT-MIB

Syntax

Access

Status

Defyal

Configuration Methods
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MCR1900 Chassis

General information on the MCR1900 Chassis

MCR1900 Chassis

The MCR chassis consists of 19 slots.
Each slot can accommodate either a Management Module or a Media Converter Module.
This chassis can support 1 Management Module plus 18 Media Converter Modules.

Each module is hot-pluggable which means it can be inserted or removed without needing to
power down the chassis

The Media Converter Modules do not require the Management Module to be present in order to
operate as media converters.

Power Supplies

The chassis supports up to two power supplies. Each supply can power the chassis on its own. When
a second power supply is present, “load sharing” is implemented between the two supplies.

The power supply is hot pluggable. When two supplies are powering the chassis, one can be pulled
without affecting the operation of the chassis.

Temperature Protection Logic

The chassis has logic which continuously monitors the internal temperature of the chassis. If this
temperature ever exceeds 70 degrees Celsius, power to all modules will be cut. This protects the
modules from being damaged. The chassis continues to monitor the temperature and when it return
back to 55 degrees Celsius, all modules are powered back up.

Removal Of Management Module From a Chassis

You can remove the Management Module from the chassis at any time if needed (i.e for service). All
Media Converter Modules will continue to operate normally. What will be lost is the ability to
remotely (or locally) connect to the chassis and monitor or control any of its functions. All event
notification will be lost as well as any scheduled slot power up/down functionality.

Firmware Components

The MCR1900 chassis has a number of intelligent components, each with supporting firmware.
These components are;

Power supply
Backplane
Management module

Media converter module(s)

All the components are pre-loaded with firmware at the factory. Over time, new updates can become
available for any component. Through the Management Module, all components (including the
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Management Module itself) can be upgraded.

The firmware residing on Managed Media Converter Modules can be updated manually (user
intervention required) or automatically to the latest firmware versions. The Management Module and
Media Converter Modules can be at different firmware versions.

The power supply and backplane firmware is embedded in the Management Module image and is
updated automatically by the management card so that they always match its firmware.

Configuration

The MCR-MGT Management Module allows for the soft configuration of parameters on the chassis
and Media Converter Modules. Some configuration parameters reside only on the Management
Module and others reside on the backplane or Media Converter Module.

Backplane

The user can configure a “default power state” for each slot in the chassis. This determines if the slot
is powered up or down when the system boots. This information is stored on the backplane so that
even if the management card is removed from the chassis, the slots will still power up as per the
configured status.

If you ever need to reset this configuration but no longer have a management card with which to do
s0, you can reset the configuration to factory default (all slots powered up) by doing the following;

Power off the chassis.

Remove all modules from the chassis.

Power up the chassis for at least 30 seconds.
Power down the chassis.

Re-insert all modules into their respective slots.
Power up the chassis.

N R WD

At this point, all slots should have gone back to a “powered up” default state.

Media Converter Modules

The Media Converter Modules can be configured using the MCR-MGT Management Module. This
configuration will be stored on the Media Converter Module in non-volatile memory. Whenever the
Media Converter Modules are powered up or re-started, the Media Converter Modules will look first
at their Auto-Config Jumper to determine the jumper position see Appendix D, Auto-Config Jumper
on page 119 for more information. If the jumper is set to SW the modules will read the settings of the
DIP switches and use those as their running configuration. The Media Converter Modules will ignore
any configuration information in their flash memory. If the jumper is set to Auto (default), the Media
Converter Modules will at power up, check their internal flash memory to see if configuration
information has been downloaded to them from a management module. If so, the Media Converter
Modules will use this as their running configuration. If there is no configuration in flash, the Media
Converter Modules will read the settings of the DIP switches and uses those as their running
configuration.

When configuring the Media Converter Module, you have the option to enable the “Backup/Restore
Module Configuration Automatically”. When this option is used, the Media Converter configurations
are also stored on the Management Module. At any time, if you replace the module in this slot with a
different module of the same type, the management card will automatically download the
configuration it has for that slot to the new Media Converter Module. This allows you to easily
replace a module for servicing purposes.
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MCR1900 Chassis View

The Chassis section is used to view the parameters directly associated with the MCR1900 chassis.

MCR-MGT-069F29 January 13, 2011 10:54:10 EST

lJEl'lE 216.129.13.62 User's Guide | User: admin | Logout

MCR-MGT-069F29 [+ | Chassis
B B oA @A E N R B EEE EE B

006LHON

Chassis - MCR1900

Power Supplies and Fans || Alert Log
Model: MCR1900
Current Temperature: 24°C Self Test: Passed |
Maximum Temperature Threshold: 50 °C Firmware Version: 1.0G6
Bootloader Version: 0.0
Serial Number: 103-002710T10095
General
Model The Model of the chassis.
Current The current temperature of the chassis.
Temperature
Maximum When the temperature of the chassis exceeds this threshold, alerts will be
Temperature generated. Once the threshold is exceeded a new alert will be issued each time

Threshold the temperature raises by 1 degree.
Default: 50 °C

Power Supplies and Fans

Show details for the Power supplies and fans installed.

Alert Log

Shows any alerts that have been generated.

Populating Slots In the MCR1900 Chassis

Slots in the MCR1900 chassis can be populated with a Management Module and Media Converter
Modules. The Media Converter Modules can be of the CM/eX variety (managed) or C variety
(unmanaged). You can mix managed and unmanaged Media Converter Modules in the same chassis.

Slots can also be left unpopulated.

Unmanaged modules

If a slot is populated with an unmanaged Media Converter Module, the management card can not
manage that module however, it can still perform the following actions on this slot;

® Assign a logical name to the slot. This can facilitate the ability for the operator to determine what
this card is.

Power the slot on or off
Define a default power state for this slot
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Empty slot
If a slot is empty the management card can perform the following actions on this slot;
® Power the slot on or off
® Define a default power state for this slot
® Disable the “Backup/Restore Module Configuration Automatically” option.
°

This is done to provide the user a method of cancelling or disabling this operation even once the

Media Converter Module is no longer in the slot. This would be useful if you plan to place a new
Media Converter Module in this slot but do not wish to have its configuration overwritten by the
one stored on the management card.
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SMI Media Converter

General information on the SMI Media Converter

SMI Media Converter

This chassis consists of 2 slots.
One Management Module plus 1 Media Converter Module are supported.

By default, slot 1 of the SMI Media Converter will be populated with a MCR-MGT management
module and slot 2 will be populated with a Media Converter module.

® FEach module is hot-pluggable which means it can be inserted or removed without needing to
power down the chassis

Removal Of Management Module From a Chassis

You can remove the Management Module from the chassis at any time if needed (i.e for service). The
Media Converter Module will continue to operate normally. What will be lost is the ability to
remotely (or locally) connect to the chassis and monitor or control any of its functions. All event
notifications will be lost.

Firmware Components

Both the MCR-MGT management module and the Media converter module are pre-loaded with
firmware at the factory. All modules can be upgraded as new firmware becomes available.

The firmware residing on Managed Media Converter Modules can be updated manually (user
intervention required) or automatically to the latest firmware versions. The Management Module and
Media Converter Modules can be at different firmware versions.

Configuration

Modules

The two slots in the SMI Media Converter are populated with a Management Module and a Media
Converter Module. See Advanced Parameter on page 23 for information on how to set the slot
position for the management module.

The one Media Converter Module can be configured using the MCR-MGT Management Module.
This configuration will be stored on the Media Converter Module in non-volatile memory. Whenever
the Media Converter Module is powered up or re-started, the Media Converter Module will look first
at the Auto-Config Jumper to determine the jumper position see Appendix D, Auto-Config Jumper
on page 119 for more information. If the jumper is set to SW the module will read the settings of the
DIP switches and use those as its running configuration. It will ignore any configuration information
in its flash memory. If the jumper is set to Auto (default), the Media Converter Module will at power
up, check its internal flash memory to see if configuration information has been downloaded to it
from a management module. If so, the Media Converter Module will use this as its running
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configuration. If there is no configuration in flash, the Media Converter Module will read the settings
of the DIP switches and use those as its running configuration.

When configuring the Media Converter Module, you may enable the “Backup/restore Module
Configuration Automatically”. When this option is used, the Media Converter configuration is also
stored on the Management Module. At any time, if you replace the module in this slot with a different
module of the same type, the management card will automatically download the configuration it has
for that slot to the new Media Converter Module. This allows you to easily replace a module for

servicing purposes.
Chassis

The Chassis section is used to view or configure the parameters directly associated with the SMI
Media Converter chassis.

General Parameters

EﬂE MCR-MGT-VI January 12, 2011 15:52:04 EST
p 172 16 .54 106 User's Guide | User: admin | Logout

MCR-MGT-VI Chassis SMI-110-52LC120 A Hide Chassis

| Chassis Info

10/100Base-T

Chassis - SMI-110-82LC120

Advanced

Product Model: SMI-110-S2L.C120

Serial Number: |user123

Product Model The product model.

Sets the chassis serial number.
Field Format: 16 characters

Serial Number

Advanced Parameter

MCR-MGT-VI J 12, 2011 14:26:05 EST
DEI"E 172.16.54 106 Usefsaglﬁ‘g | User: admin | Logout
MCR-MGT-VI [» | Chassis SMI-110-52L.C120
£ 10/1008ase-T Eé@@i 80110008z i
Chassis - SMI-110-52LC120
General
Manag Module is i lled in: | Slot 2 v
Management The management module can be installed in either slot 1 or slot 2.
Module Slot
Number

Note: Ifa change is made to the slot position of the management module, a reboot of the SMI
Media Converter is needed for the new slot position to take effect.




MCR-MGT Module

MCR-MGT Management Module

The MCR Web Manager screens will be used to explain the various parameters associated with each

component of the system. The parameters have the same meaning in all configuration tools.

General Tab

Field Descriptions

Slot 1 - MCR-MGT

Administration

Alert Lag || Port Setup

Status Advanced

Model: MCR-MGT
Uptime: 0 Days 0 Hours 35 Minutes 50 Seconds
MAC Address: 00-80-d4-10-06-34 Firmware Version: 1.0A1
Failsafe Bootloader Version: ~ 01.01.0101
Secondary Bootloader Version: 01.01.0002
Serial Number: 101-694010W00001
Model Displays the module’s model information.
Uptime Displays the amount of time the MCR-MGT Management Module has been

MAC Address

Details

Alert Log Tab

The MCR-MGT Management Module monitors the status of the various components in the system

running since its last reboot.

Displays the MCR-MGT Management Module’s MAC Address.

Displays the Management Module’s firmware and serial number information.

and when a note worthy event occurs, it records this event in its local event log. This log is kept in a

circular buffer which means that once the log is full (around 200 entries), the oldest entries will be
replaced with new entries. The date and time of when the alert occurred is recorded with each alert.
Clicking on any column will cause the log to be sorted based on the selected column.

MCR-MGT Management Module User’s Guide, Version 1.8
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MCR-MGT Management Module

Field Descriptions
Slot 9 - MCR-MGT

Administration...
General Port Setup || Status | Advanced

Show alerts for: Clear Alert Log
1 2 npexte> last=>
Date > Description Severity

09/10/2010 6-02-08 PM ;\ég:T‘lliﬁluga%ngjalinn SUCCESSFUL! Access method=VWebManager(HTTP), Originating Normal Operation

09/110/2010 6-01-23 PM Mgmt: Authentication SUCCESSFUL! Access method=WebManager(HTTP), Originating Normal Operation
IP=10.10.200.41.
09/10/2010 5:59:21 PM Mgmt: Configuration saved to flash. MNormal Operation

09/10/2010 5-58-39 PM ;\ég:r:;:zixgtgin:\a::tion SUCCESSFUL! Access method=VWebManager(HTTP), Originating Normal Operation

09/10/2010 5:55:36 PM Mgmt: Ethernet port link status UP.
09/10/2010 5:55:36 PM Mgmt: System boot - Cold Start.

MNormal Operation

MNormal Operation

Configure the following parameters:
Show Alerts Shows Alerts for the Entire System, Chassis or a specific slot.

Clear Alerts Clears the Alert Log for the Entire System.

Port Setup Tab

Serial

General Alert Log Status Advanced

Enable Serial Conscle

Speed:
Parity:
Data Bits:

Stop Bits:
[ software Flow Control (XON/XOFF)
[ Hardware Flow Control (RTSICTS)

[ Menitor DSR

The serial console port is used to obtain local access to the MCR-MGT module. The port allows the
user to configure, monitor and/or control the system modules via CLI (Command Line Interface) or
Menu (a series of menus). This tab allows for the configuration of the serial parameters used for the
port. This tab also allows the system administrator to disable the console port if they do not want to
grant access to the Management Module via this port.
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MCR-MGT Management Module

Field Descriptions

Enable Serial
Console

Speed

Parity

Data Bits

Stop Bits

Software Flow
Control

Hardware Flow
Control

Monitor DSR

Ethernet

Enables/Disables the serial console port.
Default: Enabled

Specifies the baud rate of the serial console port.
Data Options: 9600, 19200, 38400, 57600 or 115200
Default: 9600

Specifies the type of parity being used for the data communication on the serial
port.

Data Options: Even, Odd, None
Default: None

Specifies the number of bits in a transmitted character.
Data Options: 7, 8
Default: 8

Specifies the number of stop bits that follow a byte.
Data Options: 1, 2
Default: 1

The data flow is handled by the Software Flow Control (XON/OFF).
Default: Off

The data flow is handled by the Hardware Flow Control (RTS/CTS).
Default: Off

Specifies whether the EIA-232 signal DSR (Data Set Ready) should be
monitored. on the serial console port. When the DSR signal is dropped (turn off
terminal), the session is terminated. If login is required, will force user to login
next time terminal is powered up.

Default: Off

The Ethernet port is used to both provide access to the MCR-MGT Management Module from the
LAN or Internet as well as allowing the Management Module to access hosts and servers on the LAN
or beyond. The port allows the user to configure, monitor and/or control the system modules by
Telneting, SSHing, HTTPing or HTTPSing into the IP address associated with this port.

General || Alert Log

Status Advanced

Serial Consale Iﬁiﬁlﬁl

ol

MDD -

Speed and Duplex: [Auts

@ auto Detect O MDI O MDIX
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MCR-MGT Management Module

Field Descriptions

Speed and Duplex Define the Ethernet connection.
Data Options:
Auto—automatically detects the Ethernet interface speed and duplex
10 Mbps/Half Duplex
10 Mbps/Full Duplex
100 Mbps/Half Duplex
100 Mbps/Full Duplex
1000 Mbps/Half Duplex
Default: Auto

MDI/MDI-X ® Auto-Detect— automatically detects the Ethernet’s cable polarity
® MDI —the cable’s polarity is straight-through
® MDI-X —the cable’s polarity is crossovered
Default: Auto

Advanced Tab

This tab allows the user to reset/restart modules or to reset the configuration of modules back to a

factory default state.
Slot 9 - MCR-MGT
General | Alert Log | Port Setup || Status
Restart ~ Set Configuration to Factory Defaults—
[ Management Module ] [ Management Madule ]

[ All Media Converter Modules ] [ All Media Converter Modules ]

[ Chassis (All Modules) ]

Field Descriptions

Restart ® Restart the Management Module

® Restarts all Media Converter Modules

® Restarts all Modules (including the Management Module)

® Sets the Management Module back to factory default, erasing all
configuration, SSL keys and certificates.

e Sets all Media Converter Modules back to factory defaults.

Set Configuration
to Factory Defaults
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Management Module View

Management Module View

To configure the “system wide” parameters associated with the MCR-MGT module, click on the
“Administration” button. This will take you to the following screen where you can navigate to the
various parameters which can be set.

MCR-MGT-100634 October 13, 2010 11:04:28 E
172.16.22.30 Uszers Guide | User: admin | Log

MCR-MGT-100634 » Management Module View

Management Module

Model: MCR-MGT
System Name: MCR-MGT-100634
MAC Address: 00: 5:34
IP Address: 1T . 3V255.255.0.0
DHCP: Disabled

Diste 3nd Time Default Gateway: 172.18.1.7

Dizplay Formats | Date and Time: October 13, 2010 11:04:28 EDT

_ Files Uptime: 0 Days 17 Hours 27 Minutes 4 Seconds

Firmware Version: 1.0

The main screen is divided into two sections. On the left is the “navigation tree” and on the right is
the information associated with a specific selection on the navigation tree.

Click on the desired item on the navigation tree and then review or update the information in the
window on the right of it.

To get back to the “Chassis” view, click on the “Chassis View” item on the top of the navigation tree.
This will return you to the screen with the graphical representation of the chassis.

MCR1900 Chassis

The Chassis section is used to configure the parameters directly associated with the chassis.
Maximum Threshold parameter as well as the parameters for the Power Scheduler.

erle MCR-MGT-100903 October 13, 2010 14:11:50 EDT
F 172.16.113.79 User's Guide | User: admin | Logout

MCR-MGT-100203 » Management Moduls View » Chassis

Chassis Configuration

Maximum Temperature Threshold 5| *C
Aoply

Date and Time

Display Formats
A Fiies

Configure the following parameters:

Maximum When the temperature of the chassis exceeds this threshold, alerts will be
Temperature generated. Once the threshold is exceeded a new alert will be issued each time
Threshold the temperature raises by 1 degree.

Field Format: 0 °C to 70 °C (32 °F to 158 °F)
Default: 50 °C
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Management Module View

Power Schedule

The parameters in Power Scheduler allow you to configure each slot within the Chassis to be
automatically turned On or Off according to a user pre-defined schedule. This feature is available on
the MCR1900 chassis only.

perle

3 Files.

Schedule Field Descriptions

MCR-MGT-100503 » Management Module View »

MCR-MGT-100303

Power Schedule

172.16.113.79

ower Schedule

October 13, 2010 14:13:18 EDT
Users Guide | User: admin | Logout

Shots can be automatically tumed on or off according to 3 schedule. Use the links below to view and changs a shot's schedule.

Empty

Resst and Dissble All Schedules

Clicking on “Change” for a specific slot above, you will be presented with the following screen;

MCR-MGT-100503 » Management Module View » Chassis » Fower Schedule [ | Shot 2

MCR-MGT-100903

Power Schedule - Slot 2

Enzble power schedule

172.16.113.78

Time
Day Tum On Tum Off
Sunday [pa:z0 | [14:00 |
Worsay | O | || Of |
Tussday [roz0 | [1&:20 |
wesressay 0 | || Of |
Thursday fps:an | [1&:20 |
Fasy | O | | |
Saturdsy [pa:z0 | [1&:20 |

Configure the following parameters:

Enable Power

Scheduler

Turn On/Turn Off

Enable the scheduler feature for this slot. The power scheduler can be enabled
or disabled individually for each slot.

Default: Disabled

For each day of the week, you can select an "ON" time and/or an "OFF" time.
You can cross over one or more days. For example you could configure an
"OFF" time on Friday at 17:00 (5 P.M.) and an "ON" time of Monday at 9:00.
This would power the slot off on Friday afternoon until Monday morning.

29



Network

Management Module View

The Network node allows you to set up your IPv4 or IPv6 network permeates to be used on the
Ethernet port of the MCR-MGT Management Module. These are used by the Management Module to
access the network.
MCR-MGT-100903 October 13, 2010 16:12:00 EDT
FEE'E 172.16.113.79 Uzars Sui&ell User: admin | Logout

MCR-MGT-100303 » Management Module View » Network

I'n-:-:ue Network

s=is System Name: MCR-HMGT-100303
» B Network >
Domain: testing
Advanced
Acoess Register Address with DNS (when DHCP is enabled)
Authentication
and Accounting [laeh L H | Pyl Addresses
Alerts
Date and Tims ) Obtain IP Address automatically using DHCPIBOOTP
Dizplay Formats =
pimt 2l Use the following IP Address:
i Files
IF Address: 172.16.113.79
Subnet Mask: 256 265.0.0
Default Gateway: 172.16.1.7
DNE Server: 0.0.0.0

Configure the following parameters:
System Name The System Name is used for informational purposes by such tools as the

MCR Web Manager and is also used in conjunction with the Domain field to
construct a fully qualified domain name (FQDN).

Default: MCR-MGT-xxxxxx (wWhere xxxxxx is the last 6 digits of the
Management Module’s MAC address).

Domain This field is combined with the System Name to construct the fully qualified
domain name (FQDN). For example, if the domain is mycompany.com and the
Server Name is set to accounting, the FQDN would be
accounting.mycompany.com.

Register Address in When this parameter is set, the MCR-MGT Management Module will provide

DNS the DHCP server with a fully qualified domain name (FQDN), so that the
DHCEP server can update the network's DNS server with the newly assigned IP
address.

Default: Disabled

Obtain IP Address When enabled, the MCR-MGT Management Module will request an IP address

automatically using from the DHCP/BOOTP server. When this option is enabled, the MCR-MGT

DHCP/BOOTP Management Module will also attempt to retrieve the DNS server and default
gateway from the DHCP/BOOTP server.

Default: Disabled

Use the following  Assign a specific IP address and subnet to the MCR-MGT Management
IP Address Module’s Ethernet interface.
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Management Module View

IP Address The IPv4 network address you wish to assign to the MCR-MGT management
module’s Ethernet port. For example: 172.16.113.79

Subnet Mask The IPv4 subnet mask you wish to assign to the MCR-MGT management
module’s Ethernet port. For example, 255.255.0.0

Default Gateway  Specify the gateway IP address that will provide general access beyond the
local network.

Field Format: IPv4 address

DNS Server Specify the IP address of a DNS host in your network for host name resolution.
Field Format: IPv4

IPv6 Addresses

Configure IPv6 settings when the Management Module resides in an [Pv6 network.

Field Descriptions

erle MCR-MGT-100903 October 13, 2010 16:52:23 EDT
p i72.168.113.79 User's Guide | User: admin | Logout

MCR-MGT-100202 » Management Module View » Network

Chassis View

Network
+ [ Chassis System Name: EK’EP:-_L’_GT'_G:D_'::)_!-—]
- Metwaork e
e i

& A
Register Address with DN S [when DHCF is enabled)

COUNting LR P vE Addresses

[ Aerts
@ D-.ata and Tims Obtain IPvé Address(es) using:
@l Theplay, Eomat @ IPvé Autoconfiguration
i Files
O DHCPvE
Custom IPvE Address List:
|F Addrzzs
< ¥
Default Gateway: |
DNE Server: = B Obtain Automatically
DHCPwE Settings: I IPvé Address [ IPvE Network Prefix
Configure the following parameters:
Obtain IPv6 When enabled, you can configure the MCR-MGT Management Module to

Address(es) using  obtain the IPv6 address using [IPv6 Autoconfiguration or a DHCPv6 server.
Default: Enabled
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IPv6
Autoconfiguration

DHCPv6

Custom IPv6
Address list

Default Gateway

DNS Server

Obtain
Automatically

DHCPv6 Settings
IPv6 Address

IPv6 Network
Prefix

Management Module View

When enabled, the MCR-MGT Management Module will send out a Router
Solicitation message. If a Router Advertisement message is received, the MCR-
MGT Management Module will configure the IPv6 address and configuration
parameters based on the information contained in the advertisement. If no
Router Advertisement message is received, the MCR-MGT Management
Module will attempt to connect to a DHCPv6 server to obtain [Pv6 addresses
and other configuration parameters.

Default: Enabled

When enabled, requests IPv6 address and configuration information from the
DHCPv6 server.

Default: Disabled

You can manually assign one or more IPv6 addresses to the MCR-MGT
management module’s Ethernet port using this table. Use the "Add",
"Delete" or "Edit" buttons to manipulate the table entries.

Specify the IPv6 address of a gateway that will provide general access beyond
the local network.

Field Format: IPv6 address

Specify the IPv6 address of a DNS host in your network for host name
resolution.

Field Format: IPv6 address

When DHCPvV6 is enabled, you can enable this option to have the MCR-MGT
Management Module receive the DNS IP address from the DHCPv6 server.

Default: Enabled

When enabled, the MCR-MGT Management Module will accept IPv6 address
from the DHCPv6 server.

Default: Disabled

When enabled, the MCR-MGT Management Module will accept the network
prefix from the DHCPv6 server.

Default: Disabled

Adding/Editing a Custom IPv6 Address

You can manually add one of the following:

® The IPv6 network prefix (and the Management Module will determine an [Pv6 address based on
the network prefix and the Management Module MAC address).

® The complete I[Pv6 address.

32



Management Module View

IPv6 Address x

{5} Create Unique IPv6 Address on the Network:

Network Prefix: [0
Subnet Bits: |64

-0 -0 .:.U

) Use the following IPv6 Address

IPv6 Address: I

Subnet Bits: I

Configure the following parameters:

Create a unique

When enabled, the MCR-MGT Management Module will derive an IPv6

IPv6 address on the address from the entered network prefix and the MCR-MGT Management

network

Network Prefix

Subnet Bits

Use the following
IPv6 address

IPv6 Address

Subnet Bits

Module’s MAC address.
Default: Enabled

Specify the IPv6 network prefix. The MCR-MGT Management Module will
derive the complete IPv6 address from the entered network prefix and the
MCR-MGT Management Module’s MAC address.

Default: Enabled

Specify the network prefix bits for the [Pv6 address.
Range: 0-128
Default: 64

Enable this option when you want to enter a specific IPv6 address.
Default: Disabled

Specify the complete IPv6 address.
Field Format: IPv6 address

Specify the network prefix bits for the IPv6 address.
Range: 0-128
Default: 64
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Advanced
perle

i

i | Advanced Network Settings

MCR-MGT-100803
172.16.113.79

"] MCR-MGT-100303 » Management Module View » Network » Advanced

October 13, 2010 17:16:39 EDT
Users Guide | User: admin | Logout

[CEEl | Rout=s || DNS Dynamic DNS (| IPv8 Tunnels
Name IP Address(FQDN
d Accounting lyns_pc 1 13.117

The Advanced node configures Host Table entries, Routes, DNS, Dynamic DNS and I[Pv6 Tunnels.

Configure the parameters in the Advanced node if you want to

® add a specific host
modify the host table
® add aroute to an external network or host
® specify a DNS server to perform host resolution
e configure an [Pv6 tunnel
Host tab

Advanced Network Settings

2| Routes | ONS || Dynamic DNS

yns_pc

1P Tunnsis.

The host tab configures Host Table entries. This can include any type of host the MCR-MGT
Management Module will need to communicate with. The host is given a local name and an IP
address or a fully qualified domain name which will need to be resolved using a DNS server.
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Adding/Editing a Host
Add Host *
Host Name: |
® IP Address:

O Fully Qualified

Domain Name (resolved
by DNS)

Configure the appropriate parameters.

Host Name The name of the host. This is used only for the MCR-MGT Management
Module configuration.

Field Format: Up to 14 characters, no spaces.

IP Address The IP address of the Host you want to add.
Field Format: IPv4 or IPv6 address

Fully Qualified You can configure up to four DNS servers.
Domain Name
Field Format: IPv4 or IPv6 address

Routes tab

Entering routes in the routing list enables the identification of gateways to be used for accessing
specific hosts or external networks from the Management Module's local network.

There are three types of routes:
® Default—A route that provides general access beyond your local network.
® Host—A route defined for accessing a specific host external to your local network.

® Network—A route defined for accessing a specific network external to your local network.

Two types or gateways (method of accessing specific hosts or external networks) can be configured:

e Host—Specify a specify host that will provide access to the route destination.

® Interface—Specify the IPv6 tunnel that will provide access to the route destination.
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Field Descriptions
M DNS | Dynamic DNS | IPv6 Tunnels

Destination Network Mask

0.0.0.0

Type Gateway Gateway Type

Default _default Host

Apply

The following buttons are available on this window:

Add Button

Edit Button

Delete Button

Adds a route to the Route List.
Changes an existing route in the Route List.

Deletes a route from the Route List.

Adding/Editing Routes
From the Route List tab, if you click the Add or Edit button, you will be able to add a new or edit an

existing route.

Add Route

Destination
Type:

Gateway

Interface:

IP Address: 0.0.0.0
e Sunet e |
IPvE Subnet Bits-

@ Host:

Configure the appropriate parameters.

Type Specify the type of route you want to configure.

Data Options:

Host—A route defined for accessing a specific host external to your local

network.

Network—A route defined for accessing a specific network external to

your local network.

Default—A route which provides general access beyond your local

network.

Default: Default
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IP Address

IPv4 Subnet Mask

IPv6 Prefix Bits

Host

Interface

DNS tab

Management Module View

When the route Type is defined as Host, this field will contain the IP address of
the host. If the route Type is defined as Network, the network portion of the IP
address must be specified and the Host port of the address will be set to 0.
Example: to access network 10.10.20, the address 10.10.20.0 would be
specified in this field.

Format: IPv4 or IPv6 address

When the route is a Network route, you must specify the network’s subnet
mask.

If the IP address is IPv6, then you must specify the network’s prefix bits.
Range: 0-128

Select this option when a host is being used at the route gateway.
Default: Enabled, None

The Interface list is comprised of configured IPv6 tunnels. Select this option
when you want to use the specified interface as the gateway to the destination.

Field Option(s): IPv6 tunnels
Default: Disabled

You can configure up to four DNS servers. If you specified a DNS server on the Network,
Advanced, DNS tab (either IPv4 or IPv0), it will be automatically be entered into the appropriate list.
If the DNS server is provided by a DHCP server, these will NOT be viewable in the list, however,
you can add DNS servers to supplement the DHCP supplied server.

Field Descriptions

MCR-DEMO » Management Module View » Network » Advanced
Advanced Network Settings

Hosts || Routes R Dynamic DNS IPv6 Tunnels

DNS Servers

The following buttons are available on this window:

Add DNS Button
Edit DNS Button

Delete DNS Button

Adds a DNS server.
Edits an existing DNS server.

Deletes a DNS server.
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Editing/Adding DNS Servers

Configure the parameter:
Add DNS Server *

IP Address: ||

DNS IP Address  You can configure up to four DNS servers.
Field Format: IPv4 or IPv6 address

Dynamic DNS

Dynamic DNS Service providers enable users to access a server connected to the internet that has
been assigned a dynamic IP address. The Management Module has built-in support for the
DynDNS.com service provider. Refer to www . DynDNS . com for information on setting up an account.

When the Management Module is assigned a dynamic IP address, it will inform the DynDNS.com
service provider of its new IP address. Users can then use DynDNS.com as a DNS service to get the
IP address of the Management Module. In order to take advantage of this service, the following steps
need to be taken.

1. Create an account with DynDNS.com and configure the name your Management Module will be
known by on the internet (the Host name). For example, create a host name such as
yourcompanySCS.DynDNS.org.

2. Enable the Network Dynamic DNS feature and configure the Management Module’s dynamic
DNS parameters to match the Host’s configuration on the DynDNS.com server. Every time the
Management Module gets assigned a new IP address, it will update DynDNS.com with the new
IP address.

3. Users accessing the Management Module via the internet can now access it via its fully qualified
host name. For example, telnet yourcompanySCS.DynDNS.org.

Field Descriptions

MCR-DEMO » Management Module View » Network » Advanced
Advanced Network Settings

Hosts Routes DNS 1Pv6 Tunnels

[ Enable Dynamic DNS for the system
Service Provider:

Registered Host Name:

User Name:

Password:

Dy ic DNS A

System Type: Dynamic v
Wildcard: Enable v
Connection Method: HTTP ~

HTTPS Configuration

Validate Peer Certificate

Configure the appropriate parameters:
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Enable Dynamic

Management Module View

Enables/disables the dynamic DNS feature. When Dynamic DNS is enabled,

DNS for the system the MCR-MGT Management Module will automatically update its IP address

Service Provider

with DynDNS.org if it changes.
Default: Disabled

Displays the Dynamic DNS service provider.
Default: DynDNS.org (permanent)

Register Host Name Specify the registered hostname with DynDNS.org that will be updated with

User Name

Password

Dynamic DNS
Account Settings

System Type

Wildcard

Connection
Method

the MCR-MGT Management Module’s IP address should it change. Put in the
full name; for example, mymediaconverter . dyndns . org.

Specify the user name used to access the account set up on the DynDNS.org
server.

Specify the password used to access the account set up on the DynDNS.org
server.

Specify how your account IP address schema was set up with DynDNS.org.
Refer to www.DynDNS.org for information about this parameter.

Data Options: Dynamic, Static, Custom
Default: Dynamic

Specifies whether to add an alias such as *to your Registered Host
Name .yourcompanySCS.dyndns.org pointing to the same IP address as
entered for yourcompanySCS.dyndns . org.

Data Options: Enable, Disable, Nochange
Default: Enable

Specify how the MCR-MGT Management Module is going to connect to the
DynDNS.org server.

Data Options:

e HTTP

e HTTP through Port 8245

® HTTPS—for a secure connection to the DynDNS server
Default: HTTPS

Cipher Suite Button Launches the cipher information window so you can specify the type of

encryption that will be used for data that is transferred between the
DynDNS.org server and the MCR-MGT Management Module.

See Appendix B, SSL/TLS Ciphers for more information.
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Validate Peer
Certificate

Validation Criteria

Button

Enables/disables peer validation between the DynDNS.org server and the
MCR-MGT Management Module. This may be desirable, since the DynDNS
user name and password are sent from the management module to the DynDNS
server when the IP address needs to be updated and when an account refresh is
performed. Account refreshes are done periodically to ensure that DynDNS
accounts do not auto-delete should the IP address change infrequently. This
parameter will only take effect if HTTPS is selected as the connection method.

Default: Disabled

Launches the peer validation criteria window so you can specify the
information used to validate the connection between the DynDNS.org server
and the MCR-MGT Management Module.

Cipher Suite Field Descriptions

The SSL/TLS cipher suite is used to encrypt data between the Management Module and the client.
You can specify up to five cipher groups.

S5L Cipher Suite x

Key Size

Encryption  Minimum

Maximum = Key Exchange  HMAC

Any 40

256 Any Any

The following buttons are available:

Add Button

Edit Button

Delete Button

Adds a cipher to the cipher list.
Edits a cipher to the cipher list.

Deletes a cipher to the cipher list.

Adding/Editing a Cipher Suite
To see a list of valid cipher suite combinations, see Appendix B, SSL/TLS Ciphers.

Add Cipher x

Encryption:

Minimum Key Size:

Maximum Key Size: |40 +

Key Exchange:
HMAC:

Any

40 v

Any
Any

v
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Configure the following parameters:

Encryption

Min Key Size

Max Key Size

Key Exchange

HMAC

Select the type of encryption that will be used for the SSL connection.
Data Options:

Any—Will use the first encryption format that can be negotiated.
AES

3DES

DES

ARCFOUR

ARCTWO

Default: Any

The minimum key size value that will be used for the specified encryption type.
Data Options: 40, 56, 64, 128, 168, 256
Default: 40

The maximum key size value that will be used for the specified encryption
type.

Data Options: 40, 56, 64, 128, 168, 256

Default: 256

The type of key to exchange for the encryption format.

Data Options:

® Any—Any key exchange that is valid is used (this does not, however,
include ADH keys).

e RSA—This is an RSA key exchange using an RSA key and certificate.

o EDH-RSA—This is an EDH key exchange using an RSA key and
certificate.

o EDH-DSS—This is an EDH key exchange using a DSA key and
certificate.

e ADH—This is an anonymous key exchange which does not require a
private key or certificate. Choose this key if you do not want to
authenticate the peer device, but you want the data encrypted on the
SSL/TLS connection.

Default: Any

Select the key-hashing for message authentication method for your encryption
type.

Data Options:
® Any

e MDS5

e SHAI

Default: Any

Validation Criteria Field Descriptions

If you choose to configure validation criteria, the information in the peer SSL/TLS certificate must
match exactly the information configured in this window in order to pass peer authentication and
create a valid SSL/TLS connection.
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S5L Validation Criteria

[ state/Province:

[ Locality:

[J Organization:

[J Organization Unit:

Oc Name:

Il Country: [ ]
|
|
|
|
|
|

I Email:

IPv6 Tunnels

IPv6 tunnels transport IPv6 data packets from one IPv6 network to another IPv6 network over an
IPv4 network. In addition to creating the IPv6 tunnel, you must also create the route that will

transport the data packets through the IPv4 network in the Route List (seeddvanced on page 35) for

more information.

Field Descriptions
Advanced Network Settings

Hosts | Routes | DNS || Dynamic DNS |EISRILEE

Name Mode Remote Host Gateway
ipv6_tunnel_1 Manual _default ethernet_1
Add Il Edit Il Delete

The following buttons are available:

Add Button
Edit Button

Delete Button

Adds an IPv6 tunnel.

Edits an existing IPv6 tunnel.

Deletes an IPv6 tunnel. If a tunnel is associated with a route, it cannot be

deleted until the route is either changed or deleted.

Adding/Editing an IPv6 Tunnel

When you add/edit an IPv6 tunnel, you are determining how an IPv6 message will reach an IPv6

device through an IPv4 network.
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Management Module View

IPv6 Tunnel x
Name: ipvé_tunnel_2|
Mode: Manual hd

Remote Host: | None

e

¥

Interface: | ethernet_1

hd ‘

Configure the following parameters:

Name

Mode

Remote Host

Interface

The name of the IPv6 tunnel.
Field Format: Maximum 16 alphanumeric characters
Default: ipv6_tunnell

The method or protocol that is used to create the IPv6 tunnel.

® Manual—When enabled, the MCR-MGT Management Module will
manually create the [Pv6 tunnel to the specified Remote Host through the
specified Interface.

® 6to4—When enabled, the MCR-MGT Management Module will broadcast
to the multicast address 192.88.99.1 through the specified Interface. When
the closest 6to4 router responds, it will create the IPv6 tunnel,
encapsulating and decapsulating IPv6 traffic sent to and from the MCR-
MGT Management Module.

® Teredo—When enabled, the Teredo protocol encapsulates the IPv6 packet
as an [Pv4 UDP message, allowing it to pass through most network
address translator (NAT) boxes and create an IPv6 tunnel to the specified
Remote Host (a Teredo server) through the specified Interface.

Default: Manual

The IPv4 host that can access the IPv6 network when the Mode is Manual.
The Teredo server when the Mode is Teredo.
Default: None

The interface that the MCR-MGT Management Module is going to use to
access the Remote Host.

Default: Ethernet 1

The Access node allows you to configure which services can be used to access the MCR-MGT
module as well as configuring specific parameters for Web, SSH and SNMP access. It also allows
for the configuration of a filter to determine which hosts will be granted access to the Management

Module.
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Chassis View MCR-MGT-100634 » Management Module View » Access
\N;I_anagemem Module | Management Module Access Settings
iew
[E Chassis Network g t services:
[ Network Senice Listening Network Port
[“]Web Manager (HTTP)  TCP 80
[E Web Manager
B ssH [“]Web Manager (HTTPS) TCP 443
[E SNMP SSH TCP 22
[ Authorized
Hosts M Telnet TCP 23
[2 Authentication SNMP UDP 161
and Accounting
2 Alerts SetlP UDP 33815

[E Date and Time
[ Display Formats

; Session Inactivity Timeout: 3600/ seconds
[ Files

[¥] Allow Incoming Pings

Unchecking the box next to each of the services listed above, will disable this service and users will

no longer be able to reach the MCR-MGT module using that service.

The session inactivity timer is only used when “Bypass login” is not enabled (i.e. login is required). If

no activity is detected on the session for the amount of time configured here, the session will be
terminated.

MCR Web Manager

MCR_MGT-100631 » Management Module View » Access » Web Manager
Web Manager

~HTTPS

SS5L Certificate Passphrase:

Manage SSL Certificate. .
Configure the following parameter.

SSL Certificate This is the SSL/TLS passphrase used to generate an encrypted RSA/DSA

Passphrase private key. This private key and passphrase are required for both HTTPS and
SSL/TLS connections, unless an unencrpyted private key was generated, then
the SSL passphrase is not required. Make sure that you download the SSL
private key and certificate if you are using the secure HTTP option (HTTPS) or
SSL/TLS. If both RSA and DSA private keys are downloaded to the MCR-
MGT Management Module, they need to be generated using the same SSL
passphrase for both to work.

SSH

The Management Module contains SSH Server software that you need to configure if the
Management Module is going to be accessed via SSH. If you specify more than one Authentication
method and/or Cipher, the Management Module will negotiate with the client and use the first
authentication method and cipher that is compatible with both systems.
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Functionality

When you are using the SSH connection protocol, keys need to be distributed to all users and the
Management Module. Below is an example scenario for key/certificate distribution.

Users Logging into the Management Module Using SSH

In the following example, users are connecting to the Management Module via SSH from the LAN.

Therefore, the following keys need to be exchanged:

e Install Management Module SSH Public Key to each user’s host machine who is connecting
and logging into the Management Module using SSH.

® Get the SSH Public Key from each user’s host machine who is connecting and logging into the
Management Module using SSH.

Lynn
Management Module Public Key
==\ Lynn Private Key

o |
T e & Tracy
_— N N Management Module
£ £ Management Mod Public Key
L==' Management Module Tracy Private Key
Server Server Private Key Dennis
Lynn Public Key Management Module Public Key
Tracy Public Key -\ Dennis Private Key
Dennis Public Key

Field Descriptions

MCR-DEMO » Management Module View » Access » SSH
SSH Server

[ Allow SSH-1 Protocol
Authentication

RSA DSA Keyboard Interactive
Password

Ciphers
3DES Blowfish AES

casT Arcfour

Break String: [~break

[ Enable Verbose
Output

[ Allow Compression

Configure the following parameters:
Allow SSH-1 Allows the user’s client to negotiate an SSH-1 connection, in addition to SSH-
Protocol 2.

Default: Disabled

RSA When a client SSH session requests RSA authentication, the Management
Module’s SSH server will authenticate the user via RSA.

Default: Enabled

DSA When a client SSH session requests DSA authentication, the Management
Module’s SSH server will authenticate the user via DSA.

Default: Enabled

Keyboard- The user types in a password for authentication.
Interactive Default: Enabled
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Password

3DES

CAST

Blowfish

Arcfour

AES

Enable Verbose
QOutput

Allow Compression

SNMP

Management Module View

The user types in a password for authentication.
Default: Enabled

The Management Module SSH server’s 3DES encryption is enabled/disabled.
Default: Enabled

The Management Module SSH server’s CAST encryption is enabled/disabled.
Default: Enabled

The Management Module SSH server’s Blowfish encryption is
enabled/disabled.

Default: Enabled

The Management Module SSH server’s Arcfour encryption is
enabled/disabled.

Default: Enabled

The Management Module SSH server’s AES encryption is enabled/disabled.
Default: Enabled

Displays debug messages on the terminal.
Default: Disabled

Requests compression of all data. Compression is desirable on modem lines
and other slow connections, but will only slow down things on fast networks.

Default: Disabled

If you are using SNMP to manage/configure the Management Module, or to view statistics or traps,
you can connect to the Management Module using either of the two pre-defined communities.

Community = public, IP address = 0.0.0.0 (any), Permissions = Readonly

Community = private, IP address = 0.0.0.0 (any), Permissions =Readwrite

You must load the management.MIB (found on the CD-ROM packaged with the Management
Module) file into your SNMP manager before you connect to the Management Module.
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MCR-MGT-100634 » Manage

SNMP

Contact Informati

Contact: cotnact Location: location

Communities (Ve

Community

public
private
a

f

Users (Version 3)

ment Module View » Access » SNMP

on

rsion 1 and Version 2)

1234
0000
56738
1223

Read-Write:
User: abcd

Security Level Auth/Privacy ~
Auth Algorithm- SHA ~
Auth Password:  [ssssssss
Privacy Algorithm-  |AES ~
Privacy Password: |[seeeesss

Configure the following parameters.

Contact

Location

Community

Internet Address

Permissions

Users (Version 3)

Users

Internet Address

Read-Only-

effg
Auth/Privacy
DS

Management Module View

Permissions
Readanly ~
Readwrite
Readwrite ~

Readwrite

The name and contract information of the person who manages this SMNP

node.

The physical location of the SNMP node.

The name of the group that devices and management stations running SNMP

belong to.

The IP address of the SNMP manager that will send requests to the MCR-MGT
module. If the address is 0.0.0.0, any SNMP manager matching the
Community name configured, can access the MCR-MGT module. If you
specify a network address, for example 172.16.0.0, any SNMP manager
residing on the 172.16.x.x subnet with a matching Community name can
access the MCR-MGT module.

Field Format: IPv4 or IPv6 address

Defines the level of access this community has.

Data Options:

® None—No access will be granted to members of this community.

® Readonly—Read access will be granted to members of this community.

® Readwrite—Read and write access will be granted to members of this

community.
Default: None

This section is used to configure the attributes associated with a "read-only"
type user and a "read-write" type user. For each parameter you configure an
entry in either or both of these columns. It is only used to define V3 users.

Enter the user name for the SNMP v3 user. This name must match the v3 user
name configured in the SNMP manager.
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Security Level

Authentication
Algorithm

Authentication
Password

Privacy Algorithm

Privacy Password

Management Module View

Select the security level for the user. This must match the configuration set up
in the SNMP manager.

Data Options:
® None—No security is used.
e Auth—User authentication is used.

® Auth/Priv—User authentication and privacy (encryption) settings are
used.

Default: None

Specify the authentication algorithm that will be used for the user.
Data Options: MD5, SHA
Default: MD5

Type in the user’s authentication password.

Specify the authentication algorithm that will be used for the user.
Data Options: MD5, SHA
Default: MD5

Type in the user’s privacy password.

Authorized Hosts

You can configure which hosts will be permitted access to the MCR-MGT module. Up to 16 hosts
can be defined by IP address and an additional 16 hosts can be defined by MAC address. When
enabled, only hosts matching the IP address or MAC address of an entry in this table will be allowed
to access the MCR-MGT Management Module.

MCR-DEMO » Management Module View » Access » Authorized Hosts

Authorized Hosts

System Access Policy:
O Allow all network hosts

Authorized Hosts

IP Address Description MAC Address Description
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Field Descriptions

System Access Data Options:
Policy o Allow all network hosts— Allows any host to connect to the MCR-MGT
Management Module.
® Only allow authorized hosts—A security feature that when enabled, the
Management Module will only accept data from or send data to hosts
configured in this table.

Add Authorized Adds an authorized host.

Host

Edit Authorized  Edits an authorized host.
Host

Delete Authorized De¢letes an authorized host.
Host

Authentication and Accounting

This node allows the administrator to configure the security and accounting methods which will be
used by the MCR-MGT module.

MCR-MGT-100634 October 14, 2010 10:51:24 PST
perle 172.16.22.30 User's Guide | User: admin | Logout

Chassis View MCR-MGT-100634 » Module View » and
Management Module | Authentication and Accounting

View

Ch
DS O Bypass Login
[ Network
M e @ Require Login
and Accounting Primary Authentication Gahed
[El User Accounts Method: RADUS =
B Alerts Kerberos
[2) Date and Time LDAP/Active Directory

TACACS+

[2 Display Formats SecurlD i

3 Files

Secondary Authentication
erberos ”~
LDAP/Active Directory
[ only use as backup M
SecurlD
NIS hd

The default settings are not to have any security or accounting enabled (“Bypass login™). It is up to
the administrator to lock down the access to the module if desired. When “Bypass login” is enabled,
the user is never prompted with a login prompt.

If “Require Login” is enabled, users will be prompted to login to the MCR-MGT module before
access is granted. The default username and password are;

User name --> admin
Password --> superuser

You can define additional users via the “User Accounts” node. The “admin” user cannot be deleted.
however the password (“superuser”) can be changed.
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Field Descriptions

MCR-MGT-100634 » Management Module View » Authentication and Accounting
Authentication and Accounting

O Bypass Login
@ Require Login

Primary Authentication
Method: L
ocal ~
Kerberos
LDAP/Active Directory
TACACS+ ~
Secondary Authentication

Method:

None ~
Local

[ Only use as backup RADIUS

Kerberos
LDAP/Active Directory |+

Configure the following parameters.

Bypass login

Require Login

Primary
Authentication
Method

Only use as backup

When “Bypass login” is selected (enabled), a user accessing the MCR-MGT
module is not asked to login.

Default: Enabled

When "Require Login" is selected (enabled), a user accessing the MCR-MGT
module is presented with a login prompt or screen before they can obtain
access to the management module. The default user name is "admin" and the
default password is "superuser". The "admin" user can not be deleted, however
the password for this user can be changed.

Default: Disabled

Select the primary (or only if "none" is selected for the secondary)
authentication method to be used to authenticate users attempting to access the
MCR-MGT management module.

Data Options:

Local

Radius

Kerberos

LDAP/Active Directory
TACACS+

SecurelD

NIS

Default: Local

If this option is selected (enabled), the secondary authentication method will
only be attempted if the MCR-MGT module can not reach the primary
authentication host. (i.e. if the primary authentication host indicates that the
user does not have access, the secondary authentication method will not be
attempted). In other words, the secondary is only used as a backup to the
primary in case the primary is not available.

If this options is not selected (disabled), the secondary authentication will
always be tried if the primary authentication is not successful (for any reason
including an indication from the primary that the user is not authenticated).

Default: Disabled (not selected).
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Specific authentication methods

Local

When Local authentication is selected, the user must be configured in the Management Module’s
User Accounts list. A maximum of 31 users can be configured in the list.

Field Descriptions

User Accounts

lyn Operator
test Operator

Add User X

User Name:

Password:

Confirm

Password:

Level: Qperator v

Configure the following parameters:

User Name The name of the user.
Restrictions: Do not use spaces.

Password The password the user will need to login into the Management Card.
Level The access that a user is allowed.
Data Options:

® Admin—The admin level user has total access to the Management
Module. You can create more than one admin user account but we
recommend that you only have one. They can monitor and configure the
Management Module.

® Operator—The Operator level user has no write access to make
configuration changes to the Management Module. They are able to read
all management module configuration and to control and reset media
converter modules, the management module and the chassis.

When the admin user logs into the Management Module using CLI (via Telnet
or SSH), the prompt ends with a #, whereas all other users’ prompts ends with
a $ or £, depending on the character set.

Default: Operator

51



Management Module View

RADIUS

When setting up users on the Radius host, you can specify the permission level this user will have on
the MCR-MGT Management Module (i.e. admin or operator). To do this, you need to set the radius
parameter “Service Type” to one of the following values;

Service_Type Value Permission
1 - Login Operator

3 - Callback-Login Operator

6 - Administrative User Admin

11- Callback Administrative User Admin

If the “Service_Type” parameter is not returned by the Radius server or if it contains any other value
from the one defined above, the firmware will look for a user record in the local data base. If one is
found, the permission level will be extracted from this record. If no matching user is found in the
local database, the user will be given the default permission of “Operator”

General Field Descriptions

MCR-DEMO » Management Module View » Users » RADIUS

RADIUS Authentication

RADIUS Settings RADIUS Attributes

RADIUS
First Authentication Host:

Mone -
Second Authentication Mone 3
Host:
Authentication Port: 1812

Accounting

[J Enable Accounting
First Accounting Host:
Second Accounting Host:

Accounting Port:

Enable Accounting Authenticator

RADIUS Configuration

Retry: L] Timeout: 3 seconds

Configure the following parameters:
First Authentication Name of the primary RADIUS authentication host.
Host Default: None

Second Name of the secondary RADIUS authentication host, should the first RADIUS
Authentication Host host fail to respond.

Default: None

Authentication Port The port that the RADIUS host listens to for authentication requests.
Default: 1812

Change Secret The secret (password) shared between the Management Module and the
RADIUS authentication host.

Enable Accounting Enables/disables RADIUS accounting.
Default: Disabled
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First Accounting  Name of the primary RADIUS accounting host.
Host Default: None

Second Accounting Name of the secondary RADIUS accounting host.
Host Default: None

Accounting Port ~ The port that the RADIUS host listens to for accounting requests.
Default: 1813

Change Secret The secret (password) shared between the Management Module and the
RADIUS accounting host.

Enable Accounting Enables/disables whether or not the Management Module validates the
Authentication RADIUS accounting response.

Default: Enabled

Retry The number of times the Management Module tries to connect to the RADIUS
server before erroring out.

Range: 0-255
Default: 5

Timeout The time, in seconds, that the Management Module waits to receive a reply
after sending out a request to a RADIUS accounting or authentication host. If
no reply is received before the timeout period expires, the Management
Module will retry the same host up to and including the number of retry
attempts.

Range: 1-255
Default: 3 seconds

Attribute Field Descriptions

MCR-DEMO » Management Module View » Users » RADIUS
RADIUS Authentication

RADIUS Settings |[eEBlEERCGITER

Attributes
NAS-Identifier:
® Automatically determine NAS-IP-Address & Automatically determine NAS-IPv6-Address
O Use the following NAS-IP-Address: O Use the following NAS-IPv6-Address:
IP Address: IPv6 Address:
Apply

Configure the following parameters:

NAS-Identifier This is the string that identifies the Network Address Server (NAS) that is
originating the Access-Request to authenticate a user.

Field Format: Maximum 31 characters, including spaces

Automatically When enabled, the Management Module will send the Management Module’s
determine NAS-IP- Ethernet IPv4 address to the RADIUS server.
Address Default: Enabled
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Use the following = When enabled, the Management Module will send the specified IPv4 address
NAS-IP-Address  to the RADIUS server.

Default: Disabled

IP Address The IPv4 address that the Management Module will send to the RADIUS
server.

Default: 0.0.0.0

Automatically When enabled, the Management Module will send the Management Module’s
determine NAS- IPv6 address to the RADIUS server.
IPv6-Address Default: Enabled

Use the following = When enabled, the Management Module will send the specified IPv6 address
NAS-IPv6-Address to the RADIUS server.

Default: Disabled

IPv6 Address The IPv6 address that the Management Module will send to the RADIUS
server.

Field Format: IPv6 address
Kerberos

Field Descriptions

MCR-DEMO » Management Madule View » Users » Kerberos
Kerberos Authentication

Realm:
KDC Domain:
KDC Port: 88

Configure the following parameters.

Realm The Kerberos realm is the Kerberos host domain name, in upper-case letters.

KDC Domain The name of a host running the KDC (Key Distribution Center) for the
specified realm. The host name that you specify must either be defined in the
Management Module’s Host Table before the last reboot or be resolved by
DNS.

KDC Port The port that the Kerberos server listens to for authentication requests.
Default: 88
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LDAP/Microsoft Active Directory

LDAP (Lightweight Directory Access Protocol) is an application protocol for querying and
modifying directory services running over TCP/IP. It is also used as a method of authenticating users.
Microsoft Active Directory is an LDAP like directory service. It can be used for authenticating users
in a similar fashion to LDAP. In this manual, the use of LDAP is synonymous with Microsoft Active
Directory.

Field Descriptions

MCR-DEMO » Management Madule View » Users » LDAP/Active Directory

LDAP/Active Directory Authentication

Host:
Port: 389
Base:
User Attribute:
@ OpenLDAP (uid)
© Microsoft Active Directory (sAMAccountName)
O Other:
[ Encrypt Passwords Using MD5 Digest
O Authenticate With LDAP Server
Name:
Append Base To Name
Password:
Confirm:
[ Enable TLS
TLS Port

Configure the following parameters.

Host Name The name or IP address of the LDAP/Microsoft Active Directory host. If you
use a host name, that host must either have been defined in the Management
Module’s Host Table before the last reboot or be resolved by DNS. If you are
using TLS, you must enter the same string you used to create the LDAP
certificate that resides on your LDAP/Microsoft Active Directory server.

Port The port that the LDAP/Microsoft Active Directory host listens to for
authentication requests.

Default: 389

Base The domain component (dc) that is the starting point for the search for user
authentication.

User Attribute This defines the name of the attribute used to communicate the user name to
the server.
Options:

® OpenLDAP(uid)—Chose this option if you are using an OpenLDAP
server. The user attribute on this server is “uid”.

® Microsoft Active Directory(sAMAccountName)—Chose this option if
your LDAP server is a Microsoft Active Directory server. The user
attribute on this server is “sAMAccountName”.

® Other—If you are running something other than a OpenLDAP or
Microsoft Active Directory server, you will have to find out from your
system administrator what the user attribute is and enter it in this field.

Default: OpenLDAP(uid)

55



Management Module View

Encrypt Passwords Checking this parameter will cause the Management Module to encrypt the

Using MDS digest

Authenticate with
LDAP server

Name

Append Base to
Name

Password

Confirm

Enable TLS

TLS Port

password using MD5 digest before sending it to server. If this option is not
checked, the password is sent to the server in the clear.

Default: Disabled

This option will cause the Management Module to authenticate with the LDAP
server before the user authentication takes place. The user name/password to
use for this authentication is configured below.

Default: Disabled
The user name associated with the Management Module.

When checked, this causes the domain component configured in the “base”
parameter to be appended to the user name. This allows for a fully qualified
name to be used when authenticating the Management Module.

Default: Enabled but if the base parameter is not configured, it does not
modify the name.

The password associated with the user name for authenticating the
Management Module.

Default: Blank

You must enter the exact same value as the password field. Since the password
is not echoed, this ensures that the field was entered correctly.

Default: Blank

Enables/disables the Transport Layer Security (TLS) with the LDAP/Microsoft
Active Directory host.

Default: Disabled.

Specify the port number that LDAP/Microsoft Active Directory will use for
TLS.

Default: 636

If you are using LDAP or Microsoft Active Directory with TLS, you need to Install a CA list to the
Management Module that includes the certificate authority (CA) that signed the LDAP certificate on
the LDAP host by selecting Files, Keys and Certificates. See Appendix B, SSL/TLS Ciphers for
more information on the LDAP certificate.
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Management Module View

Field Descriptions

MCR_MGT-100631 » Management Module View » Users » TACACS+

TACACS+ Authentication

~ Authentication/Authori

Primary Host:

Secondary Host:
Port:

Secret:

zation

None &

None &

49

Change Secret___

[ Enable Authorization

Primary Host:

Secondary Host:
Port:

Secret:

[ Enable Accounting

Cluse Alternate Service Names

Configure the following parameter.

Authentication/
Authorization
Primary Host

Authentication/
Authorization
Secondary Host

Authentication/
Authorization Port

Authentication/
Authorization
Secret

Enable
Authorization

Enable Accounting

Accounting
Primary Host

Accounting
Secondary Host

The primary TACACS+ host that is used for authentication.
Default: None

The secondary TACACS+ host that is used for authentication, should the
primary TACACS+ host fail to respond.

Default: None

The port number that TACACS+ listens to for authentication requests.
Default: 49

The TACACS+ shared secret is used to encrypt/decrypt TACACS+ packets in
communications between two devices. The shared secret may be any
alphanumeric string. Each shared secret must be configured on both client and
server sides.

Enables authorization on the TACACS+ host, meaning that Management
Module-specific parameters set in the TACACS+ configuration file can be
passed to the Management Module after authentication.

Default: Disabled

Enables/disables TACACS+ accounting.
Default: Disabled

The primary TACACS+ host that is used for accounting.
Default: None

The secondary TACACS+ host that is used for accounting, should the primary
accounting TACACS+ host fail to respond.

Default: None
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Accounting Port

Accounting Secret

Use Alternate
Service Names

Management Module View

The port number that TACACS+ listens to for accounting requests.
Default: 49

The TACACS+ shared secret is used to encrypt/decrypt TACACS+ packets in
communications between two devices. The shared secret may be any
alphanumeric string. Each shared secret must be configured on both client and
server sides.

The TACACS+ service name for Telnet or SSH is normally “raccess”. The
service name for MCR Web Manager is “EXEC”. In some cases, these service
names conflicted with services used by Cisco devices. If this is the case,
checking this field will cause the service name for Telnet or SSH to be
“perlecli” and the service name for MCR Web Manager to be “perleweb”.
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Management Module View

If you need to reset the SecurlD secret, select Administration, Authentication, Securid, Settings,
Reset SecurlD Node Secret.

Field Descriptions

MCR_MGT-100631 » Management Module View » Users » SecurlD

SecurlD Authentication

Primary/Master Host:
Replica/Slave Host:
UDP Port:

Encryption Type:

[] Use Legacy Mode

Reset Node Secret

None v
None v
5500
SDI +

Apply

Configure the following parameters.

Primary/Master
Host

Replica/Slave Host

UDP Port

Encryption Type

Legacy

Reset Node Secret

The first SecurID server that is tried for user authentication.
Default: None

If the first SecurID server does not respond to an authentication request, this is
the next SecurlD server that is tried for user authentication.

Default: None

The port number that SecurID listens to for authentication requests.
Default: 5500

The type of encryption that will be used for SecurID server communication.
Data Options: DES, SDI
Default: SDI

1If you are running SecurID 3.x or 4.x, you need to run in Legacy Mode. If you

are running SecurlD 5.x or above, do not select Legacy Mode.
Default: Disabled

Resets the SecurlD secret (password) in the Management Module.
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NIS

Field Descriptions

MCR_MGT-100631 » Management Module View » Users » NIS

NIS Authentication
NIS Domain:
Primary NIS Host: None ¥
Secondary NIS Host: None ¥

Configure the following parameters.

NIS Domain The NIS domain name.

Primary NIS Host The primary NIS host that is used for authentication.
Default: None

Secondary NIS Host The secondary NIS host that is used for authentication, should the primary NIS

host fail to respond.
Default: None
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Alerts

er]E MCR-MGT-100903 October 14, 2010 5:28:32 PM EDT
p 172.16.113.79 User's Guide | User: admin | Logout
Chassis View MCR-MGT-100203 » Management Module View » Alerts
Manzgement odue | Local Alerts
View
b |5 Chassis
» [ Networc Log Alerts Locally
¢ || Acoess
y [d Authentication Alert Level
and Accounting
Systemdevel Moduledevel Persistent One-time Significant Hormal
|& Email Fault Fault Emor Ermor Event Operation
[ Syskg

i) Displsy Formats
» (2 Files

The MCR-MGT Management Module supports the ability to provide notification of important events
occurring in the system. The events can be communicated via one or more of the following methods;

® Local Event Log
® Email

® Syslog

® SNMP traps

For a complete list of all alerts and their associated level, please see Appendix A, Alert Messages.
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Local Event Log

The MCR-MGT Management Module has a built-in local event log. The event log is a circular buffer
that can hold up to 200 local event messages. Once the log is full, the oldest entries will be replaced
with new entries. The date and time of when the event occurred is recorded with each event.

The local event log buffer will be cleared if the Management Module is rebooted.

Field Descriptions

MCR1900-100631 » Management Module View » Alerts
Local Alerts

Log Alerts Locally

~Alert Level

System-level Module-level Persistent One-time Significant Normal
Fault Fault Error Error Event Operation

Configure the following parameters:

Log Alerts Locally When enabled, alert events are logged to the built-in local event log.

Alert Level Choose the alert level that will trigger a notification to be sent to the local log.
Data Options:
System-level Fault
Module Level Fault
Persistent Error
One-time error
Significant Event
Normal Operation.

The level selected is the minimum trigger level with the "Normal
Operation" being the least severe and "System-level Fault" being the most
severe. The level selected will include alerts of that level and all more
severe levels above it.

Default: Normal Operation
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Management Module View

Email notification requires an SMTP host that is accessible by the Management Module to process
the email messages sent by the Management Module.

Field Descriptions

MCR1900-100631 » Management Module View » Alerts » Email

Email Alerts

[ Send Email Alerts

~Alert Level

System-level  Modulelevel
Fault Fault

Persistent
Error Emor Event

Onetime  Significant Normal ‘

Operation

To:

Subject:

From: ‘

Reply To:

Outgoing Mail Server (SMTP):
Username:

Password:

Encryption:
TCP Port:
NTLM Domain:

None |+

Verify Peer Certificate
25

Configure the following parameters:

Send Email Alert

Email Alert Level

To

Subject

Reply To

Outgoing Mail
Server

Username

Enables/disables Email Alerts.
Default: Disabled

Choose the alert level that will trigger a notification to be sent to the local log.
Data Options:

System-level Fault

Module Level Fault

Persistent Error

One-time error

Significant Event

Normal Operation.

The level selected is the minimum trigger level with the "Normal
Operation" being the least severe and "System-level Fault" being the most
severe. The level selected will include alerts of that level and all more
severe levels above it.

Default: Normal Operation

An email address or list of email addresses that will receive the email
notification.

A text string, which can contain spaces, that will display in the Subject field of
the email notification.

The email address to whom all replies to the email notification should go.

The SMTP host (email server) that will process the email notification request.
This can be either a host name defined in the Management Module host table or
the SMTP host IP address.

If your mail server requires you to authenticate with it before it will accept
email messages, use this field to configure the authorized user name. Maximum
size of user name is 64 characters.
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Encryption

Verify Peer
Certificate

TCP Port

NTLM Domain

Management Module View

Enter the password associated with the user configured in “Username”.
Maximum size of password is 64 characters.

Choose the type of encryption desired. Valid options are;
None - All information is sent in the clear.

® TLS - Select this if your email server requires TLSAIl data from previous
connections on that serial port has drained

® SSL - Select this if your email server requires SSL

When checked this will enable the validation of the certificate presented by the
email server. To validate the certificate, you will need to download the
appropriate CA list into the Management Module. If the certificate is not found
to be valid, the communication with the email server will be terminated. No
authentication will take place and the email message will not be forwarded to
the email server. If this option is not checked, the certificate validation will still
be attempted but if it fails, a syslog message will be generated but the
authentication and forwarding of the email will still take place.

Default: Enabled if SSL or TLS encryption is selected. Disabled if no
encryption is selected.

This is the TCP port used to communicate with the email server.
Default: 25 for non-SSL, 465 if SSL/TLS is used

This field is only used if SPA authentication is performed with the email

server. It may or may not be required. If the email server does not expect this
field, it can be left blank.
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Syslog

The Management Module can be configured to send system log messages to a syslog daemon
running on a remote host if the Syslog service is activated. You can configure a primary and
secondary host for the syslog information and specify the level for which you want syslog
information sent.

Field Descriptions
MCR_MGT-100631 » Management Module View » Alerts » Syslog
Syslog

Send syslog messages

Syslog Level

Emergency Alert Critical Error Warning Motice Info Debug
System-level Module-level Persistent One-time Significant Normal

Fault Fault Error Error Event Operation

Alert Level
Primary Host: i labgw V

Secondary Host: | None b

Configure the following parameters:

Send Syslog Alert Enable/disable syslog alert settings.
Default: Disabled

Syslog Level Choose the alert level that will trigger a syslog message to be sent.
Data Options:

Emergency (System-level Fault)

Alert (Module Level Fault)

Critical (Persistent Error)

Error (One-time error)

Warning (Significant Event)

Notice (Normal Operation)

Info

Debug

The level selected is the minimum trigger level with the '"Debug' being the
least severe and "System-level Fault" being the most severe. The level
selected will include alerts of that level and all more severe levels above it.

Default: Normal Operation

Primary Host The Primary Host where syslog alerts will be send.

Secondary Host The Secondary Host where the syslog alerts will be send.
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Management Module View

If MCR-MGT Management Module supports the use of SNMP traps to communicate significant
events to an SNMP trap host. Up to 4 trap hosts can be defined to receive the traps. Each host can be
configured independently for the version of traps that it supports.

The MCR-MGT Management Module supports v1, v2¢ and v3 traps.

Field Descriptions

MCR-MGT-100903 » Management Module View » Alerts » SNMP Traps

SNMP Traps

Send SNMP Traps

Alert Level

System-level  Module-level

Persistent One-time Significant Normal

Fault Fault Error Error Event Operation

Internet Address SNMP Version = Type Community (SNMPv1 and SNMPv2c)  UDP Port
17216 113 117 v3 |~ [Inform [&2 162
(o]
O
(ud]
SNMPv3 User Inform Settings
Username: Inform Timeout: 1000| milliseconds
Security Level: MNone h Inform Retries: 3

Apply

Advanced
SNMP Engine 1D: ‘EUUUUTEEUJE130332\1303U323731305431303U3935 Change_

Configure the following parameters:

Send SNMP Traps

Alert level

Trap checkbox

Internet Address

Enables/Disables SNMP Alerts.
Default: Disabled

Choose the alert level that will trigger an SNMP trap to be sent.
Data Options:

System-level Fault

Module Level Fault

Persistent Error

One-time error

Significant Event
e Normal Operation.

The level selected is the minimum trigger level with the "Normal
Operation" being the least severe and "System-level Fault" being the most
severe. The level selected will include alerts of that level and all more
severe levels above it.

Default: Normal Operation

Check this box to enable the entry for this trap host.
Default: Disabled

Enter the IP address of the host you wish to send the trap to.
Field Format: IPv4 or IPv6 address
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SNMP Version

Type

Community

UDP Port

SNMP V3 User

User Name

Security Level

Authentication
Algorithm

Authentication
Password

Confirm
Authentication
Password

PrivacyAlgorithm

Privacy Password

Management Module View

Defines the SNMP version of the traps sent to the specified host. If v3 is
selected then the SNMP trap v3 user will be used to authenticate the trap with
the specified host. Valid options are v1, v2c or v3.

Default: v1

This field is ignored for trap host version v1"
Data Options:

Trap -Management module will send traps via a TRAP_PDU or TRAP2-PDU
not expecting any response from the specified host.

Inform -Management module will send traps via an INFORM_PDU, expecting
a response from the specified host.

Default: Trap

The name of the group that devcies and management stations running SNMP be-
long to. This applies to SNMP version 1 and version 2c.

Enter the UDP port number that the SNMP trap host is listening on for UDP
traps.

Default: 162

This section is used to configure the attributes associated with a trap "user". It
is only used if the trap version is set to V3.

This field identifies the system sending the traps to the host receiving the traps.
Same user name is used for all V3 traps sent by this system.

Select the security level for the user. This must match the configuration set up
in the SNMP manager.

Data Options:
® None—No security is used.
® Auth—User Authtication is used.

e Auth/Priv—User authentication and privacy (encryption) settings are
used.
Default: None

Specify the authentiation algorithm that will be used for the user.
Data Options: MDS5, SHA
Default: MD5

Type in the user’s authentication password.

Retype the user’s authentication password.

Specifiy the encryption algorithm to be used with this user.
Data Options: DES, AES
Default: DES

Type in the user’s privacy password.
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Confirm Password Retype the privacy password.

Inform Retires This is only used for "Inform" traps. Select the number of seconds to wait for
the acknowledgement of the trap.

Default: 1 second

This is only used for "Inform" traps. Select the number of times the trap will
be sent if no acknowledgement is received.

Default: 3

Inform Retries

SNMP Engine ID  The engine ID is used to help identify the trap sender to the trap receiver when
using v3 traps. It is a unique identifier of the SNMP agent in the domain. By
default the Engine ID is composed using the serial number of the Management
Module which should make it unique. If you wish to assign a different engine
ID to this node, click on the "Change" button. When changing the engine ID,
the string entered in this field will be combined with other required elements to
form the EnginelD. It is up to the user to ensure that this will be a unique
string.

Date and Time

The Management Module has a real-time internal clock, allowing the date and time to be set and
viewed. It will maintain the time over a short power outage and after reboots of the Management
Module. If you do not set the time, it will start the clock at the factory set time.

Time Zone Settings

You can set standard and summer time (daylight savings time) in the Management Module. You can
specify the summer time settings as absolute, on a fixed date and time, or relative, on something like
the third day of the third week at this time in June.

Time Zone Settings

@ Select time zone from list: | Canada/Eastemn v
[ Adjust clock automatically for daylight saving time (summer time)

O Specify time zone and daylight saving time (summer time) rules manually

Select time zone from list:
Adjust clock automatically for daylight saving time

Specific time zone and daylight saving time rules manually Time Zone/Summer Time Tab Field
Descriptions
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Field Descriptions

Time Zone Settings

O Select time zone from list:

{] Specify time zone and daylight saving time (summer time) rules manually

~Time Zone

Name: EST

Offset: -5:00 UTC/GMT

- Daylight Saving Time {Summer Time)

Name: EDT

Offset: 60| minutes

Mode
© None
© Fixed
® Recurring

End Date:

Month
Start Date: March

MNovember v |/ 1 |/

Week Day Time
|/ 2 &/ Sunday v 02:00

Sunday v 02:00

Py

Configure the following parameters:

Time Zone Name

Time Zone Offset

Summer Time
Name

Summer Time
Offset

Summer Time
Mode

Fixed Start Date

Fixed End Date

The name of the time zone to be displayed during standard time.

Field Format: Maximum 4 characters and minimum 3 characters (do not use
angled brackets <>)

The offset from UTC for your local time zone.
Field Format: Hours A4 (valid -12 to +14) and minutes mm (valid 0 to 59

minutes)

The name of the configured summer time zone; this will be displayed during

the summer time setting. If this parameter is not set, then the summertime

feature will not work.

Field Format: Maximum 4 characters and minimum 3 characters (do not use
angled brackets <>)

The offset from standard time in minutes. Valid values are 0 to 180.
Range: 0-180
Default: 60

You can configure the summer time to take effect:

e None—No summer time change.

e Fixed—The summer time change goes into effect at the specified time
every year. For example, April 15 at 1:00 pm.

® Recurring—The summer time changes goes into effect every year at same
relative time. For example, on the third week in April on a Tuesday at 1:00
pm.

Default: None

Sets the exact date and time in which the Management Module’s clock will
change to summer time (daylight saving time) hours.

Sets the exact date and time in which the Management Module’s clock will
end summer time hours and change to standard time.
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Recurring Start Sets the relative date and time in which the Management Module’s clock will
Date change to summer time (daylight saving time) hours. Sunday is considered the
first day of the week.

Recurring End Date Sets the relative date and time in which the Management Module’s clock will
end summer time hours and change to standard time. Sunday is considered the
first day of the week.

Network Time Tab

You can configure your SNTP client in the Management Module to automatically synchronize the
Management Module’s time.

Field Descriptions

Date and Time Network Time (SNTP)

SNTP Settings

Set date and time automatically using SNTP
SNTP Mode:
SNTP Version: 4v

Unicast +

[0 Enable Authentication
Primary Host: ntp_server ¥
Key 1D:

Secondary Host: MNone v

Key 1D:

Configure the following parameters.

SNTP Mode The SNTP mode. The SNTP client listens on UDP port 123.
Data Options:
® None—SNTP is turned off.
o Unicast—Sends a request packet periodically to the Primary host. If
communication with the Primary host fails, the request will be sent to the
Secondary host.
® Multicast—Listen for any broadcasts from an SNTP server and then
synchronizes its internal clock to the message.
® Anycast—Sends a request packet as a broadcast on the LAN to get a
response from any SNTP server. The first response that is received is used
to synchronize its internal clock and then operates in Unicast mode with
that SNTP server.
Default: None
SNTP Version Version of SNTP.
Range: 1-4
Default: 4
Enable Sets SNTP server authentication on or off
Authentication Default: Off

Primary Host

The name of the primary SNTP server from the Management Module host
table. Valid with Unicast and Multicast modes, although in Multicast mode,
the Management Module will only accept broadcasts from the specified host
SNTP server.
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Secondary Host The name of the secondary SNTP server from the Management Module host
table. Valid with Unicast and Multicast modes, although in Multicast mode,
the Management Module will only accept broadcasts from the specified host
SNTP server.

Key ID Specify the key id associated with this host. This key must exist in the sntp
(symmetric key) file that was downloaded to the MCR-MGT management
card.

Valid Key ID’s: 1-65534

(Note: the structure for the sntp (symmetric key) file can be found in this
guide. Appendix F, Symmetric Key File

Display Formats

Files

The Display Format tab allows you to customize the way date, time, temperature and power are
displayed.

Field Descriptions
MCR_MGT-100631 » Management Module View » Display Formats
Display Formats

Customize the way date, time, temperature and power are displayed.

Date (short format):  MM/DD/YYYY +

Time: @ 12-Hour Clock O 24-Hour Clock

Temperature: ®°c O°F

SFP Power Units: O mW (milliwatts) © dBm (decibel milliwatts)
Apply

Configure the following parameters:
Date The Date can be express in the following formats:
e MM/DD/YYYY
e DD/MM/YYYY
e YYYY-MM-DD
Default: MM/DD/YYYY

Date Time can be express in the following formats:
e [2-Hour Clock
® 24-Hour Clock
Default: 12-Hour Clock

Temperature Temperature can be expressed as Celsius or Fahrenheit

SFP Power Units  Power can be expressed in mW (milliwatts) or dBm (decibel milliwatts) for SFP
modules.

Firmware

Allows you to update new firmware to the Management Module and any installed Media Converter
Modules.

You can choose to use TFTP or HTTP as the method of transferring the files. If TFTP is used, you
must have a TFTP server set up with the firmware files residing on it. With HTTP, you can use the
same PC as the one which your browser is running on without the need for any additional software.

71



Management Module View

You must agree to the Perle Licensing Agreement and the Privacy Policy in order to download
firmware.

When the Licensing Agreement window appears, specify your country. If you reside in Germany you
must select “Germany” as your country. Germany has unique licensing requirements. After selecting
your country click on the I Agree button.

License Agreement b

Please specify the country in which the MCR-MGT is located: 2lect Countr V<—

License Agreement x

Please specify the country in which the MCR-MGT is located: | All Other Countries ¥

END USER LICENSE AGREEMENT

Please review this end user license agreement (this "Agreement”) carefully. This Agreement constitutes a legal
agreement between You (either an individual or single entity, such as a company) ("You") and Perle Systems Limited
("Perle"). By clicking on the applicable "l agree” button, downloading, copying, installing, activating or otherwise using
the software Perle makes available on Perle’s website or any of Perle’s software loaded or pre-installed in devices,
equipment, or products sold or offered for sale by Perle (the "Perle Software”), You do so with the intent to electronically
"execute” and agree to be bound by this Agreement. IF YOU DO NOT AGREE TO ALL OF THE TERMS AND
CONDITIONS OF THIS AGREEMENT, You have no right to use the Perle Software and You should (a) return,
delete, or disable the Perle Software or (b) if You purchased a product from Perle or its reseller or distributor
on which the Perle Software is pre-installed by Perle, return the purchased product to Perle or the
applicable reseller or distributor from whom You obtained the product.

1. License Uses and Restrictions. Subject to the terms and conditions of this Agreement, Perle grants to You a
personal, revocable, limited, non-exclusive, non-tr (except as otk d) license to download,
install, and use the Perle Software in object code format in association with Perle's products. With respect to any
Perle Software available for download by You from Perle’s website, You may make one copy of the Perle Software
on Your computer in machine-readable form for backup purposes only, provided that the backup copy must include
all copyright or other proprietary notices contained on the original. Such copy will be the sole and exclusive
property of Perle. No right to copy any Perle Software is otherwise granted under this Agreement. This Agreement
does not grant You any other rights, and You have no rights to use any aspect of Perle Software. You may not
distribute or make the Perle Software available over a network where it could be accessed, downloaded, or used by
others. You will not modify, rent, lease, loan, sell, make available, re-sell, offer for re-sale, distribute, sublicense, or
create derivative works based on, the Perle Software, in any manner, and You will not exploit the Perle Software in
any unauthorized manner whatsoever. You will only use the Perle Software and any portions thereof in accordance
with this Agreement and all applicable laws and regulation. Perle may make available updates and upgrades to the
Perle Software on its website (the "Software Updates”). The Software Updates is made available from time to time
solely at Perle's option. The Software Updates may come with its own terms and conditions, provided however that
if it does not, You may only use and install such Software Updates under the terms and conditions of this

For Perle Software for which vou nav license fees (the "Paid Software”) the Paid Software mawv anby he

| Agree

Click on the I Agree checkbox, then click Install.
&) PerleVIEW Setup - | = [

Privacy Policy
®

By clicking "l agree” below, you agree that Perle may collect, use, or
disclose custorner information in the course of fulfilling its obligations under
the End User License Agreement, and such collection, use, and disclosure
will be in accordance with Perle's privacy policy available at

<httpn: e, perle. cam/privacy. shirl>

1 agree and accept the terms of the Privacy Policy

[ epadk [ sl | [ caneel |

The download will now continue and firmware will be downloaded to each of the modules specified.
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After the download has completed, a status dialog will appear.

Firmware Update Results x

Slot  Firmware Update Result  Firmware Version

4 Successful 1.2G61
8 Successful 1.2G61

MCR 1900 Media Converter Module Firmware Update

Manual Update

Manually update one or more managed Media Converter Modules of the same type.

MCR-MGT-100634 » Management Module View » Files » Firmware » Media Converter Module
Update Media Converter Module Firmware

—Choose Update Method

OAutumatically update media module firmware from management module
© Manually update media module firmware

-~ Select Modules to Update

Module Type: | CM-110 b
Update Slot  Name Firmware Version Select All
O 10 CM-110-M28T2 1.1G1
Clear All

File: | " Browse_

W=

From the drop down box, select the Module Type.

Select Update for each module to be upgraded.

Displayed is a list of slots which contain this Module Type.

Either select Web or TFTP to perform the firmware update.
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Automatic Update

Automatically update managed Media Converter Modules. Only media converter modules that are
running older versions of the firmware will be updated.

MCR-MGT-100634 » Management Module View » Files » Firmware » Media Converter Module
Update Media Converter Module Firmware

—Choose Update Method

® Automatically update media module firmware frem management module
This management module contains a bundle of firmware, which is used to automatically update installed media modules.

Automatic updates occur when:
+ Management module is restarted
# Chassis is power cycled
* Media module is inserted

Media module firmware bundle is included with management module firmware.

Module Type Firmware Version
CMm-100 1161
Ccm-110 1161
CM-1000/CM-1000-SFP 1.0G2
CM-1110 1161
CM-1110-SFP 1161
CM-100MM 1.0A2
CM-1000MM 1.0A2

O Manually update media module firmware

Apply | Change has not been applied.

The Media Converter Module firmware bundle is included with management module firmware.
Automatic updates will occur when the:

e Management Module is restarted
® Chassis is power cycled

® Media Converter Module is inserted

Note: Remember to click the Apply button to save your configuration changes.

SMI Media Converter Firmware Update

Manual Update
MCR-MGT-VI » Management Module View » Files » Firmware » Media Converter Module
Update Media Converter Module Firmware

~—Module Informati

Module Type:
Slot ~ MName Firmware Version
2 CM-110-52LC120 1.0G3
Web |SEIRI

The managed Media Converter Module to be updated will be shown. Either select Web or TFTP to
perform the firmware update.

74



Management Module View

Automatic Update
MCR-MGT-100634 » Management Module View » Files » Firmware » Media Converter Module
Update Media Converter Module Firmware

~Choose Update Method

® Aut tically updat: di dule firmware from management module
@ This management module contains a bundle of firmware, which is used to automatically update installed media modules.

Automatic updates occur when:
* Management module is restarted
* Chassis is power cycled
* Media module is inserted

Media module firmware bundle is included with management module firmware.

Hide Bundle Info &

Module Type Firmware Version
CM-100 1.1G1
CM-110 1.1G1
CM-1000/CM-1000-5FF  1.0G2
CM-1110 1.1G1
CM-1110-5FP 1.1G1
CM-100MM 1.0A2
CM-1000MM 1.0A2
Oom Ily updat: di dule firmware

Apply | Change has not been applied.

The Media Converter Module firmware bundle is included with management module firmware.
Automatic updates will occur when the:

® Management Module is restarted
® Chassis is power cycled
® Managed Media Converter Module is inserted

Note: Remember to click the Apply button to save your configuration changes.

Configuration

This option allows you to Backup and Restore configuration files. You can choose to backup the
configuration in Binary (native) format or as a text file. The text file can be viewed and edited with a
standard text editor.

Keys and Certificates

Allows you to install Keys and Certificates to the Management Module. See Appendix B, SSL/TLS
Ciphers for more information.
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Manage SSL Keys

Field Descriptions

MCR_MGT-100631 » Management Module View » Files » Keys and Certificates
Manage Keys and Certificates

Manage keys and certificates for SSH and WebManager (HTTPS).

KeyiCertificate:
Key Type:

Get Server SSH Public Key v
RSA »

TFTP

Configure the following parameter

Key/Certificate

Key Type

Web/TFTP

Diagnostic File

Select key or certificate to be transferred to or from the management module.
Data Options:

® Get Server SSH Public Key.

Install SSH User Public Key.

Install SSL/TLS Private Key, required if using HTTPS and/or SSL/TLS
Install SSL/TLS Certificate, required if using HTTPS and/or SSL/TLS.

Install SSL/TLS CA, required if using LDAP/Microsoft Active Directory
with TLS, SSL/TLS.
e Install SNTP Keys File, required if using SNTP authentication.

Specify the key type that will be used for SSH/SSL.
Data Options:

e RSA

e DSA

Choose the method by which to download/upload keys/certificates. TFTP
requires a TFTP server to be accessible by the MCR-MGT management
module.

Should the Management Module experience any problems, a Perle Technical support representative
may ask you to get this file and sent it to us. Uploading this file will permanently remove it from the
non-volatile memory on the MCR-MGT Management Module.

Bootup Files

Provides the ability to configure the host and file name from which the firmware and/or configuration
for the MCR-MGT Management Module can be retrieved from when the module is booted. A check
will be made to determine if the filename has changed since the previous load. If it matches the name
of the file downloaded previously, no download will occur. The files must reside on a TFTP server
which is accessible to the MCR-MGT Management Module.
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TFTP Settings
Provides the ability to configure the timeout and number of retires when doing a TFTP file transfer.

MCR-MGT-100903 » Management Module View » Files » TFTP Settings
TFTP Settings

Settings for TFTP file transfers.

TFTP Retries:
TFTP Timeout: seconds
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CM-1

00 Media Converter

Module

CM-100 Media Converter Module Parameters

MCR1900 Chassis

perle

MCR-MGT-100634 [» | Slot 5

Slot 5 - CM-100-M28C2

MCR-MGT-100634
172.16.22.30

March 02, 2011 4:06:35 PM EST
User's Guide | User: admin | Logout

A Hide Chas:

006140

Fiber Port Advanced

o

Copper Port Alert Log

Slot

Name: CM-100-M25C2
Model: CM-100-M25C2
Description: Fast Ethemnet Media Converter Managed Mod

km/1.24 miles]
CM-

100BASE-TX (RJ45) [100 m/328 f] to 100BASEX 1310nm multimode (SC) [2

—Hardware Setup

Configuration Jumper: Auto ¥ Current Switch Settings

100 Media Converter Module
J

Copy Settings

SMI Chassis

perie

MCR-MGT-900084 [» | Slot 2

Slot 2 - CM-100-M25C2

Copper Port || Fiber Port || Alert Log

MCR-MGT-200084
172.16.113.66

May 28, 2013 20:38:59 EDT
User's Guide | User: admin | Logout

4 Hide Chassis
Chassis Infa

SMI-100-M25C2

Advanced | Slot

CM-100-M28C2
CM-100-M28C2

Name:
Model:

kmi1.24 miles]

Description: Fast Ethernet Media Converter Managed Module. 100BASE-TX (RJ45) [100 m/328 f] to 100BAS

¥ Details

-X 1310nm multimode (SC) [2

Hardware Setup

[ConfiguralionJumper:Autu ¥

Current Switch Settings J

CM-100 Media Converter Module

Settings

MCR-MGT Management Module User’s Guide, Version 1.8




CM-100 Media Converter Module Parameters

General Tab

Field Descriptions

Slot 5 - CM-100-M2SC2
Copper Port | Fiber Port | Alert Log | Advanced | Slot
Name: CM-100-M2SC2
Model: CM-100-M25C2

Description: Fast Ethemnet managed media converter card 100BASE-TX (RJ-45) [100 m/328 f.] to 100BASE-FX 1310nm multimode (SC) [2 km/1.2
miles]

Setup

‘ Configuration Jumper: Auto ¥  Current Switch Settings...

[ Settings | ————
Name Displays the configured name for this Module.
Model Displays the module’s model information.
Description Displays a description of the Module that is inserted in this slot.
Configuration All'tO: Use.software configuration if present, otherwise use hardware DIP
Jumper switch settings.

Switch: Use hardware DIP switch settings.

For detailed information on hardware DIP switch settings, see the Hardware
Installation Guide.

Current Switch Displays the current DIP switch settings.

Settings For detailed information on hardware jumpers and DIP settings, see the
Hardware Installation Guide.
Details Displays the firmware’s details.
Settings
Module Settings x
Name: CM-100-M25C2|

Link Mode: | Passthrough v
Far End Fault

Name Displays the configured name for this Module.
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Link Mode Smart Link Pass-Through: In this mode, the link state on one connection is
directly reflected through the Media Converter Module to the other connection.
If link is lost on one of the connections, then the other link will be brought
down by the Media Converter.
Standard: In this mode, the links on the fiber and copper sides can be brought
up and down independently of each other. A loss of link on either the fiber or
copper port can occur without affecting the other connection.

Default: Smart Link Passthrough

Far End Fault When enabled, if the Media Converter Module detects a loss of signal on the
fiber receiver, it will transmit a FEF signal to the remote Media Converter
Module. This, in effect, notifies the fiber link partner that an error condition
exists on the fiber connection.
Note: This feature only takes effect if Auto Negotiation has been turned off.
When disabled, the Media Converter Module will not monitor for or generate
Far End Fault.

Default: On

Copy Settings
Slot 5 - CM-100-M25C2
Copper Port | Fiber Port || Alert Log | Adwvanced | Slot
Name: CM-100-M25C2
Model: CM-100-M25C2

Description: Fast Ethemet managed media converter card 100BASE-TX (RJ-45) [100 m/328 ft] to 100BASE-FX 1310nm multimode (SC) [2 km/1.2
miles]

—Hardware Setup

Configuration Jumper: Auto “¥  Current Switch Settings. ..

Copy Settings.. +—

Copy Module Settings x

Copy this module’s settings to other modules of the same type:

Copy Slot Name

™ 14 CM-100-M25T2
Copy Module Copy this module’s settings to other modules of the same type.
Settings
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Copper Port Tab

Copper Port > Settings

Slot 5 - CM-100-M25C2

General (WL ERSG | Fiber Port || Alert Log | Advanced | Slot

Name:

Connector: RJ45
Link Status: Up
Auto Negotiation: Complete
Duplex: Full
Pause: Symmetrical
MDI/MDI-X: MDI
Copper Port Settings

Enable Port

Name:

Auto-Negotiation
Pause

MDIMDI-X: @& Auto © MDI O MDI-X

Configure the following parameter.

Enable Port

Name

Auto-Negotiation

Pause

MDI/MDXI

Enables/Disables the copper port.
Default: Enable

The name of the copper port.
Field Format: 8 characters

When enabled, the Media Converter Module will negotiate with its link partner
to determine the most optimal parameters for this connection.

When enabled, the Media Converter Module will advertise its Pause
capabilities.

® Auto-Detect— automatically detects the Ethernet’s cable polarity
® MDI —the cable’s polarity is straight-through

® MDI-X —the cable’s polarity is crossovered

Default: Auto-Detect
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Fiber Port Tab

Fiber Port Settings

Slot 5 - CM-100-M2SC2

General | Copper Port Iiﬁﬁl Alert Log || Advanced | Slot

Name:
Connector: SC
Link Status: Up

Far End Fault: 0K
Loopback Mode: Disabled

[Senge ) ———

Settings

Fiber Port Settings x

Configure the following parameter:

Name The name of the fiber port.
Field Format: 8 characters

Alert Log Tab
Field Descriptions
Slot 5 - CM-100-M2SC2

General | Copper Port || Fiber Port m = 4 Lot

1 10 %
Date ~ Description Severity
2010-09-23 13:17:48 CM-100-M28C2 (slot 5): Fiber port link status UP. Significant Event
2010-09-23 13:17:48 CM-100-M2SC2 (slot 5): Copper port link status UP. Significant Event
2010-09-23 13:17:48 CM-100-M2SC2 (slot 5): OK. Significant Event
2010-09-23 13:17:48 CM-100-M2SC2 (slot 5): Has been inserted. Model=CM-100-M25C2, S/N=101-212110M1000. Significant Event
:

Displays the current local Alerts. The local Alert buffer contains the last 200 alerts and displays these
events in a wrap around fashion.

Advanced Tab

Field Descriptions
Slot 5 - CM-100-M2SC2

General Copper Port | Fiber Port | Alert Log W

Restart Module — Diagnosti A
Fiber Loopback:
Reset to Factory Defaults
¥ Advanced Diagnostics

82



Slot Tab

CM-100 Media Converter Module Parameters

Configure the following parameter:

Restart Module  Restarts this Media Converter Module.

Reset to Factory ~ Resets this Media Converter Module back to factory defaults.
Defaults

Diagnostics

Fiber Off: This is the normal setting. In this setting, data received on the fiber port
Loopback will be passed through the Media Converter Module.

On: This is a test mode. All data received on the receive (RX) fiber connection
is looped back to the transmit (TX) fiber connection.

Default: Off

Advanced This feature should only be used if guided by a Perle Technical Support
Diagnostics,  Representative. Use of this feature without guidance from a Perle Technical

Read/Write Support Representative could make your Media Converter Module inoperable.
Register

Field Descriptions
Slot 5 - CM-100-M2SC2

General | Copper Port || Fiber Port w

- Slot Settings

Default Power State: ©0n O Off

[ Backup/Restore Module Configuration Automatically

Configure the following parameters:

Power Immediately power the slot on or off. The current state of the slot is
highlighted in BLUE.
Press the "ON" button to immediately power the slot on.
Press the "OFF" button to immediately power the slot off.

Default Power State This is the default power state of the slot when the chassis is powered up or
restarted.

Default: On

Backup/Restore Enabled: The configuration information associated with this slot is saved on
the Management Module and will be downloaded to the Media Converter
Module whenever the Media Converter Module is inserted into this slot.

Disabled: The Media Converter Module configuration information is only kept
on this Module.

Default: Disabled
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CM-110 Media Converter
Module

CM-110 Media Converter Module Parameters

MCR1900 Chassis

EﬂE MCR-MGT-VI March 01, 2011 15:57-31 EST
p 172 16.54 106 User's Guide | User: admin | Logout

A Hide Chassis

MCR-MGT-VI [» | Slot 6

006142

. Cx-1000 _ Cx-1000 _

L Cx-1110 _ Cx-1000 _

Slot 6 - CM-110-M2SC2 k

Copper Port | Fiber Port || Alert Log Advan\ Slot

Name:  CM-110M25C2
Model: CM-110-M28C2
Description: 10/100 Fast Ethernet Media and Rate Converter Managed M . 10/100BASE-TX (RJ45) [100 m/328 ft] to 100BASE-X 1310nm

multimode (SC) [2 km/1.24 miles]
el CM-110 Media Converter Module

‘ Configuration Jumper: Auto ¥  Current Switch Settings... ‘

Copy Settings_._

MCR-MGT Management Module User’s Guide, Version 1.8
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SMI Chassis

Er,E MCR-MGT-900084 May 28, 2013 20-32-34 EDT
p 172 16.113 .66 User's Guide | User: admin | Logout
MCR-MGT-200084 [» | Slot 2 SMI-110-S2LC120 & Hide Chassis
| *

Slot 2 - CM-110-S2LC120
Copper Port || Fiber Port | Alert Log | Advanced | Slot

Name: CM-110-S2LC120 ¥ Details

Model: CM-110-82LC120

Description: 10/100 Fast Ethernet Media and Rate Converter Managed Module. 10/100BASE-TX (RJ45) [100 n/328 f] to 100BASE-X 1550nm
single mode (LC) [120 km/74 4 miles]

CM-100 Media Converter Module

{Hardware Setup

Configuration Jumper: Auto @ Current Switch Ssttings J

Settings

General Tab
General > Settings

Slot 6 - CM-110-M2SC2
Copper Port || Fiber Port | Alert Log || Advanced | Slot
Name:  CM-110-M25C2
Model:  CM-110-M25C2

Description: 10/100 Fast Ethernet Managed Media and Rate Converter Card 10/100Base-TX (RJ-45) [100 m/328 f.] to 100BASE-FX 1310nm
multimode (SC) [2 km/1.2 miles]

~Hard Setup

Configuration Jumper: Auto ¥ Current Switch Settings...

Name Displays the configured name for this Module.

Model Displays the module’s model information.

Description Displays a description of the Module that is inserted in this slot.
Configuration Auto: Use software configuration if present, otherwise use hardware DIP
Jumper switch settings.

Switch: Use hardware DIP switch settings.

For detailed information on hardware DIP switch settings, see the Hardware
Installation Guide.

Current Switch Displays the current DIP switch settings.

Settings For detailed information on hardware jumpers and DIP settings, see the
Hardware Installation Guide.

Details Displays the firmware’s details.
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Module

Advanced

Switch Features

Name: CM-110-M25T2|

Link Mode: | Passthrough +

Far End Fault

Configure the following parameters.

Name

Link Mode

Far End Fault

Displays the configured name for this Module.

Standard: In this mode, the links on the fiber and copper sides can be brought
up and down independently of each other. A loss of link on either the fiber or
copper port can occur without affecting the other connection.

Smart Link Pass-Through: In this mode, the link state on one connection is
directly reflected through the Media Converter Module to the other connection.
If link is lost on one of the connections, then the other link will be brought
down by the Media Converter.

Default: Smart Link Pass-Through
When enabled, if the Media Converter Module detects a loss of signal on the
fiber receiver, it will trasmit a FEF signal to the remote Media Converter

Module. This, in effect, notifies the fiber link partner that an error conditiion
exists on the fiber connection.

Note: This feature only takes effect if Auto Negotiation has been turned off.

When disabled, the Media Converter Module will not monitor for or generate
Far End Fault.

Default: Enabled

Slot 6 - CM-110-M2SC2
Copper Port | Fiber Port | Alert Log | Advanced | Slot
Name:  CM-110-M2SC2
Model: ~ CM-110-M25C2

Description: 10/100 Fast Ethernet Managed Media and Rate Converter Card 10/100Base-TxX (RJ-45) [100 m/328 ft ] to 100BASE-FX 1310nm
multimode (SC) [2 km/1.2 miles]

Hard Setup

Configuration Jumper: Auto &

Current Switch Settings_ ..

Settings | Copy Settings.. gp————-----ou
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Copy Settings
Copy Module Settings X
Copy this module's settings to other modules of the same type:
Copy Slot Name
i 11 CM-110-M25T2
Copy Module Copy this module’s settings to other modules of the same type.
Settings

General > Settings > Advanced

Module x

Maximum Packet Size: 01522 @ 2048

Maximum Packet Select the maximum packet size.
Size Options: 1522 bytes or 2048 bytes
Default: 2048
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General > Settings > Switch Features

Module

X

O Copper to Fiber
O Fiber to Copper

Unidirectional Ethernet: (%) Disabled
Map Priority to Egress Queue:

Priority Queue

0

:

2

3

4

5

6

7

Configure the following parameters.

Unidirectional When enabled, this feature provides the ability to restrict the flow of data

Ethernet between the Copper and fiber ports.
Values:

Disabled
Copper to Fiber
Fiber to Copper

Default: Disabled

Map Priority to This is the default egress priority mapping for both the copper and fiber ports.

Egress

Priority 0 (lowest priority)......Queue 0

Priority 1 ..o Queue 0
Priority 2 ..o Queue 1
Priority 3 ..o Queue 1
Priority 4 ..o Queue 2
Priority 5 .ooveieiee e Queue 2
Priority 6 ..coeveiieeieeee Queue 3

Priority 7 (highest priority) ....Queue 3
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Copper Port Tab

Copper Port > Properties

Slot 6 - CM-110-M25C2

W Fiber Port ” Alert Log ” Advanced ‘ Slot

-

Name:

Connector: RJ-45

Link Status: Up

Auto Negotiation: Complete
Speed: 100
Duplex: Full
Pause: Symmetrical

MDI/MDI-X: MDI-X

Copper Port - Statistics

w Fiber Port H Alert Log ” Advanced ‘ Slot

Frames
Receive Errors:

Receive Filtered:
Transmit Collisions:

~Bytes
Received (Good): 0
Received (Error): 0
Transmitted: 0
Detailed

~R d Frames

~Tri itted Frames

~Frame Lengths

oo o oo

~Good Frames ~Good Frames 64 Bytes:
Unicast Frames: 0 Unicast Frames: 0 65 to 127 Bytes:
Broadcast Frames: 0 Broadcast Frames: 0 128 to 255 Bytes:
Multicast Frames: 0 Multicast Frames: 256 to 511 Bytes:
Pause (Flow Control) 0 Pause (Flow Control) 0 512 to 1023 Bytes:
Frames: Frames: 1024 to Maximum
L J J Bytes:
—Bad Frames 8
FCS Errors: 0
Undersized Frames: 0 Deferred Frames: 0
Liagmentiiames: s Collisions (excluding 0
Oversized Frames: 0 Late and Excessive):
Jabber Frames: 0 Late Collisions: 0
MAC Receive Errors: 0 Excessive Collisions: 0
FCS Errors: 0 Single Collisions: 0
g Multiple Collisions: 0

Copper Port > Properties

Slot 6 - CM-110-M2SC2

General Fiber Port ” Alert Log ” Advanced | Slot

Statistics

Name:
Connector: RJ-45
Link Status: Up
Auto Negotiation: Complete
Speed: 100
Duplex: Full
Pause: Symmetrical
MDI/MDI-X: MDI-X
+—
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Copper Port > Settings (Auto negotiate speed and duplex)

Copper Port

SERIGER  Advanced

X

Enable Port

Name:

® Auto-negotiate speed and duplex
Advertise the following capabilities:
10 Mbps, Full Duplex 10 Mbps, Half Duplex
100 Mbps, Full Duplex [¥]100 Mbps, Half Duplex

O Set speed and duplex manually

Pause

MDI/MDI-X: ® Auto OmMDI O MDI-X

Configure the following parameters.

When enabled, the Media Converter Module will negotiate with its link partner

Enable Port Enables/Disables the copper port.
Default: Enable

Name The name of the copper port.
Field Format: 8 characters

Auto Negotiate

Speed and Duplex

Set Speed and

to determine the most optimal parameters for this connection.
Advertise capabilities of:

e 10 Mbps, Full Duplex
® 100 Mbps, Full Duplex
® 10 Mbps, Half Duplex
® 100 Mbps, Half Duplex

When enabled, the following selections are available:

‘When enabled, the Media Converter Module will advertise its Pause

Duplex Manually  gpeed: 100 Mbps, 10 Mbps
Duplex: Full, Half

Pause
capabilities.

MDI/MDI-X

® Auto-Detect— automatically detects the Ethernet’s cable polarity
® MDI —the cable’s polarity is straight-through

® MDI-X —the cable’s polarity is crossovered

Default: Auto
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Copper Port > Settings (Set speed and duplex manually)

Copper Port

Settings

Advanced

X

Enable

Name:

Speed:
Duplex:

Pause

Port

[ 1]

O Auto-negotiate speed and duplex
{%] Set speed and duplex manually
100 Mbps O 10 Mbps
@ Full O Half

MDI/MDI-X: @ Auto O mMDI O MDI-X

Configure the following parameters.

Set Speed and
Duplex Manually  gpeed: 100 Mbps, 10 Mbps

When enabled, the following selections are available:

Duplex: Full, Half

Copper Port > Advanced

Copper Port

X

10BASE-T Distance: O Normal @ Extended

Configure the following parameters.

10BASE-T Distance Normal: the Media Converter copper link is in normal operating mode.

Extended: the Media Converter will boost the signal strength on its copper
link.
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Switch Features

Copper Port > Switch Features > Priority

Copper Port x

W.- g kot Fogging || Other

Use 802.1p Tag Priority

Use IP TOS Priority

Priority Precedence: @ g02.1p CIP TOS

Congestion Policy:  ® Strict Queueing O Weighted Queueing

R p 802.1p Tag Priority:
Criginal Priority ~ Mew Priority

H

0w
1 [E

el & il ] el

Configure the following parameters.

Enable 802.1p When enabled, the media converter module will use IEEE 802.1p tagged frame
Priority priority control to assign ingress frames to the appropriate priority egress queue.
Default: Enabled

Enable IP TOS When enabled, the media converter module will use IPv4 Diffserv or IPv6 traffic
Priority class field to assign ingress frames to the appropriate priority egress queue.
Default: Enabled

Priority Precedence When both 802.1p priority and IP TOS priority are selected, you can select which
of the two priorities takes precedence.
Default: 802.1p
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Remap Priority

Congestion Policy

Remap IEEE 802.1p ingress frames with a new priority tag. This new priority tag
will be used to determine which queue the frame gets posted to.

Original Priority ----- > New Priority

Values: 0-7

Select a method to be used when determining the order by which frames are sent
from the four egress queues. Setting the congestion policy on either the fiber or
copper port will change the policy on both ports.

Strict Priority Queuing - The order is determined strictly by the priority of the
queue. Frames in higher priority queues are always sent ahead of frames in lower
priority queues.

Weighted Fair Queuing - This method allows lower priority frames to be inter-
mixed with higher priority frames in the ratio of (8, 4, 2, 1).

The ratio for 8 highest priority sent frames will be as follows:

8 highest priority frames from queue 3

4 frames from queue 2

2 frames from queue 1

1 frame from queue 0

Default: Strict Priority Queuing

Copper Port > Switch Features > Rate Limiting

Copper Port

X

Egress Rate Limit:

Ingress Rate Limit: | MNone hd

MNaone hd

Configure the following parameters.

Ingress Rate Limit Restricts ingress frames on the copper port.

Egress Rate Limit

Default: None
Data Options: 64 kbps to 90 Mbps

Restricts egress frames on the copper port.
Default: None
Data Options: 64 kbps to 90 Mbps
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Copper Port > Switch Features- VLAN Tagging

Copper Port b

Priority | Rate Limiting Wﬁa—

[ Discard Tagged Frames

[ Discard Untagged Frames

Default VLAN ID: 1

Default Priority: IE|

VLAN Tagging Action: & Normal O Untag O Tag O Double Tag

Configure the following parameters.
Discard Tagged When enabled, discards all VLAN tagged frames.
Frames Default: Off

Discard Untagged When enabled, discards all VLAN untagged frames.
Frames Default: Off

Default VLAN ID Specify a default VLAN ID to insert when tagging frames.
Default: 1
Data Options: 0-4095

Default Priority Specify a default VLAN priority to insert when tagging frames.
Default: 0
Data Options: 0-7

VLAN Tagging Define the VLAN tagging action to take on a egress frame.
Actions ® Normal -Take no action.

e Untag - Remove any existing tag.

® Tag
Insert tag with configured VLAN ID and VLAN priority if original
frame is untagged.

Replace tag with configured VLAN ID and VLAN priority if original
frame is tagged.

® Double tag - Append a tag with configured VLAN ID and VLAN priority.
Default: Normal

Copper Port > Switch Features > Other

Copper Port x

Priority || Rate Limiting || VI

[CIFilter Unknown Multicast Frames

[CIFilter Unknown Unicast Frames
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Configure the following parameters.

Filter Unknown  When enabled, multicast frames with unknown destination addresses are not

Multicast Frames allowed to egress this port.
Default: Disabled

Filter Unknown  Yhen enabled, unicast frames with unknown destination addresses are not

Unicast Frames allowed to egress this port.
Default: Disabled

Fiber Port Tab
Field Descriptions > Properties
Slot 5 - CM-110-M2ST2

General | Copper Port Alert Log | Advanced

Slot

Statistics

Name:

Connector: ST
Receive Status: Fault
Link Status: Down

Far End Fault:  Sending Far End Fault
Loopback Mode: Disabled

(Seings ) ¢————

Fiber Port > Statistics
Slot 10 - CM-110-M25T2

General Copper Port |MEGESSEGE Alert Log || Advanced | Slot

Properties w_

— Bytes ~Frames
Received (Good): 0 Receive Errors:
Received (Error): 0 Receive Filtered:

Transmitted: 0 Transmit Collisions:

Single Collisions:

Undersized Frames: 0 Tt Bees
bagmetiiianes: s Collisions (excluding
Oversized Frames: 0 Late and Excessive):
Jabber Frames: 0 Late Collisions:

MAC Receive Errors: 0 Excessive Collisions:
FCS Errors: 0

Maltinko Collind

Detailed
~R d Frames - —Tr d Frames

~Good Frames ~Good Frames
Unicast Frames: 0 Unicast Frames: 0
Broadcast Frames: 0 Broadcast Frames: 0
Multicast Frames: 0 Multicast Frames: 0
Pause (Flow Control) 0 Pause (Flow Control) 0
Frames: Frames:

—Bad Frames [

FCS Errors: 0

b o oo

—Frame Lengths
64 Bytes:
65 to 127 Bytes:
128 to 255 Bytes:
256 to 511 Bytes:
512 to 1023 Bytes:

1024 to Maximum
Bytes:

s oo
o

o o oo o
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Fiber Port > Properties
Slot 5 - CM-110-M2ST2

General Copper Port Iiﬁal Alert Log || Advanced | Slot
Statistics

Name:

Connector: ST
Receive Status: Fault
Link Status: Down

Far End Fault:  Sending Far End Fault
Loopback Mode: Disabled

Fiber Port Settings

Fiber Port Settings b

Switch Features

Enable Port

Name: l:l

Duplex: @ Full O Half

Configure the following parameters.

Enable Port Enables/Disables the fiber port.

Name The name of fiber port 1.
Field Format: 8§ characters

Duplex The following Duplex modes are available:

Duplex: Full, Half
Default: Full
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Switch Features
Switch Features > Priority

Fiber Port Settings x

Wing Other

Use 802.1p Tag Priority

Use IP TOS Priority

Priority Precedence: @ g02.1p CIP TOS

Congestion Policy:  ® Strict Queueing O Weighted Queueing

R

p 802.1p Tag Priority:

Criginal Priority ~ Mew Priority

.
=l (=] [ £ [5%] ra - [=]
L 1 | | | | | |

Configure the following parameters.

Enable 802.1p When enabled, the media converter module will use IEEE 802.1p tagged frame
Priority priority control to assign ingress frames to the appropriate priority egress queue.

Default: Enabled

Enable IP TOS When enabled, the media converter module will use IPv4 Diffserv or IPv6 traffic
Priority class field to assign ingress frames to the appropriate priority egress queue.

Default: Enabled

Priority Precedence When both 802.1p priority and IP TOS priority are selected, you can select which

of the two priorities takes precedence.
Default: 802.1p
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Congestion Policy

Remap Priority

Select a method to be used when determining the order by which frames are sent
from the four egress queues. Setting the congestion policy on either the fiber or
copper port will change the policy on both ports.

Strict Priority Queuing - The order is determined strictly by the priority of the
queue. Frames in higher priority queues are always sent ahead of frames in lower
priority queues.

Weighted Fair Queuing - This method allows lower priority frames to be inter-
mixed with higher priority frames in the ratio of (8, 4, 2, 1).

The ratio for 8 highest priority sent frames will be as follows:

8 highest priority frames from queue 3

4 frames from queue 2

2 frames from queue 1

1 frame from queue 0

Default: Strict Priority Queuing

Remap IEEE 802.1p ingress frames with a new priority tag. This new priority tag
will be used to determine which queue the frame gets posted to.

Original Priority ----- > New Priority

Values: 0-7

Switch Features > Rate Limiting

Fiber Port Settings

Ingress Rate Limit:
Egress Rate Limit:

X

Configure the following parameters.

Ingress Rate Limit Restricts ingress frames on the fiber port.

Egress Rate Limit

Default: None
Data Options: 64 kbps to 90 Mbps

Restricts egress frames on the fiber port.
Default: None
Data Options: 64 kbps to 90 Mbps

Switch Features > VLAN Tagging

Fiber Port Settings

X

[ Discard Tagged Frames
[ Discard Untagged Frames

Default Priority:

Priority | Rate Limiting W

Default VLAN ID:

VLAN Tagging Action: & Normal O Untag C Tag C Double Tag

98



CM-110 Media Converter Module Parameters

Configure the following parameters.

Discard Tagged
Frames

Discard Untagged
Frames

Default VLAN ID

Default Priority

VLAN Tagging
Actions

Switch Feature

Fiber Port Settings

Priority || Rate Limiting

When enabled, discards all VLAN tagged frames.
Default: Off

When enabled, discards all VLAN untagged frames.
Default: Off

Specify a default VLAN ID to insert when tagging frames.
Default: 1
Data Options: 0-4095

Specify a default VLAN priority to insert when tagging frames.
Default: 0
Data Options: 0-7

Define the VLAN tagging action to take on a egress frame.
@ Normal -Take no action.

o Untag - Remove any existing tag.

e Tag
Insert tag with configured VLAN ID and VLAN priority if original
frame is untagged.

Replace tag with configured VLAN ID and VLAN priority if original
frame is tagged.

® Double tag - Append a tag with configured VLAN ID and VLAN priority.
Default: Normal

s > Other

VLA

[CIFilter Unknown Uni

[CIFilter Unknown Multicast Frames

cast Frames

Configure the following parameters.

Filter Unknown
Multicast Frames

Filter Unknown
Unicast Frames

When enabled, multicast frames with unknown destination addresses are not
allowed to egress this port.
Default: Disabled

When enabled, unicast frames with unknown destination addresses are not
allowed to egress this port.
Default: Disabled
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Alert Port Tab

Field Descriptions

Slot 6 - CM-110-M2SC2 £2 Refresh
General Copper Port || Fiber Port |EIE SR & = Lot
1 2 nexts lastz> [10w

Date > Description Severity

2010-09-23 14:55:28 CM-110-M2SC2 (slot 6): Fiber port link status UP. Significant Event
2010-09-23 14:55:27 CM-110-M2SC2 (slot 6): Copper port link status UP. Significant Event
2010-09-23 14:55:26 CM-110-M2SC2 (slot 6): Fiber port link status DOVWN. Significant Event
2010-09-23 14:55:26 CM-110-M2SC2 (slot 6): Copper port link status DOWN. Significant Event
2010-09-23 14:55:26 CM-110-M25C2 (slot 6): OK. Significant Event
2010-09-23 14:55:26 CM-110-M2SC2 (slot 6): Has been inserted. Model=CM-110-M25C2, S/N=101-412310M1000. Significant Event

Displays the current local Alerts. The local Alert buffer contains the last 200 alerts and displays these
events in a wrap around fashion.

Advanced Tab

Field Descriptions

Slot 6 - CM-110-M25C2
General || Copper Port || Fiber Port || Alett Log Wﬁ—
Restart Module ~Diagnostics —————————
Fiber Loopback
Reset to Factory Defaults
Virtual Cable Test
¥ Advanced Diagnostics

Configure the following parameter:

Restart Module

Reset to Factory
Defaults
Diagnostics

Fiber
Loopback

Virtual Cable
Test

Advanced
Diagnostics,
Read/Write
Register

Restarts this Media Converter Module.

Resets this Media Converter Module back to factory defaults.

Off: This is the normal setting. In this setting, data received on the fiber port
will be passed through the Media Converter Module.

On: This is a test mode. All data received on the receive (RX) fiber connection
is looped back to the transmit (TX) fiber connection.

Default: Off

Performs a Virtual Cable Test to remotely and non-evasively diagnose the quality
and characteristics of the attached ethernet cable. This test can detect issues such
as cable opens, cable shorts or any impedance mismatch in the cable and then ac-
curately report (within one meter) the distance of the fault. In addition, this Vir-
tual Cable Test will detect pair swaps, pair polarity reversal and excessive pair
skew.

This feature should only be used if guided by a Perle Technical Support

Representative. Use of this feature without guidance from a Perle Technical
Support Representative could make your Media Converter Module inoperable.
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Slot Tab

Field Descriptions
Slot 6 - CM-110-M2SC2

General | Copper Port | Fiber Port A\enw

— Slot Settings

Default Power State: & On O Off

[ Backup/Restore Module Configuration Automatically

Configure the following parameters:

Power Immediately power the slot on or off. The current state of the slot is
highlighted in BLUE.
Press the "ON" button to immediately power the slot on.
Press the "OFF" button to immediately power the slot off.

Default Power State This is the default power state of the slot when the chassis is powered up or
restarted.

Default: On

Backup/Restore Enabled: The configuration information associated with this slot is saved on
the Management Module and will be downloaded to the Media Converter
Module whenever the Media Converter Module is inserted into this slot.

Disabled: The Media Converter Module configuration information is only kept
on this Module.

Default: Disabled
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CM-1110/CM-1110-SFP
Module

CM-1110/SPF Media Converter Module Parameters

MCR1900 Chassis

EﬂE MCR-MGT-VI March 02, 2011 11:52:51 EST
p 172 16 .54 106 User's Guide | User: admin | Logout

A Hide Chassis

MCR-MGT-V1 [» ] Slat 11

[ B> N - |
[N ]

006142

1000 _ Ca-1000

Slot 11 - CM-1110-SFP k

Copper Port | Fiber Port || Alert Log | Advanced | Slot

i

Name: CM-1110-8FP

Model: CM-1110-SFP
Description: 10/100/1000 Gigabit Ethernet Media and Rate Converter Managed Module. 10/100/1008ASE-T (RJ45) [100 m/328 ft] to 1000BASE-X
SFP Slot

-Hardware Setup

Configuration Jumper: Auto ¥  Current Switch Settings... ‘

CM-1110 Media Converter Module

Copy Settings_..

EﬂE MCR-MGT-200084 May 28, 2013 19:36:39 EDT
p 172.16.113.66 User's Guide | User: admin | Logout
MCR-MGT-300084 [» | Slot 2 SMI-{110.SEP 4 Hide Chassis |

Chassis Info

s
I Sl CONGOLE

n

Slot 2 - CM-1110-SFP 2 Refresn

Copper Port || Fiber Port || Alert Log || Advanced Slot
Name: CM-1110-SFP ¥ Details

Model: CM-1110-SFP
Description: 10/100/1000 Gigabit Ethernet Media and Rate Converter Managed Module. 10/100/1000BASER (RJ45) [100 m/328 ft] to 1000BASE-X
SFP Slot

Configuration Jumper: Auto

Hardware Setup A
{ D Cuent Switch Settings } CM-1110 Media Converter Module

Settings

MCR-MGT Management Module User’s Guide, Version 1.8 102
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General Tab

Field Descriptions

Slot 11 - CM-1110-SFP
Copper Port | Fiber Port || Alert Log || Advanced | Slot
Name:  CM-1110-SFP
Model: ~ CM-1110-5FP

SFP Slot

Description: 10/100/1000 Gigabit Ethernet Media and Rate Converter Managed Module. 10/100/1000BASE-T (RJ45) [100 m/328 ft] to 1000BASE-X

H Setup

3

Configuration Jumper: Auto &/

Current Switch Settings__.

Settings Copy Settings...

Configure the following parameters.

Name

Description

Configuration
Jumper

Current Switch

Displays the configured name for this Module.
Displays a description of the Module that is inserted in this slot.

Auto: Use software configuration if present, otherwise use hardware DIP
switch settings.

Switch: Use hardware DIP switch settings.

For detailed information on hardware DIP switch settings, see the Hardware
Installation Guide.

Displays the current DIP switch settings.

Settings For detailed information on hardware jumpers and DIP settings, see the
Hardware Installation Guide.
Details Displays the firmware’s details.
Copy Settings
Slot 11 - CM-1110-SFP
Copper Port | Fiber Port | Alert Log | Advanced | Slot
Name:  CM-1110-SFP
Model: CM-1110-SFP
Description: 10/100/1000 Gigabit Ethernet Media and Rate Converter Managed Module. 10/100/1000BASE-T (RJ45) [100 m/328 ft] to 1000BASE-X
SFP Slot
~Hard Setup

Configuration Jumper: Auto &

Current Switch Settings...

Copy Settings.. —————
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Copy Module Settings

Copy this module’s settings to other modules of the same type:

Copy this module’s settings to other modules of the same type.

Copy Slot Name
i 8 CM-1110-M2SC05
Copy Module
Settings
Settings
Module *

Aol

Name: CM-1110-SFP|

Link Mode: | Smart Link Passthrough +

[¥I Fiber Fault Alert

Configure the following parameters.

Name

Link Mode

Fiber Fault Alert

Displays the configured name for this Module.

Smart Link Pass-Through: In this mode, the link state on one connection is
directly reflected through the Media Converter Module to the other connection.
If link is lost on one of the connections, then the other link will be brought
down by the Media Converter.

Standard: In this mode, the links on the fiber and copper sides can be brought
up and down independently of each other. A loss of link on either the fiber or
copper port can occur without affecting the other connection.

Default: Smart Link Passthrough
When enabled, if the Media Converter Module detects a loss of signal on the
fiber receiver, it will immediately disable its fiber transmitter signal. This in

effect, notifies the fiber link partner that an error condition exists on the fiber
connection.

Note: This feature only takes effect if Fiber Negotiation has been turned off.

When disabled, the Media Converter Module will not monitor for or generate
Fiber Fault Alert.

Default: On
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Advanced

Module x

Maximum Packet Size: (1522 C 2048 © 10240

Configure the following parameter.

Maximum Packet Select the maximum packet size.
Size Options: 1522, 2048, 10240
Default: 10240

Switch Features

Module x

Unidirectional Ethernet: (% Disabled

O Copper to Fiber
O Fiber to Copper

Map Priority to Egress Queue:

Priority Queue

.
LW (R R s o o
L 1 | | | | | |

Configure the following parameters:

Unidirectional When enabled, this feature provides the ability to restrict the flow of data
Ethernet between the Copper and fiber ports.

Values:

e Disabled

e Copper to Fiber
® Fiber to Copper

Default: Disabled
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Map Priority to

Egress Queue ® Priority 0 (lowest priority)......Queue 0
® Priority 1 Queue 0
® Priority 2 Queue 1
® Priority 3 Queue 1
® Priority 4 Queue 2
® Priority 5 Queue 2
® Priority 6 ............ weeeeee..Queue 3
® Priority 7 (highest priority) ....Queue 3

Copper Port Tab

Copper Port > Properties
Slot 11 - CM-1110-SFP

General Fiber Port | Alert Log | Advanced | Slot

Statistics

Name:

Connector: RJ-45

Link Status: Down

Auto Negotiation: In Progress
Speed: 10
Duplex: Half
Pause: Disabled

Link Partner Remote Fault Status: OK

Downshift Status: No

MDI/MDI-X: MDI-X

Copper > Port Statistics

Slot 11 - CM-1110-SFP

& Refresh

M Fiber Port | Alert Log | Advanced | Slot

Propertes [EEETe———————

~Bytes ~Frames
Received (Good): 0 Receive Filtered: 0
Received (Error): 0 Transmit Filtered: 0
Transmitted: 0 Receive Discards: 0
Detailed -]
~Received Frames v T itted Frames ~Frame Lengths ————
~Good Frames———— ~Good Frames————— 64 Bytes: 0
Unicast Frames: 0 Unicast Frames: 0 65 to 127 Bytes: 0
Broadcast Frames: 0 Broadcast Frames: 0 128 to 255 Bytes: 0
Multicast Frames: 0 Multicast Frames: 0 236 to 511 Bytes: 0
Pause (Flow Control) 0 Pause (Flow Control) 0 312 to 1023 Bytes: 0
Frames: Frames: 1024 to Maximum 0
« . Bytes:
—Bad Frames -

FCS Ermrors: 0

Undersized Frames: 0 Tt Bees

bagmetiiianes: s Collisions (excluding 0

Oversized Frames: 0 Late and Excessive):

Jabber Frames: 0 Late Collisions: 0

MAC Receive Errors: 0 Excessive Collisions: 0

FCS Errors: ] Single Collisions: 0
g Multiple Collisions: 0

This is the default egress priority mapping for both the copper and fiber ports.
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Copper Port Settings
Slot 11 - CM-1110-SFP

General |eLGEREGLE | Fiber Port | Alert Log | Advanced || Slot

Statistics

Name:
Connector: RJ-45
Link Status: Down
Auto Negotiation: In Progress
Speed: 10
Duplex: Half
Pause: Disabled
Link Partner Remote Fault Status: OK
Downshift Status: No
MDI/MDI-X: MDI-X
[Setings ) —————

Copper Port > Settings (Auto negotiation speed and duplex)

Copper Port x

Settings ST d——Bitet=Fcatures

Enable Port

Name: l:l

® Auto-negotiate speed and duplex

Advertise the following capabilities:

10 Mbps, Full Duplex 10 Mbps, Half Duplex
100 Mbps, Full Duplex 100 Mbps, Half Duplex
[¥] 1000 Mbps, Full Duplex

O Set speed and duplex manually

Pause: Asymmetrical RX
MDI/MDI-X: ® Auto OmpDI O MDI-X

Configure the following parameters.

Enable Port Enables/Disables the copper port.

Default: Enable

Name The name of the copper port.
Field Format: 8 characters
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Auto negotiate When enabled, the Media Converter Module will negotiate with its link partner
speed and duplex 10 determine the most optimal parameters for this connection.

Advertise capabilities of:

10 Mbps, Full Duplex
100 Mbps, Full Duplex
10Mbps, Half Duplex
100Mbps, Half Duplex
1000Mbps, Full Duplex

Set speed and When enabled, the following selections are available:
duplex manually  Speed: 100 Mbps, 10 Mbps
Duplex: Full, Half
Pause When enabled, the Media Converter Module will advertise the following Pause
capabilities:
e Symmetrical
® Asymmetrical TX
® Asymmetrical RX

Note: Pause feature will only work if Auto Negotiation is set to OFF on the
fiber port and Duplex is set to Full.

Default: Off

MDI/MDI-X ® Auto-Detect— automatically detects the Ethernet’s cable polarity
® MDI —the cable’s polarity is straight-through
® MDI-X —the cable’s polarity is crossovered
Default: Auto
°

Copper Port > Settings (Set speed and duplex manually)

Copper Port x

SERIGER  Advanced

[¥] Enable Port

Name:

O Auto-negotiate speed and duplex

{%] Set speed and duplex manually
Speed: (& 100 Mbps O 10 Mbps
Duplex: @ Full O Half

[l Pause
MDI/MDI-X: @ Auto O mMDI O MDI-X

Configure the following parameters.

Set Speed and When enabled, the following selections are available:
Duplex Manually  gpeed: 100 Mbps, 10 Mbps
Duplex: Full, Half
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Copper Port > Advanced

Copper Port x

Downshift speed after link attempts
10BASE-T Distance: (& Normal O Extended

Configure the following parameter.

Downshift speed ~ When enabled, the number of retries the Media Converter Module will attempt
after number of  to establish a fiber connection at 1000 Mbps before attempting a lower speed.

link

attempts Default: On
Link attempts: 1-8

10BASE-T Distance Normal: the Media Converter copper link is in normal operating mode.

Extended: the Media Converter will boost the signal strength on its copper
link.

Switch Features
Switch Features > Priority

Copper Port x

W.- g kot Fogging || Other

Use 802.1p Tag Priority

Use IP TOS Priority

Priority Precedence: @ g02.1p CIP TOS

Congestion Policy:  ® Strict Queueing O Weighted Queueing

R

p 802.1p Tag Priority:

Criginal Priority ~ Mew Priority

0w

2 lsl i

)

[=2] (53] L= [#%)
cn||; J>-|m
} 3 LJ i =

e |
(=i
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Configure the following parameters.

Enable 802.1p When enabled, the media converter module will use IEEE 802.1p tagged frame
Priority priority control to assign ingress frames to the appropriate priority egress queue.

Default: Enabled

Enable IP TOS When enabled, the media converter module will use IPv4 Diffserv or IPv6 traffic
Priority class field to assign ingress frames to the appropriate priority egress queue.

Default: Enabled
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Priority Precedence When both 802.1p priority and IP TOS priority are selected, you can select which

Congestion Policy

Remap Priority

of the two priorities takes precedence.
Default: 802.1p

Select a method to be used when determining the order by which frames are sent
from the four egress queues.

Strict Priority Queuing - The order is determined strictly by the priority of the
queue. Frames in higher priority queues are always sent ahead of frames in lower
priority queues.

Weighted Fair Queuing - This method allows lower priority frames to be inter-
mixed with higher priority frames in the ratio of (8, 4, 2, 1).

The ratio for 8 highest priority sent frames will be as follows:

8 highest priority frames from queue 3

4 frames from queue 2

2 frames from queue 1

1 frame from queue 0

Remap IEEE 802.1p ingress frames with a new priority tag. This new priority tag
will be used to determine which queue the frame gets posted to.

Original Priority ----- > New Priority

Values: 0-7

Switch Features > Rate Limiting

Copper Port

X

Egress Rate Limit:

Ingress Rate Limit: | MNone hd

MNaone hd

Configure the following parameters.

Congestion Policy

Remap Priority

Restricts ingress frames on the copper port.
Default: None
Data Options: 64 kbps to 900 mbps

Restricts egress frames on the copper port.
Default: None
Data Options: 64kbps to 900 mbps
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Switch Features > VLAN Tagging

Copper Port b

Priority | Rate Limiting Wﬁa—

[ Discard Tagged Frames

[ Discard Untagged Frames

Default VLAN I1D: 1
Default Priority: [0¥]
VLAN Tagging Action: & Normal O Untag O Tag O Double Tag

Configure the following parameters.
Discard Tagged When enabled, discards all VLAN tagged frames.
Frames Default: Off

Discard Untagged When enabled, discards all VLAN untagged frames.
Frames Default: Off

Default VLAN ID Specify a default VLAN ID to insert when tagging frames.
Default: 1
Data Options: 0-4095

Default Priority Specify a default VLAN priority to insert when tagging frames.
Default: 0
Data Options: 0-7

VLAN Tagging Define the VLAN tagging action to take on a egress frame.
Actions ® Normal -Take no action.

e Untag - Remove any existing tag.

® Tag
Insert tag with configured VLAN ID and VLAN priority if original
frame is untagged.

Replace tag with configured VLAN ID and VLAN priority if original
frame is tagged.

® Double tag - Append a tag with configured VLAN ID and VLAN priority.
Default: Normal

Switch Features > Other

Copper Port x

Priority || Rate Limiting || VI

[CIFilter Unknown Multicast Frames

[CIFilter Unknown Unicast Frames
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Configure the following parameters.

Filter Unknown  When enabled, multicast frames with unknown destination addresses are not
Multicast Frames allowed to egress this port.
Default: Disabled

When enabled, unicast frames with unknown destination addresses are not
allowed to egress this port.
Default: Disabled

Filter Unknown
Unicast Frames

Fiber Port Tab

Fiber Port > Properties
Slot 11 - CM-1110-SFP

General Copper Port Iiﬂal Alert Log || Advanced | Slot

Name:

Connector: SFP

Receive Status: Fault

Link Status: Down

Auto Negotiation: In Progress
Speed: 1000
Duplex: Half
Pause: Disabled

Link Partner Remote Fault Status: OK

Loopback Mode: Disabled

Fiber Port > SFP

Slot 3 - CM-1110-M25C05
General || Copoer Porl AletLog | Advanced || St
Propeties Eqsm,m—

Status -]
Module Temperature: 45 (High Alarm)

Transceiver Transmit Supply Voltage: 36mV  (High Warning)

Transceiver Transmit Bias Current:  11mA  (Low Warning)

Transceiver Transmit Power: 15.051 4B (Low Alarm)

Transceiver Receive Optical Power: 13.617 dBm (Normal)

Information -]
Connector: ST
Nominal Signaling Rate: 200 Mbps

Link Reach for 9/125 Single Mode Fiber: 220 m
Link Reach for 50/125 Single Mode Fiber: 230 m
Link Reach for 52.5/125 Single Mods Fiber: 240 m

Fiber Wavelength: 128 nm

Alarm and Warning Thresholds -]

~Modulz Temperature ~Transmit Supply Voltage —————— ~Transmit Bias Current
High Alarm Thresheld:  41.000°C
High Warning Threshold: 35.000 °C
Low Viarning Threshold: 25.000 °C

Low Alarm Threshold:  20.000°C

High Alarm Threshold: ~ 41.000 mV/
High Warning Threshold: 35.000 mV/
Low Warning Threshold: 25.000 mV/
Low Alarm Threshold: 20000 mV/

High Alarm Threshold: 20000 mA
High Warning Threshold: 13.000 mA
Low Warning Threshold: 12.000 mA
Low Alarm Threshold: ~ 5.000 mA

~Transmit Power

High Alarm Threshld: 17404 dBm
High Warning Threshold: 17.160 dBm
Low Warning Threshold: 16.021 dBm
Low Alarm Threshold:  15.441 dBm

~Receive Power

High Alarm Threshold:  14.771 dBm
High Warning Threshold: 13.802 dBm
Low Warning Threshold: 13.010 dBm
Low Alarm Threshold: 10.000 dBm
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Fiber Port > Statistics
Slot 11 - CM-1110-SFP

& Refresh

General || Copper Port |WELEERUS Alert Log | Advanced | Siot

Properties || SFP Statis

~Bytes ~Frames
Received (Good): 0 Receive Filtered: 0
Received (Error): 0 Transmit Filtered: 0
Transmitted: 0 Receive Discards: 0

Detailed

~Received Frames v T d Frames ~Frame Lengths
~Good Frames ~Good Frames 64 Bytes: 0
Unicast Frames: 0 Unicast Frames: 0 65 to 127 Bytes: 0
Broadcast Frames: 0 Broadcast Frames: 128 to 255 Bytes: 0
Multicast Frames: 0 Multicast Frames: 256 to 511 Bytes: 0
Pause (Flow Control) 0 Pause (Flow Control) 0 512 to 1023 Bytes: 0
Frames: Frames: 1024 to Maximum
- . Bytes: L
—Bad Frames [ -
FCS Ermrors: 0
Undersized Frames: 0 Deferred Frames: 0
(R (e s Collisions (excluding 0
Oversized Frames: 0 Late and Excessive):
Jabber Frames: 0 Late Collisions: 0
MAC Receive Errors: 0 Excessive Collisions: 0
FCS Errors: 0 Single Collisions: 0
g Multiple Collisions: 0
Fiber Port > Properties
Slot 11 - CM-1110-SFP
General IREESELE | Alert Log | Advanced | Slot
w Statistics
Name:
Connector: SFP
Receive Status: Fault
Link Status: Down
Auto Negotiation: In Progress
Speed: 1000
Duplex: Half
Pause: Disabled
Link Partner Remote Fault Status: OK
Loopback Mode: Disabled
Fiber Port > Settings
Fiber Port Settings x

| 1000 Mbps SFP || 100 Mbps SFP || Switch Features

Enable Port

SGMilInterface

Appl

Configure the following parameter.

Enable Port Enables/Disables the fiber po

Cancel

rt.
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The name of the fiber port.
Field Format: 8 characters

Name

SGMII-Interface  Select the checkbox if your SFP has a SGMII interface.

Fiber Port > 1000 MBPS SFP

Fiber Port Settings x

=G 1000 Mbps SFP G-ttrs-afF = Features

[] Auto-Negotiation

Configure the following parameter.

Enabled: The Media Converter Module will negotiate Ethernet parameters on
the fiber connection. This will ensure that the most optimal connection
parameters will be in effect. If connecting to another Perle Media Converter,
this parameter should be set to Auto. The Media converter module will
advertise 1000 Mbps, Full and Half Duplex, no Pause.

Disabled: The Media Converter Module’s fiber will be fixed to 1000 Mbps,
Full Duplex.

Default: Disabled

Auto Negotiation

Fiber Port > 100 MBPS SFP

Fiber Port Settings x

Settings | 1000 Mbps SFP | RN -RS o oS =
Duplex: @ Full O Half

Configure the following parameter.

The following Duplex modes are available:
Duplex: Full, Half

Default: Full

Duplex
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Switch Features
Switch Features > Priority

Fiber Port Settings x

Settings | 1000 Mbps SFP || 100 Mbps SFP m

S [ 11 S AR st amtirriting——t=dd=Faqging | Other

Use 802.1p Tag Priority

Use IP TOS Priority

Priority Precedence: @ g02.1p CIP TOS

Congestion Policy:  ® Strict Queueing O Weighted Queueing

R p 802.1p Tag Priority:
Criginal Priority ~ Mew Priority

.
=l (=] [ £ [5%] ra - [=]
L 1 | | | | | |

Configure the following parameters.

Enable 802.1p When enabled, the media converter module will use IEEE 802.1p tagged frame
Priority priority control to assign ingress frames to the appropriate priority egress queue.
Default: Enabled

Enable IP TOS When enabled, the media converter module will use IPv4 Diffserv or IPv6 traffic
Priority class field to assign ingress frames to the appropriate priority egress queue.
Default: Enabled

Priority Precedence When both 802.1p priority and IP TOS priority are selected, you can select which
of the two priorities takes precedence.
Default: 802.1p
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Congestion Policy

Remap Priority

Select a method to be used when determining the order by which frames are sent
from the four egress queues.

Strict Priority Queuing - The order is determined strictly by the priority of the
queue. Frames in higher priority queues are always sent ahead of frames in lower
priority queues.

Weighted Fair Queuing - This method allows lower priority frames to be inter-
mixed with higher priority frames in the ratio of (8, 4, 2, 1).

The ratio for 8 highest priority sent frames will be as follows:

8 highest priority frames from queue 3

4 frames from queue 2

2 frames from queue 1

1 frame from queue 0

Remap IEEE 802.1p ingress frames with a new priority tag. This new priority tag
will be used to determine which queue the frame gets posted to.

Original Priority ----- > New Priority

Values: 0-7

Switch Features > Rate Limiting

Fiber Port Settings

Settings || 1000 Mbps SFP

100 Mbps SFP

Ingress Rate Limit: | MNone hd

Egress Rate Limit: | None hd

Configure the following parameters.

Ingress Rate Limit Restricts ingress frames on the fiber port.

Egress Rate Limit

Default: None
Data Options: 64 kbps to 900 mbps

Restricts egress frames on the fiber port.
Default: None
Data Options: 64 kbps to 900 mbps
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Switch Features > VLAN Tagging

Fiber Port Settings

X

Settings | 1000 Mbps SFP || 100 Mbps SFP m

Priority || Rate Limiting W

Default VLAN ID:
Default Priority:

[ Discard Tagged Frames
[ Discard Untagged Frames

VLAN Tagging Action: & Normal O Untag O Tag O Double Tag

Configure the following parameters.

Discard Tagged
Frames

Discard Untagged
Frames

Default VLAN ID

Default Priority

VLAN Tagging
Actions

When enabled, discards all VLAN tagged frames.
Default: Off

When enabled, discards all VLAN untagged frames.
Default: Off

Specify a default VLAN ID to insert when tagging frames.
Default: 1
Data Options: 0-4095

Specify a default VLAN priority to insert when tagging frames.
Default: 0
Data Options: 0-7

Define the VLAN tagging action to take on a egress frame.
® Normal -Take no action.

e Untag - Remove any existing tag.

® Tag
Insert tag with configured VLAN ID and VLAN priority if original
frame is untagged.

Replace tag with configured VLAN ID and VLAN priority if original
frame is tagged.

® Double tag - Append a tag with configured VLAN ID and VLAN priority.
Default: Normal

Switch Features > Other

Fiber Port Settings

Settings | 1000 Mbps SFP || 100 Mbps SFP

Priority || Rate Limiting | VLAM Tagging m—

[CIFilter Unknown Multicast Frames

[IFilter Unknown Unicast Frames
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Configure the following parameters.

Filter Unknown  "When enabled, multicast frames with unknown destination addresses are not

Multicast Frames allowed to egress this port.
Default: Disabled

Filter Unknown When enabled, unicast frames with unknown destination addresses are not
Unicast Frames allowed to egress this port.
Default: Disabled

Alert Log Tab

Field Descriptions
Slot 8 - CM-1110-M28C05 [ Refresh

General Copper Port || Fiber Port W

12/3/4/58/6 next> lasto>
Date > Description Severity
09/21/2010 15:03:26 CM-1110-M2SC05 (slot 8): Copper port link status UP. Significant Event
09/21/2010 15:03:24 CM-1110-M2SC05 (slot 8): Fiber port link status UP. Significant Event
09/21/2010 15:03:24 CM-1110-M2SC05 (slot 8): Fiber port link status UP. Significant Event
09/21/2010 15:03:24 CM-1110-M2SC05 (slot 8): Copper port link status DOWN. Significant Event
09/21/2010 15:03:24 CM-1110-M2SC05 (slot 8): Fiber port link status DOWN. Significant Event
09/21/2010 15:03:24 CM-1110-M2SC05 (slot 8): OK. Significant Event
09/21/2010 14:48:35 CM-1110-M2SC05 (slot 8): Copper port link status UP. Significant Event
09/21/2010 14:48:35 CM-1110-M2SC05 (slot 8): Copper port link status DOWN. Significant Event
09/21/2010 14:48:33 CM-1110-M2SC05 (slot 8): Fiber port link status UP. Significant Event
09/21/2010 14:48:33 CM-1110-M2SC05 (slot 8): Fiber port link status DOWN. Significant Event

123485 nexts laster

Displays the current local Alerts. The local Alert buffer contains the last 200 alerts and displays these
events in a wrap around fashion.

Advanced Tab
Field Descriptions
Slot 3 - CM-1110-M2SC05
General || Copper Port || Fiber Port | Alert Log Lat

Restart Module (~ Diagnosti
Fiber Loopback:

Reset to Factory Defaults

Configure the following parameter:

Restart Module  Restarts this Media Converter Module.

Reset Factory Resets this Media Converter Module back to factory defaults.
Defaults

Diagnostics
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Slot Tab

CM-1110/SPF Media Converter Module Parameters

Fiber "Off: This is the normal setting. In this setting, data received on the fiber port
Loopback will be passed through the Media Converter Module.

On: This is a test mode. All data received on the receive (RX) fiber connection
is looped back to the transmit (TX) fiber connection.
Default: Off

Virtual Cable FPerforms a Virtual Cable Test to remotely and non-evasively diagnose the quality

Test and characteristics of the attached ethernet cable. This test can detect issues such
as cable opens, cable shorts or any impedance mismatch in the cable and then ac-
curately report (within one meter) the distance of the fault. In addition, this Vir-
tual Cable Test will detect pair swaps, pair polarity reversal and excessive pair
skew.

Advanced This feature should only be used if guided by a Perle Technical Support
Diagnostics, ~ Representative. Use of this feature without guidance from a Perle Technical
Read/Write  Support Representative could make your Media Converter Module inoperable.

Register

Field Descriptions
Slot 8 - CM-1110-M2SC05

General | Copper Port || Fiber Port | Alert LDM

- Slot Settings

Default Power State: ©0n O Off

[ Backup/Restore Module Configuration Automatically

Configure the following parameters:

Power Immediately power the slot on or off. The current state of the slot is
highlighted in BLUE.

Press the "ON" button to immediately power the slot on.
Press the "OFF" button to immediately power the slot off.
Default Power State 1his is the default power state of the slot when the chassis is powered up or
restarted.
Default: On

Backup/Restore Enabled: The configuration information associated with this slot is saved on
Automatically the Management Module and will be downloaded to the Media Converter
Module whenever the Media Converter Module is inserted into this slot.

Disabled: The Media Converter Module configuration information is only kept
on this Module.

Default: Disabled
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CM-1000/CM-1000-SFP
Module

CM-1000 Media Converter Module Parameters

MCR1900 Chassis

MCR-MGT-VI March 02, 2011 11:16:02 EST

per'E 172 16 .54 106 User's Guide | User: admin | Logout

MCR-MGT-VI [+ Slot 16 A Hide Chassis

0061 40N

Slot 16 - CM-1000-SFP ,

Copper Port | Fiber Port | Alert Log | Advanced || Slot
Name:  CM-1000-SFP
Model: CM-1000-SFP

Description: Gigabit Ethernet Media Converter Managed Module. 1000BASE-T (RJ45) [100 m/325g# to 1000BASE-X SFP Slot

—Hardware Setup \
. Configuration Jumper: Auto “¥  Current Switch Settings.. ‘ CM_ l OOO Medla Converter Module

Copy Settings...

SMI Chassis

EﬂE MCR-MGT-900084 May 28, 2013 20:22:51 EDT
p 172.16.113.66 Users Guide | User: admin | Logout
MCR-MGT-300084 [» | Slot 2 SMI-1000-M25C05 A Hide Chassis

Chassis Info

Slot 2 - CM-1000-M2SC05

Copper Port || Fiber Port | Alert Log | Advanced Slot
Name: CM-1000-M2S8C05 ¥ Details

Model: CM-1000-M2SC05
Description: Gigabit Ethernet Media Converter Managed Module. 1000BASE-T (RJ45) [100 m/328 ft] to 1000BABE-X 850nm multimode (SC) [550
mAB04 7]

CM-1000

Hardware Setup
{Configuralion Jumper: Auto @ Current Switch Settings ]

Settings
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General Tab

Field Descriptions

Slot 16 - CM-1000-SFP =
Copper Port | Fiber Port | AlertLog | Advanced | Slot
Name: CM-1000-SFP
Model: CM-1000-SFP

Description: Gigabit Ethernet Media Converter Managed Module. 1000BASE-T (RJ45) [100 m/328 f] to 1000BASE-X SFP Slot

Setup

Configuration Jumper: Auto @  Current Switch Settings...

Name Displays the configured name for this Module.

Model Displays the module’s model information.

Description Displays a description of the Module that is inserted in this slot.
Configuration Auto: Use software configuration if present, otherwise use hardware DIP
Jumper switch settings.

Switch: Use hardware DIP switch settings.

For detailed information on hardware DIP switch settings, see the Hardware
Installation Guide.

Current Switch Displays the current DIP switch settings.

Settings For detailed information on hardware jumpers and DIP settings, see the
Hardware Installation Guide.
Settings
Module Settings x
Name: CM-1000-SFP

Link Mode: | Smart Link Passthrough +
CIFiber Fault Alert
[¥] Jumbo Packets

Configure the following parameters:

Name Displays the configured name for this Module.

Link Mode Smart Link Pass-Through: In this mode, the link state on one connection is
directly reflected through the Media Converter Module to the other connection.
If link is lost on one of the connections, then the other link will be brought
down by the Media Converter.

Standard: In this mode, the links on the fiber and copper sides can be brought
up and down independently of each other. A loss of link on either the fiber or
copper port can occur without affecting the other connection.

Default: Smart Link Passthrough
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Fiber Fault Alert When enabled, if the Media Converter Module detects a loss of signal on the
fiber receiver, it will immediately disable its fiber transmitter signal. This in
effect, notifies the fiber link partner that an error condition exists on the fiber
connection.

Note: This feature only takes effect if Fiber Negotiation has been turned off.

When disabled, the Media Converter Module will not monitor for or generate
Fiber Fault Alert.

Default: On

Jumbo Packets Enable Jumbo Packet support.
Default: Enabled

Copy Settings
Slot 16 - CM-1000-SFP =
Copper Port | Fiber Port || Alert Log | Adwvanced | Slot
Name: CM-1000-SFP
Model: CM-1000-SFP

Description: Gigabit Ethernet Media Converter Managed Module. 1000BASE-T (RJ45) [100 m/328 ft] to 1000BASE-X SFP Slot

—Hardware Setup

Configuration Jumper: Auto “¥  Current Switch Settings. ..

Copy Settings.  ff————

Copy Module Settings x

Copy this module’s settings to other modules of the same type:

Copy Slot Name

™ 16 CM-1000MM-M2SC05
Copy Module Copy this module’s settings to other modules of the same type.
Settings
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Copper Port Tab
Field Descriptions
Slot 16 - CM-1000-SFP

General |eLGEREGLE | Fiber Port | Alert Log | Advanced || Slot

Name: bmeck-Cu

Connector: RJ-45

Link Status: Down

Auto Negotiation: In Progress
Speed: 1000
Duplex: Half
Pause: Disabled

Link Partner Remote Fault Status: OK

MDI/MDI-X: MDI

Copper Port > Settings

Copper Port Settings X

i¥!Enable Port

Duplex: @ Auto O Half

Pause: | Disabled b

[ Low Power Mode

123



CM-1000 Media Converter Module Parameters

Configure the following parameters:

Enable Port

Name

Duplex

Pause

Low Power Mode

Enables/Disables the copper port.
Default: Enable

The name of the copper port.
Field Format: 8 characters

The following selections are available:
Duplex: Auto, Half

Default: Auto

The following selections are available:
Duplex: Auto, Half

Default: Auto

When enabled, the Media Converter Module will advertise the following Pause
capabilities:

® Symmetrical

® Asymmetrical TX

® Asymmetrical RX

Note: Pause feature will only work if Auto Negotiation is set to OFF on the
fiber port and Duplex is set to Full.

Default: Off
If enabled, the Gigabit copper transceiver is set into low power mode which

reduces the strength of the copper signal.
Default: Off

Field Descriptions
Slot 16 - CM-1000-SFP

General | Copper Port Alert Log | Advanced || Slot

Name:

Connector:

Link Status:

Auto Negotiation:
Speed:
Duplex:
Pause:

Loopback Mode:

SFP

Up
Disabled
1000
Full
Disabled

Link Partner Remote Fault Status: OK

Disabled

Settings |-
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Fiber Port > Settings

Fiber Port Settings X

Enable Port

Name:

[CIFiber Auto-Negotiation

Configure the following parameter:

Enable Port Enables/Disables the fiber port.
Name The name of the fiber port.
Field Format: 8 characters
Fiber Auto- Enabled: The Media Converter Module will negotiate Ethernet parameters on
Negotiation the fiber connection. This will ensure that the most optimal connection

parameters will be in effect. If connecting to another Perle Media Converter,
this parameter should be set to Auto. The Media converter module will
advertise 1000 Mbps, Full and Half Duplex, no Pause.

Disabled: The Media Converter Module’s fiber will be fixed to 1000 Mbps,
Full Duplex.

Default: Disabled
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Fiber Port > SFP (Statistics)

Slot 16 - CM-1000-SFP

General Copper Port Iiﬁﬁl Alert Log || Advanced | Slot
Properties E‘—

Status

&= Refresh

Module Temperature: 0.000°C  (Normal)
Transceiver Transmit Supply Voltage: 0.000V  (Normal)
Transceiver Transmit Bias Current: 0.000 mA  (Normal)
Transceiver Transmit Power: 0.000 mW (Normal)
Transceiver Receive Optical Power:  0.000 mW (Normal)

Information [-]
Connector: Unknown
Nominal Signaling Rate: 0 Mbps

Link Reach for 9/125 Single Mode Fiber: 0m
Link Reach for 50/125 Single Mode Fiber: 0m
Link Reach for 62.5/125 Single Mode Fiber: 0 m

Fiber Wavelength: 0 nm
Alarm and Warning Thresholds [-]
—Module Temperature ————— ~ Transmit Supply Voltage ———— - Transmit Bias Current
High Alarm Threshold:  0.000 °C High Alarm Threshold:  0.000 V High Alarm Threshold:  0.000 mA
High Warning Threshold: 0.000 °C High Warning Threshold: 0.000 V High Warning Threshold: 0.000 mA
Low Warning Threshold: 0.000 °C Low Warning Threshold: 0.000 V Low Warning Threshold: 0.000 mA
Low Alarm Threshold: ~ 0.000 °C Low Alarm Threshold: 0000 V Low Alarm Threshold: 0000 mA
-~ Transmit Power———————————— ~Receive Power
High Alarm Threshold:  0.000 mW High Alarm Threshold:  0.000 mW
High Warning Threshold: 0.000 mW High Warning Threshold: 0.000 m\W
Low Warning Threshold: 0.000 mW Low Warning Threshold: 0.000 m\W
Low Alarm Threshold:  0.000 mW Low Alarm Threshold:  0.000 mW

Alert Log Tab

Field Descriptions
Slot 16 - CM-1000-SFP

General Copper Port || Fiber Port W—Qﬂ——

Date > Description Severity

2010-09-23 15:58:34 CM-1000-SFP (slot 16): Fiber port link status UP. Significant Event
2010-09-23 15:58:34 CM-1000-SFP (slot 16): Copper port link status UP. Significant Event
2010-09-23 15:58:34 CM-1000-SFP (slot 16): OK. Significant Event
2010-09-23 15:58:34 CM-1000-SFP (slot 16): Has been inserted. Model=CM-1000-SFP, S/N=102-093510M1210. Significant Event

Displays the current local Alerts. The local Alert buffer contains the last 200 alerts and displays these
events in a wrap around fashion.

Advanced Tab

Field Descriptions
Slot 16 - CM-1000-SFP

General || Copper Port || Fiber Port | Alert Log wﬂm—

Fiber Loopback: -

Reset to Factory Defaults - -
¥ Advanced Diagnostics
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CM-1000 Media Converter Module Parameters

Configure the following parameter:

Restart Module Restarts this Media Converter Module.

Reset Factory Resets this Media Converter Module back to factory defaults.
Defaults
Diagnostics
Fiber Off: This is the normal setting. In this setting, data received on the fiber port

Loopback will be passed through the Media Converter Module.

On: This is a test mode. All data received on the receive (RX) fiber connection
is looped back to the transmit (TX) fiber connection.

Default: Off

Advanced This feature should only be used if guided by a Perle Technical Support
Diagnostics, Representative. Use of this feature without guidance from a Perle Technical
Read/Write Support Representative could make your Media Converter Module inoperable.
Register

Field Descriptions
Slot 16 - CM-1000-SFP

General Copper Port | Fiber Port || Alert Lngw

- Slot Setting

Default Power State: O 0On @ Off

[JBackup/Restore Module Configuration Automatically

Configure the following parameters:

Power State Immediately power the slot on or off. The current state of the slot is
highlighted in BLUE.
Press the "ON" button to immediately power the slot on.

Press the "OFF" button to immediately power the slot off.

Default Power State This is the default power state of the slot when the chassis is powered up or
restarted.

Default: On

Backup/Restore Enabled: The configuration information associated with this slot is saved on

Module the Management Module and will be downloaded to the Media Converter

Configuration Module whenever the Media Converter Module is inserted into this slot.

Automatically Disabled: The Media Converter Module configuration information is only kept
on this Module.

Default: Disabled
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1 1 CM-100MM Media
onverter Module

CM-100MM Media Converter Module Parameters

General Tab

MCR1900 Chassis

El',E MCR-MGT-VI March 02, 2011 12:29:01 EST
p 17216 .54 106 User's Guide | User: admin | Logout
MCR-MGT-VI [» | Slot 16 'a Hide Chassis

by

:
:

0061 4O

Slot 16 - CM-100MM-M2SC2

esl
Fiber Port 1 | Fiber Port2 | AlertLog | Advanced | Slot

Name: CM-100MNM-M2SC2
Model: CM-100MM-M25C2

Description: Fast Ethernet Fiber to Fiber Media Converter Managed Module. 100BASE-X 1310nm multimode () [2 km/1.24 miles] to
100BASE-X 1310nm multimode (SC) [2 km/1.24 miles]

Hard c
I Setup

CM-100MM Media Converter Module

‘ Configuration Jumper: Auto “¥  Current Switch Settings. ..

Copy Settings._..

SMI Chassis

Er'E MCR-MGT-100634 February 18, 2013 21:563:06 EST
p 172.16.28.55 User's Guide | User: admin | Logout
MCR-MGT-100634 [» | Slot 2 SMI-100MM-M25C2 A Hide Chassis

MM R . = Chassis Info...

Slot 2 - CM-100MM-M2SC2 _
Fiber Port 1 Fiber Port 2 Alert Log Advanced Slot
Name:  CM-100MM-M25C2
Model: CM-100MM-M25C2

Description: Fast Ethemet Fiber to Fiber Media Converter Managed Module. 100BASE-X 1310nm multimode (BC) [2 km/1.24 miles] to 100BASE-X
1310nm multimode (SC) [2 km/1.24 miles]

CM-100MM-M28C2

Hardware Setup
Configuration Jumper: Auto “¥  Current Switch Settings. ..
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Field Descriptions

Slot 16 - CM-100MM-M2SC2
Fiber Port 1 Fiber Port 2 || Alert Log | Advanced | Slot
Name: CM-100MM-M2SC2
Model: CM-100MM-M2SC2

Description: Fast Ethernet Fiber to Fiber Media Converter Managed Module. 100BASE-X 1310nm multimode (SC) [2 km/1.24 miles] to
100BASE-X 1310nm multimode (SC) [2 km/1.24 miles]

Hard Setup

Configuration Jumper: Auto @ Current Switch Setings

Name Displays the configured name for this Module.

Model Displays the module’s model information.

Description Displays a description of the Module that is inserted in this slot.
Configuration Auto: Use software configuration if present, otherwise use hardware DIP
Jumper switch settings.

Switch: Use hardware DIP switch settings.
For detailed information on hardware DIP switch settings, see the Hardware
Installation Guide.

Current Switch Displays the current DIP switch settings.

Settings For detailed information on hardware jumpers and DIP settings, see the
Hardware Installation Guide.

Details Displays the firmware’s details.
Settings

Module Settings x

Name: CM-100MM-M25C2

Link Mode: | Passthrough v
Far End Fault

Name Displays the configured name for this Module.

Link Mode Link Pass-Through: In this mode, the link state on one fiber connection is
directly reflected through the Media Converter Module to the other fiber
connection. Iflink is lost on one of the fiber connections, then the other fiber
link will be brought down by the Media Converter.

Standard: In this mode, each fiber link can be brought up and down
independently of each other. A loss of signal on either fiber connection can
occur without affecting the other fiber connection.

Default: Link Pass-Through
Far End Fault When enabled, if the Media Converter Module detects a loss of signal on the
fiber receiver, it will transmit a FEF signal to the remote Media Converter

Module. This, in effect, notifies the fiber link partner that an error condition
exists on the fiber connection.

Note: This feature only takes effect if Auto Negotiation has been turned off.

When disabled, the Media Converter Module will not monitor for or generate
Far End Fault.

Default: On
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Copy Settings

Slot 16 - CM-100MM-M2SC2

Fiber Port 1 Fiber Port 2 || Alert Log | Advanced | Slot

Name: CM-100MM-M25C2
Model:

CM-100MM-M25C2

Description: Fast Ethemet Fiber to Fiber Media Converter Managed Module. 100BASE-X 1310nm multimode (SC) [2 km/1.24 miles] to
100BASE-X 1310nm multimode (SC) [2 km/1.24 miles]

—Hardware Setup

Configuration Jumper: Auto “¥  Current Switch Settings. ..

Settings | Copy Settings... ff———

Copy Module Copy this module’s settings to other modules of the same type.
Settings
Copy Module Settings x

Copy this module’s settings to other modules of the same type:

Copy Slot Name

14 CM-100MM-M2SC2

Fiber Port 1 Tab
Fiber Port 1 > Settings

Slot 16 - CM-100MM-M2SC2

m Fiber Port 2 | Alert Log | Advanced | Slot

Name:

Connector: sC
Receive Status: OK
Link Status: Down

Far End Fault:  OK
Loopback Mode: Disabled

Settings

Fiber Port Settings x

Enable Port

Configure the following parameters:

Settings
Enable Port Enables/Disables fiber port 1.
Name The name of fiber port 1.

Field Format: 8 characters
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Fiber Port 2 Tab
Fiber Port 2 > Settings

Slot 16 - CM-100MM-M2SC2 =
General Fiber Port 1 Iiﬂaa Alert Log || Advanced | Slot

Name:

Connector: sC
Receive Status: OK
Link Status: Down

Far End Fault:  OK
Loopback Mode: Disabled

Settings

Fiber Port Settings x

nable Port

Configure the following parameters:

Enable Port Enables/Disables fiber port 2.

Name The name of fiber port 2.

Field Format: 8 characters

Alert Log Tab

Field Descriptions
Slot 16 - CM-100MM-M2SC2

General Fiber Port 1 Fiber Port 2 m«m—sm—

1/2]3) next> last>>

Date ~ Description Severity

02/04/2011 17:06:03 CM-100MM-M2SC2 (slot 16): fiber1 port link status DOWN. Significant Event
02/04/2011 17:06:03 CM-100MM-M2SC2 (slot 16): fiber2 port link status DOWN. Significant Event
02/04/2011 17:06:03 CM-100MM-M2SC2 (slot 16): OK. Significant Event
02/04/2011 17:06:03 CM-100MM-M2SC2 (slot 16): Has been inserted. Model=CM-100MM-M2SC2, S/N=110-000111L1210. Significant Event
02/04/2011 17:05:29 CM-100MM-M2SC2 (slot 16): Has been removed. Significant Event
02/04/2011 16:32:31 CM-100MM-M2SC2 (slot 16): fiber1 port link status DOWN. Significant Event
02/04/2011 16:32:31 CM-100MM-M2SC2 (slot 16): fiber2 port link status DOWN. Significant Event
02/04/2011 16:32:31 CM-100MM-M2SC2 (slot 16): OK. Significant Event

Displays the current local Alerts. The local Alert buffer contains the last 200 alerts and displays these
events in a wrap around fashion.

Advanced Tab
Field Descriptions
Slot 16 - CM-100MM-M2SC2

General || Fiber Port 1 || Fiber Port 2 || Alert Log w’m—

Restart Module (~Diag i
Fiber Loopback:
Reset to Factory Defaults - 5
¥ Advanced Diagnostics
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Slot Tab

CM-100MM Media Converter Module Parameters

Configure the following parameter:

Restart Module

Reset to Factory
Defaults
Diagnostics

Fiber
Loopback

Advanced
Diagnostics,
Read/Write
Register

Restarts this Media Converter Module.

Resets this Media Converter Module back to factory defaults.

Off: This is the normal setting. In this setting, data received on the fiber port
will be passed through the Media Converter Module.

Select either Port 1 or Port 2. Only one fiber port can be in loopback at one
time.

Port 1: This is a test mode. All data received on the receive (RX) fiber
connection is looped back to the transmit (TX) fiber connection.

Port 2: This is a test mode. All data received on the receive (RX) fiber
connection is looped back to the transmit (TX) fiber connection.
Default: Off

This feature should only be used if guided by a Perle Technical Support
Representative. Use of this feature without guidance from a Perle Technical
Support Representative could make your Media Converter Module inoperable.

Field Descriptions
Slot 16 - CM-100MM-M2SC2

General Fiber Port 1 Fiber Port 2 || Alert Log || Advanced P

- Slot Settings

Default Power State: = 0n O Off

O Backup/Restore Module Configuration Automatically

Configure the following parameters:

Power

Immediately power the slot on or off. The current state of the slot is
highlighted in BLUE.

Press the "ON" button to immediately power the slot on.
Press the "OFF" button to immediately power the slot off.

Default Power State This is the default power state of the slot when the chassis is powered up or

Backup/Restore
Module
Configuration
Automatically

restarted.
Default: On

Enabled: The configuration information associated with this slot is saved on
the Management Module and will be downloaded to the Media Converter
Module whenever the Media Converter Module is inserted into this slot.

Disabled: The Media Converter Module configuration information is only kept
on this Module.

Default: Disabled
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CM-1000MM Media
Converter Module

CM-1000MM Media Converter Module Parameters

General Tab

MCR1900 Chassis

perie

March 02, 2011 13:27:01 EST
User's Guide | User: admin | Logout

4 Hide Chassis

MCR-MGT-VI
172.16.54 106

MCR-MGT-VI Slot 4

0061 40N

Slot 4 - CM-1000

General Fiber Port 1 Fiber Port 2 | Alert Advanced | Slot
Name: CM-1000MM-M2LCO5
Model: CM-1000MM-M2LC05

Description: Gigabit Ethemnet Fiber to Fiber Media Converter Mal Module. 1000BASE-X 850nm multimode (LC) [550 m/1804 f] to

1000BASE-X 850nm multimode (LC) [550 m/1804 ft]
CM-1000MM Media Converter Module

‘ Configuration Jumper: Auto ¥ Current Switch Settings... ‘

Setup

Copy Settings...

SMI Chassis

MCR-MGT-100634

pEl'lE 172 16.28 55

February 18, 2013 21:39:33 EST
User's Guide | User: admin | Logout

MCR-MGT-100634 [» | Slot 2

SMI-1000MM-M2SC05

4 Hide Chassis
Chassis Info

CONSOLE]

Slot 2 - CM-1000MM-M2SC05

Fiber Port 1 Fiber Port 2 Alert Log Advanced Slot

¥ Details

Name: CM-1000MM-M2SC05
Model: CM-1000MM-M2SC05

Description: Gigabit Ethernet Fiber to Fiber Media Converter Managed Module. 1000BASE-X 850nm multimode (SC) [550 m/1804 ft] to 1000BASE-
X 850nm multimode (SC) [550 m/1804 ft]

CM-1000MM-M2SC05

Hardware Setup

Configuration Jumper: Auto ¥  Current Switch Settings...
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Field Descriptions

Slot 4 - CM-1000MM-M2SC05
Fiber Port 1 || Fiber Port 2 | Alert Log | Advanced | Slot
Name: CM-1000MM-M2SC05
Model: CM-1000MM-M25C05

Description: Gigabit Ethemnet Fiber to Fiber Media Converter Managed Module. 1000BASE-X 850nm multimode (SC) [2 km/1.24 miles] to
1000BASE-X 850nm multimode (SC) [550 m/1804 ft]

Hard Setup

Configuration Jumper: Auto @ Current Switch Settings

Name Displays the configured name for this Module.

Model Displays the module’s model information.

Description Displays a description of the Module that is inserted in this slot.
Configuration Auto: Use software configuration if present, otherwise use hardware DIP
Jumper switch settings.

Switch: Use hardware DIP switch settings.

For detailed information on hardware DIP switch settings, see the Hardware
Installation Guide.

Current Switch Displays the current DIP switch settings.

Settings For detailed information on hardware jumpers and DIP settings, see the
Hardware Installation Guide.

Settings

Module Settings x

Name: CM-1000MM-M2SC05|

Link Mode: | Smart Link Passthrough +
“IFiber Fault Alert

[¥] Jumbo Packets

Fiber Auto-Negotiation

Configure the following parameters:

Name Displays the configured name for this Module.

Link Mode Smart Link Pass-Through: In this mode, the link state on one connection is
directly reflected through the Media Converter Module to the other connection.
If link is lost on one of the connections, then the other link will be brought
down by the Media Converter.
Standard: In this mode, the links on the fiber and copper sides can be brought
up and down independently of each other. A loss of link on either the fiber or
copper port can occur without affecting the other connection.

Default: Smart Link Passthrough
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Fiber Fault Alert When enabled, if the Media Converter Module detects a loss of signal on the
fiber receiver, it will immediately disable its fiber transmitter signal. This in
effect, notifies the fiber link partner that an error condition exists on the fiber
connection.

Note: This feature only takes effect if Fiber Negotiation has been turned off.

When disabled, the Media Converter Module will not monitor for or generate
Fiber Fault Alert.

Default: On

Jumbo Packets Enable Jumbo Packet support.
Default: Enabled

Fiber Auto- Auto: In this mode, the Media Converter will negotiate fiber parameters on both
Negotiation fiber connections. This will ensure the most optimal connection parameters will
be in effect. If connecting to another Perle Media Converter this parameter
should be set to Auto.
Off: Fiber negotiation on both fiber ports will be disabled. The switch settings
for Link Mode and Fiber Fault Alert will be determined by the Module Settings
parameters.
Default: Auto

Copy Settings
Slot 4 - CM-1000MM-M2SC05
Fiber Port 1 Fiber Port 2 || Alert Log | Advanced | Slot
Name: CM-1000MM-M25C05
Model: CM-1000MM-M2SC05

Description: Gigabit Ethernet Fiber to Fiber Media Converter Managed Module. 1000BASE-X 850nm multimode (SC) [2 km/1.24 miles] to
1000BASE-X 850nm multimode (SC) [550 m/1804 fi]

Hard Setup

Configuration Jumper: Auto @ Current Switch Setings

Settings | Copy Settings. ff——————————

Copy Module Copy this module’s settings to other modules of the same type.
Settings
Copy Module Settings x

Copy this module’s settings to other modules of the same type:

Copy Slot Name
16 CM-1000MM-M23C05
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Fiber Port 1 Tab
Fiber Port 1 > Settings
Slot 4 - CM-1000MM-M2SC05

m Fiber Port 2 || Alert Log | Advanced | Slot

Name:
Connector: sC
Receive Status: oK
Link Status: Down
Auto Negotiation: In Progress
Speed: 1000
Duplex: Half
Pause: Disabled
Link Partner Remote Fault Status: OK
Loopback Mode: Disabled
Settings
Fiber Port Settings x
¥!Enable Port

Configure the following parameter:

Enable Port Enables/Disables fiber port 1.

The name of fiber port 1.
Field Format: 8 characters

Port Name
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Fiber Port 2 Tab

Fiber Port 2 > Settings
Slot 4 - CM-1000MM-M2SC05

General || Fiber Port 1 |EEEREEIEA Alert Log | Advanced | Slot

Name:
Connector: sC
Receive Status: oK
Link Status: Down
Auto Negotiation: In Progress
Speed: 1000
Duplex: Half
Pause: Disabled
Link Partner Remote Fault Status: OK
Loopback Mode: Disabled
Settings

Fiber Port Settings x

Configure the following parameter:

Enable Port Enables/Disables fiber port 2.

Name The name of fiber port 2.
Field Format: 8 characters

Alert Log Tab
Field Descriptions

Slot 4 - CM-1000MM-M2SC05
General | Fiber Port 1 || Fiber Port 2 w

!
Date > Description Severity
01/31/2011 09:47:55 CM-1000MM-M2SCO05 (slot 4): fiber1 port link status DOWN. Significant Event
01/31/2011 09:47:55 CM-1000MM-M2SCO05 (slot 4): fiber2 port link status DOWN. Significant Event
01/31/2011 09:47:55 CM-1000MM-M2SC05 (slot 4): OK. Significant Event

- CM-1000MM-M2SCO05 (slot 4): Has been inserted. Model=CM-1000MM-M25C05, .

01/31/2011 09:47:55 S/N=107-000111L1210. Significant Event

:

Displays the current local Alerts. The local Alert buffer contains the last 200 alerts and displays these
events in a wrap around fashion.
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Advanced Tab
Field Descriptions

General Fiber Port 1 Fiber Port 2 | Alert Log W&M——_—

Slot

Restart Module
Reset to Factory Defaults

— Di i -
Fiber Loapback:
A Advanced Diagnostics

~PHY

Read/Write Register ‘

Configure the following parameter:

Restart Module

Reset Factory
Defaults
Diagnostics
Fiber Loopback

Advanced
Diagnostics,
Read/Write
Register

Restarts this Media Converter Module.

Resets this Media Converter Module back to factory defaults.

Off: This is the normal setting. In this setting, data received on the fiber port
will be passed through the Media Converter Module.

Select either Port 1 or Port 2. Only one fiber port can be in loopback at one
time.

Port 1: This is a test mode. All data received on the receive (RX) fiber
connection is looped back to the transmit (TX) fiber connection.

Port 2: This is a test mode. All data received on the receive (RX) fiber
connection is looped back to the transmit (TX) fiber connection.

Default: Off

This feature should only be used if guided by a Perle Technical Support
Representative. Use of this feature without guidance from a Perle Technical
Support Representative could make your Media Converter Module inoperable.

Field Descriptions
Slot 4 - CM-1000MM-M2SC05

General | Fiber Port 1 || Fiber Port 2

Alert Log | Advanced m.—

~Slot Settings

Default Power State: @ 0n O Off

[JBackup/Restare Module Configuration Automatically
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Configure the following parameters:

Power State Immediately power the slot on or off. The current state of the slot is
highlighted in BLUE.
Press the "ON" button to immediately power the slot on.

Press the "OFF" button to immediately power the slot off.

Default Power State This is the default power state of the slot when the chassis is powered up or
restarted.

Default: On

Backup/Restore Enabled: The configuration information associated with this slot is saved on

Module the Management Module and will be downloaded to the Media Converter

Configuration Module whenever the Media Converter Module is inserted into this slot.

Automatically Disabled: The Media Converter Module configuration information is only kept
on this Module.

Default: Disabled
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CM-10G Media
Converter Modules

Standard Models

CM-10G-STS - This model contains two SFP+ pluggable transceivers. These pluggable
transceiver ports can be populated with either:

® two (1 gigabit SFP modules)
® two (10 gigabit SFP+ modules).

CM-10G-XTS - This model contains one SFP+ pluggable transceiver port and one XFP
pluggable transceiver port.

CM-10G-XTX - This model contains two XFP pluggable transceiver ports.

High Power Models

CM-10G-XTSH - This model contains one SFP+ pluggable transceiver port and one XFP
pluggable transceiver port. This module takes 2 slots within a Perle chassis.

CM-10G-XTXH - This model contains two high power XFP pluggable transceiver ports.
parameters. This module takes 2 slots within a Perle chassis.

MCR-MGT Management Module User’s Guide, Version 1.8
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CM-10G Modules Parameters

MCR1900 Chassis

EﬂE tme-mer-mgt September 17, 2012 10:06:30 EDT
'J 172.16.22.30 User's Guide | User: admin | Logout

tme-mer-magt [» | Slot 4

LK1 WA

Slot 4 - CM-10G-XTSH

A Hide Chassis
B B E EEE B E @ HE B
ALK P

0061 HOW

1: it
Pot1 | Port2 | Alert Log AdvancN
Name:  CM0GXTSH
Model:  CM-10GXTSH

Description: High Power Ten Gigabit Media Converter Managed Module. XFP 0 SFP Plus Slot

~Hardware Setup CM-10G-STS Module
: CM-10G-XTS Module
Configuration Jumper: Auto ¥  Current Switch Settings... CM-10G-XTX Module

Copy Settings CM-10G-XTXH Module

SMI Chassis

pEﬂE MCR-MGT-900085

MCR-MGT-200085 [» ] Slat 1 SMI-10G-XFPH

CM-10G-XTSH Module (Shown)

May 01, 2013 13:22:49 EDT
172 16.21 250 User's Guide | User: admin | Logout

A Hide Chassis

PLCONSOLE]

Slot 2 - CM-10G-XTS

Port 1 || Port2 || Alert Log | Advanced || Slot

Chassis Info

Name: CM-10G-XTS I
Model:  CM-10GXTS CM-10G-STS

Description: 10 Gigabit Media Converter Managed Module. ¥FP Slot to SFP+ Slot

Hard <ot

F tup
[Cuniigumliun Jumper: Auto @ Current Switch Settings ]

Settings

¥ Details
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General Tab

Field Descriptions

Slot 4 - CM-10G-XTSH
wmen Log || Advanced | Slot
Name:  CM-10GXTSH
Model: CM-10G-XTSH

Description: High Power Ten Gigabit Media Converter Managed Module. XFP Slot to SFP Plus Slot

—Hardware Setup

Configuration Jumper: Auto “¥  Current Switch Settings. ..

Name Displays the configured name for this Module.

Model Displays the module’s model information.

Description Displays a description of the Module that is inserted in this slot.
Configuration Auto: Use software configuration if present, otherwise use hardware DIP
Jumper switch settings.

Switch: Use hardware DIP switch settings.

For detailed information on hardware DIP switch settings, see the Hardware
Installation Guide.

Current Switch Displays the current DIP switch settings.

Settings For detailed information on hardware jumpers and DIP settings, see the
Hardware Installation Guide.

Settings

Module Settings x

1000 Mbps SFP

Name: CM-10G-XTSH
Link Mode: | Smart Link Passthrough +
“IFiber Fault Alert

Configure the following parameters:

Name Displays the configured name for this Module.

Link Mode Smart Link Pass-Through: In this mode, the link state on one connection is
directly reflected through the Media Converter Module to the other connection.
If link is lost on one of the connections, then the other link will be brought
down by the Media Converter.

Standard: In this mode, the links on the fiber and copper sides can be brought
up and down independently of each other. A loss of link on either the fiber or
copper port can occur without affecting the other connection.

Default: Smart Link Passthrough
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Fiber Fault Alert When enabled, if the Media Converter Module detects a loss of signal on the
fiber receiver, it will immediately disable its fiber transmitter signal. This in

effect, notifies the fiber link partner that an error condition exists on the fiber
connection.

Note: This feature only takes effect if Fiber Negotiation has been turned off.

When disabled, the Media Converter Module will not monitor for or generate
Fiber Fault Alert.

Default: On

1000 Mbps only SFP

| Module Settings b

=G 1000 Mbps SFP

Auto-Negotiation

Auto-Negotiation When enabled, the Media Converter Module will negotiate with its link partner
to determine the most optimal parameters for this connection.

Copy Settings
Port 1 Port 2 || Alert Log | Advanced | Slot

Name:  CM-10G-XTSH
Model:

CM-10G-XTSH
Description: High Power Ten Gigabit Media Converter Managed Module. XFP Slot to SFP Plus Slot

Hard Setup

Configuration Jumper: Auto '@ Current Switch Settings. -

Settings Copy Settings.. +—

Copy Module Copy this module’s settings to other modules of the same type.
Settings
‘Copy Module Settings x

Copy this module’s settings to other modules of the same type:

Copy Slot Name
2 CM-10G-STS

143



CM-10G Modules Parameters

Port 1 Tab

Field Descriptions
Slot 4 - CM-10G-XTSH

General Wmm Slot

Name: xts-p2
Connector: XFP

Receive Status: Fault

Link Status: Down

Link Speed: 106
Loopback Mode: Off

Test Mode: off

( setings | ——

Port 1 > Properties

Port Settings x

Enable Port
Name: xts-P1
Cluse FEC
Amplitude Adjustment:
Phase Adjustment:
[Juse Channel Control
O Wave Length
O Channel Number
[Cluse TX Dither Control
ClEnable TX Dither

Configure the following parameter:

Enable Port Enables/Disables the fiber port.
Name The name of the fiber port.

Field Format: 8§ characters
Use FEC* * Note: See manufacturers documentation for parameter settings.
Use Channel * Note: See manufacturers documentation for parameter settings.
Control*
Use TX Dither * Note: See manufacturers documentation for parameter settings.
Control*
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Port 1 > XFP

General Port 2 ” Alert Log ” Advanced | Slot

Properties ﬂ.‘—

Information

Connector:
Fiber Mode:

Fiber Wavelength:
Minimum Signaling Rate:
Maximum Signaling Rate:

Serial Number:
Manufacturer:

Status

Module Temperature:

Transceiver Transmit Bias Current:

Transceiver Transmit Power:

Laser Temperature
TEC Current

Alarm and Warning Thresholds

31250 °C
67.726 mA (Normal)
1.276 mW  (Normal)
Transceiver Receive Optical Power: 0.000 mW (Low Alarm)
40203 C
-41.500 mA (Normal)

LC
Single-mode
1550 nm
9900 Mbps
11100 Mbps

Link Reach for 9/125 Single-mode Fiber: 40000 m

122-081412Y10001
Perle Systems

(Mormal)

(Mormal)

~Module Temperature

y ~ Transmit Bias Current

High Alarm Threshold:  85.000 °C High Alarm Threshold:  130.000 mA
High Warning Threshold: 80.000 °C High Warning Threshold: 128.000 mA
Low Warning Threshold: -5.000 °C Low Warning Threshold: 12.000 mA
Low Alarm Threshold:  -10.000 °C Low Alarm Threshold:  10.000 mA
~Transmit Power ~Receive Power
High Alarm Threshold:  3.000 mW High Alarm Threshold:  1.000 mW
High Warning Threshold: 2.000 m\W High Warning Threshold: 0.000 mW
Low Warning Threshold: 0.000 m\W Low Warning Threshold: 0.000 mW
Low Alarm Threshold:  0.000 mW Low Alarm Threshold:  0.000 mW

Port 2 Tab

Field Descriptions
Slot 1 - CM-10G-XTSH

General | Port 1 W | siot

SFP

Name: Port 2
SFP+
Receive Status: Fault
Link Status: Down
Link Speed: 106
Loopback Mode: Off
Test Mode: Off

—

Connector:
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Port 2 > Settings

Port Settings x

Enable Port

EDC Mode:

Auto-detect

@ Linear
O Limiting
O o

Use Channel Control

O Wave Length l:l
& Channel Number

Use TX Dither Control

Enable TX Dither

Enable Port Enables/Disables the fiber port.
Name The name of the fiber port.

Field Format: 8 characters
EDC Mode* "* Note: See manufacturers documentation for parameter settings.
Use Channel "* Note: See manufacturers documentation for parameter settings.
Control*
Use TX Dither "* Note: See manufacturers documentation for parameter settings.
Control*

Port 2 > SFP

General Port 2 | Alert Log | Advanced | Slot

Properties | (RSN <

Connector: LC

Fiber Mode: Multi-mode
Fiber Wavelength: 850 nm
Nominal Signaling Rate: 1300 Mbps

Link Reach for 50/125 Multi-mode Fiber: 550 m
Link Reach for 62.5/125 Multi-mode Fiber: 270 m
Serial Number: G25FH1195
Manufacturer: OEM

Status

Module Temperature: 41156 °C (Normal)
Transceiver Transmit Supply Voltage: 3359V  (Normal)
Transceiver Transmit Bias Current:  2.852 mA  (Normal)
Transceiver Transmit Power: 0.256 mW (Normal)

Transceiver Receive Optical Power:  0.000 mW (Low Alarm)

Alarm and Warning Thresholds -]
~Module Temp ~Transmit Supply Voltage——— —Transmit Bias Current
High Alarm Threshold: ~ 100.000 °C High Alarm Threshold:  3.700 V High Alarm Threshold:  12.000 mA
High Warning Threshold: 95.000 °C High Warning Threshold: 3.600 V High Warning Threshold: 10.000 mA
Low Warning Threshold: -45.000 °C Low Warning Threshold: 3.000 V Low Warning Threshold: 2.000 mA
Low Alarm Threshold:  -50.000 °C Low Alarm Threshold: ~ 2.900 V Low Alarm Threshold:  1.000 mA
~Transmit Power———————— - Receive Power
High Alarm Threshold: ~ 1.000 mW High Alarm Threshold:  1.259 mW
High Warning Threshold: 0.794 mW High Warning Threshold: 1.000 mW
Low Warning Threshold: 0.050 mW Low Warning Threshold: 0.008 mW
Low Alarm Threshold:  0.040 mW Low Alarm Threshold:  0.006 mW
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Note: The View Module Memory feature should only be used if guided by a Perle Technical
Support Representative.

Alert Log Tab

Field Descriptions

General | Port1 | Port2 |RENEQE St —5tet—
1 10
Date ~ Description Severity
09172012 12:17:35 CM-10G-XTSH (slot 1 - port 1): SFP/XFP module has been inserted. Significant Event
09M17/2012 12:17:34 CM-10G-XTSH (slot 1 - port 0): SFP/XFP module has been inserted. Significant Event
09172012 12:17:33 CM-10G-XTSH (slot 1): xts-p2 (unknown 1) port link status DOWN. Significant Event
09172012 12:17:32 CM-10G-XTSH (slot 1): Port 2 (unknown 2) port link status DOWN. Significant Event
09172012 12:47:32 CM-10G-XTSH (slot 1): OK. Significant Event
09172012 12:17:32 CM-10G-XTSH (slot 1): Has been inserted. Model=CM-10G-XTSH, 5/N=126-03tmc000001. Significant Event
1 10>

Displays the current local Alerts. The local Alert buffer contains the last 200 alerts and displays these
events in a wrap around fashion.

Advanced Tab

Field Descriptions

General | Port1 | Port2 || Alert Log MM.

Restart Module
Reset to Factory Defaults

~Diag

Fiber Loopback: ot

Link Test
¥ Advanced Diagnostics

Configure the following parameter:

Restart Module

Reset Factory
Defaults

Diagnostics

Fiber
Loopback

Link Test

Restarts this Media Converter Module.

Resets this Media Converter Module back to factory defaults.

Port 1: Port 1 will be in loopback mode. All data received on the receive (RX)
fiber connection is looped back to the transmit (TX) fiber connection.

Port 2: Port 2 will be in loopback mode. All data received on the receive (RX)
fiber connection is looped back to the transmit (TX) fiber connection.
Off: Loop back mode is off.

(Note: only one port can be in loopback mode at a time)

This command enables a port on a Perle 10G media converter module to
generate test patterns to a remote media converter module. If the remote media
converter module is a Perle 10G then the remote end will automatically be put
into loopback mode. This test is used to help identify link issues.
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Slot

Link Test
Link Test X
~Test P
Test Port: OPort1 OPort2
Packet Size: l
Data Type: [IRandem []Sequential (Al g

SNMP Traps on Error: []Enable

= C ion Test
Tx Packet Count: Rx Packet Count: ‘

~CRC Error Test

Tx Packet Count: CRC Error Count: ‘

~Total Errored S:

Errored Seconds Count: ‘
Test Port This is the port that will generate the test patterns to be sent to the remote

media converter. The other port will be disabled during the running of these

tests.

Values: port 1 or port 2

Packet Size The test will use this packet size when running the tests.

Values: 256-8960 bytes

Default: 256 bytes

Data Type Specify how the tests will run.

Values: Random, Sequential, Alternating (0101)

Default: 256 bytes

Advanced This feature should only be used if guided by a Perle Technical Support
Diagnostics,  Representative. Use of this feature without guidance from a Perle Technical
Read/Write Support Representative could make your Media Converter Module inoperable.

Register

Field Descriptions

General Port 1 Port2 || Alert Log | Advanced m

~ Slot Settings

Default Power State: & 0n O Off

[ Backup/Restore Module C ion A ically
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CM-10G Modules Parameters

Configure the following parameters:

Power State Immediately power the slot on or off. The current state of the slot is
highlighted in BLUE.
Press the "ON" button to immediately power the slot on.

Press the "OFF" button to immediately power the slot off.

Default Power State This is the default power state of the slot when the chassis is powered up or
restarted.

Default: On

Backup/Restore Enabled: The configuration information associated with this slot is saved on

Module the Management Module and will be downloaded to the Media Converter

Configuration Module whenever the Media Converter Module is inserted into this slot.

Automatically Disabled: The Media Converter Module configuration information is only kept
on this Module.

Default: Disabled
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CM-10GT Media
Converter Modules

Commercial Model

® CM-10GT-SFP - This model contains one pluggable transceiver port that permits insertion of
one low power SFP+ fiber module and one intergrated RJ-45 (copper) port.

High Power Model

® C(CM-10GT-XFPH - This model contains one pluggable transceiver port that permits insertion of
one high powered XFP fiber module and one intergrated RJ-45 (copper) port.

CM-10GT Module Parameters

MCR1900 Chassis

MCR-MGT-900085 April 30, 2013 13:37:16 EDT
IJEI"E 172.16.21.250 User's Guide | User: admin | Logout
MCR-MGT-900085 [» | Slot 18
H 3 O I EE N @R E O EE oOE
o m WK FWR W U e

006LHON

Cx4GPT |

Slot 18 - CM-10GT-SFP

Port 1 Port 2 Alert Log Advanced Slot

Name:  CM-0GT-SFP /

Model: CM-10GT-SFP Cx-10GT-SFP
Description: 10 Gigabit Media Converter Managed Module. SFP+ Slot to 1000BASE-T (RJ45)

. Cx 1000

Hardware Setup
Configuration Jumper: Auto ¥  Current Switch Settings...

MCR-MGT Management Module User’s Guide, Version 1.8 150



CM-10GT Module Parameters

SMI Chassis

erle MCR-MGT-900084 May 28, 2013 20:14:33 EDT
p 172.16.113.66 Users Guide | User: admin | Logout
MCR-MGT-900084 [» | Slot 2 SMI-10GT-SFP haeiaee |
Slot 2 - CM-10GT-SFP
Port 1 || Port2 || Alert Log | Advanced || Slot T
Name: CM-10GT-5FP ¥ Details
Model: CM-10GT-5FP

Description: 10 Gigabit Media Converter Managed Module. SFP+ Slot to 1000BASE-T (RJ-45)

Hardware Setup
CM-10GT-SFP

Configuration Jumper: Auta @ Current Switch Settings

Settings

General Tab

Field Descriptions
Slot 18 - CM-10GT-SFP

General ot o Ateretoy Stor

Name:  CM-10GT-SFP

Model: CM-10GT-SFP
Description: 10 Gigabit Media Converter Managed Module. SFP+ Slot to 1000BASE-T (RJ-45)

Hardware Setup
Configuration Jumper: Auto “¥  Current Switch Settings. ..

Name Displays the configured name for this Module.

Model Displays the module’s model information.

Description Displays a description of the Module that is inserted in this slot.
Configuration Auto: Use software configuration if present, otherwise use hardware DIP
Jumper switch settings.

Switch: Use hardware DIP switch settings.

For detailed information on hardware DIP switch settings, see the Hardware

Installation Guide.

Current Switch Displays the current DIP switch settings.

Settings For detailed information on hardware jumpers and DIP settings, see the

Hardware Installation Guide.
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CM-10GT Module Parameters

General > Settings > Module Settings

Module Settings b
Name:  [EDOESEE
Link Mode: |Standard ;I

I” Fiber Fault Alert

o

Configure the following parameters:

Name Displays the configured name for this Module.

Link Mode Smart Link Passthrough: In this mode, the link state on one port connection is
directly reflected through the media converter to the other port. If the link is lost
on one of the connections, then the other link will be brought down by the media
converter.

Standard Mode: In this mode, the links can be brought up and down indepen-
dently of each other. A loss of link on either connection can occur without affect-
ing the other fiber connection.

Default: Smart Link Pass-through

Fiber Fault Alert Enabled: If the media converter detects a loss of signal on the fiber port, the me-
dia converter notifies the link partner on that same port that an error condition
exists by bringing down the link.

Disabled: The media converter will not monitor for fiber fault.
Default: Disabled

.
Copy Settings
Port 1 Port 2 Alert Log Advanced Slot
Name:  CM-10GTXFPH
Model:  CM-10GTXFPH

Description: 10 Gigabit Media Converter Managed Module. XFP Slot to 1000BASE-T (RJ-45)

Hardware Setup
Configuration Jumper: Auto ¥  Current Switch Settings...

Copy Setings. e

Copy Module Settings x

Copy this module’s settings to other modules of the same type:

Copy Slot Name

2 CM-10GT-XFPH
Copy Module Copy this module’s settings to other modules of the same type.
Settings
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CM-10GT Module Parameters

Port 1 Tab (SFP installed)
Port 1 > Properties > Settings

Slot 18 - CM-10GT-SFP
General Port 2 Alert Log Advanced Slot

Name: Port 1
Connector: SFP+
Receive Status: OK
Link Status: Up
Link Speed: 10 Gbps
Loopback Mode: Off

Port 1 Settings (SFP)

Port Settings x

Enable Port

Use Channel Control

& Wave Length l:l
O Channel Number l:l

se TX Dither Control

[ Enable TX Dither

Enable Port Enables/Disables the fiber port.

Name The name of the fiber port.
Field Format: 8 characters

Use Channel Settings:

Control Wave length: 0-65535

Channel Number: 1-65535
Default: Off

* Note: See manufacturers documentation for parameter settings.

Use Dither Control Default: Disable
* Note: See manufacturers documentation for parameter settings.
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CM-10GT Module Parameters

Settings > 1000 Mbps SFP

| Module Settings x

=G 1000 Mbps SFP

Auto-Negotiation

Auto-Negotiation ~When enabled, the Media Converter Module will negotiate with its link partner
to determine the most optimal parameters for this connection. This applies to
1000 SFP modules only.
Default: Enabled

Port 1 > SFP
Slot 18 - CM-10GT-SFP

General Port 2 Alert Log Advanced Slot
Properties ﬂ———

Connector: LC

Fiber Mode: Multi-mode
Fiber Wavelength: 850 nm
Nominal Signaling Rate: 10300 Mbps

Link Reach for 50/125 Multi-mode Fiber: 80 m
Link Reach for 62.5/125 Multi-mode Fiber: 20 m

Serial Number: ASR02207
Manufacturer: OEM

Module Temperature: 38.789 °C (Normal)
Transceiver Transmit Supply Voltage: 3.317V  (Normal)
Transceiver Transmit Bias Current: 6.816 mA (Normal)
Transceiver Transmit Power: 0.560 mW (Normal)

Transceiver Receive Optical Power:  0.619 mW (Normal)

Alarm and Warning Thresholds

Module Temperature Transmit Supply Voltage Transmit Bias Current

High Alarm Threshold:  95.000 °C High Alarm Threshold: ~ 3.800 V High Alarm Threshold:  20.000 mA
High Warning Threshold: 90.000 °C High Warning Threshold: 3.700 V High Warning Threshold: 18.000 mA
Low Warning Threshold: -20.000 °C Low Warning Threshold: 2.900 V Low Warning Threshold: 1.000 mA
Low Alarm Threshold:  -25.000 °C Low Alarm Threshold: ~ 2.800 V Low Alarm Threshold:  0.500 mA
Transmit Power Receive Power

High Alarm Threshold:  1.590 mW High Alarm Threshold:  1.260 mW

High Warning Threshold: 1.260 mW High Warning Threshold: 1.000 mW

Port 1 Tab (XFP installed)
Port 1 > Properties > Settings

General Port 2 Alert Log Advanced Slot

Name: Port 1
Connector: XFP

Receive Status: OK

Link Status: Up

Link Speed: 10000
Loopback Mode: Off
—
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CM-10GT Module Parameters

Port 1 Settings (XFP)

Port Settings x

Enable Port

Name: Port 1
Use FEC .
Amplitude Adjustment: 0
Phase Adjustment: 0

Use Channel Control
& Wave Length 0

O Channel Number

Use TX Dither Control

[ Enable TX Dither |
'

Enable Port Enables/Disables the fiber port.

Name The name of the fiber port.
Field Format: 8 characters

Use FEC Settings:
Amplitude Adjustment: -128 to 127

Phase Adjustment: -128 to 127
Default: Disabled

* Note: See manufacturers documentation for parameter settings.

Use Channel Settings:
Control Wave length: 0-65535

Channel Number: 1-65535
Default: Off

* Note: See manufacturers documentation for parameter settings.

Use TX Dither Default: Disable
* Note: See manufacturers documentation for parameter settings.
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Port 1 > XFP

General Port 2 Alert Log Advanced Slot

Properties ﬂi

Connector: LC

Fiber Mode: Multi-mode

Fiber Wavelength: 850.0 nm
Minimum Signaling Rate: 9900 Mbps
Maximum Signaling Rate: 11100 Mbps

Link Reach for EBW 50/125 Multi-mode Fiber: 300 m

Link Reach for 50/125 Multi-mode Fiber: 100 m

Link Reach for 62.5/125 Multi-mode Fiber: 3m

Serial Number: 122-051412Y10002
Manufacturer: Perle Systems

Status

Module Temperature: 47.031 °C (Normal)
Transceiver Transmit Bias Current:  7.044 mA (Normal)
Transceiver Transmit Power: 0.382 mW (Normal)
Transceiver Receive Optical Power: 0.548 mW (Normal)

Alarm and Warning Thresholds +!

View Module Memory

Port 2 Tab (Copper)
Port 2 > Settings

Slot 18 - CM-10GT-SFP

General Port 1 Fer-ed 5 & ot

Name: Port 2

Connector: RJ-45

Link Status: Up

Auto Negotiation: Complete
Speed: 10000
Duplex: Full
Pause: Disabled

Link Partner Remote Fault: OK

Loopback: Off
Settings

Port 2 > Copper Port Settings

Copper Port Settings x

Enable Port

Duplex: @& Auto O Half

Pause: |Asymmetrical RX +

Energy Efficient Ethernet

Enable Port Enables/Disables the copper port.
Default: Enable

The name of the copper port.
Field Format: 8 characters

Name
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Duplex

Pause

Energy Efficient
Ethernet (EEE)

Alert Log Tab

The following selections are available:
Duplex: Auto, Half
Default: Auto

This duplex configuration parameter will only be used for 1 gigabit SPF
modules. For 10 gigabit modules, full duplex will always be advertised

When enabled, the Media Converter Module will advertise the following Pause
capabilities:

® Symmetrical

® Asymmetrical TX

® Asymmetrical RX

Note: Pause feature will only work if Auto Negotiation is set to OFF on the
fiber port and Duplex is set to Full.

Default: Off

Enabled: When enabled, the media converter module will auto negotiate EEE
with the attached EEE compliant devices/servers.

Disabled: The media converter module will not auto negotiate EEE with at-
tached the EEE compliant devices/servers.

Default: Enabled

Field Descriptions

Slot 18 - CM-10GT-SFP
General Port 1 Port 2 Alert Log

1 2 3|4 npext=last>> (10w
Date > Description Severity
04/30/2013 14:23:41 CM-10GT-SFP (slot 18): Port 2 (copper 2) port link status UP. Significant Event
04/30/2013 14:23:37 CM-10GT-SFP (slot 18): Port 2 (copper 2) port link status DOWN. Significant Event
04/30/2013 14:23:23 CM-10GT-SFP (slot 18): Port 2 (copper 2) port link status UP. Significant Event
04/30/2013 14:23:19 CM-10GT-SFP (slot 18): Port 2 (copper 2) port link status DOWN. Significant Event
04/30/2013 14:23:04 CM-10GT-SFP (slot 18): Port 2 (copper 2) port link status UP. Significant Event
04/30/2013 14:22:46 CM-10GT-SFP (slot 18): Port 2 (copper 2) port link status DOWN. Significant Event
04/30/2013 14:22:31 CM-10GT-SFP (slot 18): Port 2 (copper 2) port link status UP. Significant Event
04/30/2013 14:22:19 CM-10GT-SFP (slot 18): Port 2 (copper 2) port link status DOWN. Significant Event
04/30/2013 14:22:03 CM-10GT-SFP (slot 18): Port 2 (copper 2) port link status UP. Significant Event
04/30/2013 14:21:36 CM-10GT-SFP (slot 18): Port 2 (copper 2) port link status DOWN. Significant Event

1 2 3 4 next>last=> |10 v

Displays the current local Alerts. The local Alert buffer contains the last 200 alerts and displays these
events in a wrap around fashion.
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Advanced Tab

CM-10GT Module Parameters

Field Descriptions

General | Port1 | Port2 | Alert Log

Restart Module
Reset to Factory Defaults

Diagnostics

(o

Link Test
¥ Advanced Diagnostics

Restart Module

Reset Factory
Defaults

Diagnostics

Loopback

Link Test

Advanced
Diagnostics,
Read/Write
Register

Restarts this Media Converter Module.

Resets this Media Converter Module back to factory defaults.

Port 1: Port 1 (fiber) will be in loopback mode. Data received on the receive
(RX) fiber connection is looped back to the transmit (TX) fiber connection.

Port 2: Port 2 (copper) will be in loopback mode. Data received on the TXD
lines are looped back to the RXD lines.

Off: Loop back mode is off.
(Note: only one port can be in loopback mode at a time)

The Link Test involves sending a pattern to the remote peer, having him
validate the pattern and send back a response indicating whether he received
the pattern correctly or not. Based on the response from the peer, the local
module is able to obtain one of three statuses for that transaction (which is
repeated every second). See Link Test Responses.

This feature should only be used if guided by a Perle Technical Support
Representative. Use of this feature without guidance from a Perle Technical
Support Representative could make your Media Converter Module inoperable.

Note:

The View Module Memory feature under the Advanced Diagnostics menu should only be

used if guided by a Perle Technical Support Representative.

Link Test

Elapsed Time (seconds):

R

Link Test X

Good:
Bad:

Tr itted |
Good:

Bad:
Unknown:

Start Test | Link test unavailable because module is not inserted

Stop Test
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Link Test Received
Responses ® Good - The local module received a “good” response from the peer.

® Bad - The response received from the peer was received in error or not
received at all

Transmitted:

® Good - The remote peer indicated that the data sent by the local module
was received correctly.

e Bad - The remote peer indicated that the data sent by the local module was
received in error

® Unknown - The local module was unable to decode the message sent by
the remote peer (this is a “bad” receive status). Since the local module is
unable to decode what the peer sent back, it is unable to determine if the
data it transmitted to the peer was received correctly.

Slot
Field Descriptions
Slot 18 - CM-10GT-SFP
General Port 1 Port 2 Alert Log Advanced Slot p

Slot Settings
Default Power State: @ On O Off

[ Backup/Restore Module C ion A ically
Power State Immediately power the slot on or off. The current state of the slot is
highlighted in BLUE.

Press the "ON" button to immediately power the slot on.
Press the "OFF" button to immediately power the slot off.

Default Power State This is the default power state of the slot when the chassis is powered up or
restarted.

Default: On

Backup/Restore Enabled: The configuration information associated with this slot is saved on
Module the Management Module and will be downloaded to the Media Converter
Module whenever the Media Converter Module is inserted into this slot.

Disabled: The Media Converter Module configuration information is only kept
on this Module.

Default: Disabled
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1 5 eX-1CM110/1110 Media
Converter Modules

eX-1CM110/1110 Models

® ¢X-CM110 - This model contains one Ethernet port and one VDSL Line port with Ethernet
speeds of 10/100 megabits.

® ¢X-CMI1110 - This model contains one Ethernet port and one VDSL Line port with Ethernet
speeds of 10/100/1000 megabits.

® Both models can be ordered either with an RJ-45, BNC or Terminal Block connector for the
VDSL line port.

eX-1CM110/1110 Modules Parameters

MCR1900 Chassis

Er'E MCR-MGT-100634 February 15, 2013 01:27:09 EST
p 172.16.28.55 User's Guide | User: admin | Logout
MCR-MGT-100634 [» | Slot 2 2 Hide Chassis

=
(9]
&
o
o
o

Slot 2 - eX-1CM1110°R

InterLink Port Ethernet Port Alert Log Advanced Slot

Name:  eXICM1110-R
Model: eX-1CM1110-RJ
Description: Ethernet Extender

eX-1CM1110-RJ

SMI Chassis

eX-1CM1110-RJ

Er'E MCR-MGT-100634 February 18, 2013 21:13:14 EST
p 172.16.28.55 User's Guide | User: admin | Logout
MCR-MGT-100634 [¥ | Slot 2 X 1SMIT110.R) [a Hide Chassis |
f *
ETHERNET )
Slot 2 - eX-1CM1110-RJ 4
InterLink Port Ethernet Part Alert Log Advanced Slot
Name:  eX-ACMi110-RJ
Model: eX-1CM1110-RJ

Description: Ethernet Extender
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General Tab

Field Descriptions

Slot 2 - eX-1CM1110-RJ
w‘ S = A -
9
Name:  eX-1CM1110RJ
Model:  eX-1CM1110R

Description: Ethemnet Extender

Hardware Setup
Configuration Jumper: Auto “#  Current Switch Settings...

Name Displays the configured name for this Module.

Model Displays the module’s model information.

Description Displays a description of the Module that is inserted in this slot.
Configuration Auto: Use software configuration if present, otherwise use hardware DIP
Jumper switch settings.

Switch: Use hardware DIP switch settings.

For detailed information on hardware DIP switch settings, see the Hardware
Installation Guide.

Current Switch Displays the current DIP switch settings.

Settings For detailed information on hardware jumpers and DIP settings, see the
Hardware Installation Guide.

General > Settings

Module x

Name: EX-1CM1110-RJ

Link Mode: | Standard hd

[ InterLink Fault Feedback

Displays the configured name for this Module.

Name

Link Mode Standard Mode: In this mode, the Ethernet Extender module will not pass the
state of the Ethernet interface across the Line connection to its peer. A loss on
the Ethernet interface can occur without affecting the peer connection.

Link Pass-Through: In this mode, the Ethernet Extender will pass the state of
the Ethernet interface across the Line connection to its peer. If link is lost on
the Ethernet connection, then the peer Ethernet connection will be brought
down by the remote Ethernet Extender. This is accomplished by signalling
Link Pass-Through across the VDSL line without bringing down the link.

Default: Standard Mode
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Interlink Fault
Feedback

The status of the VDSL interface will be passed to its Ethernet interface. If the
VDSL line link is lost the Ethernet link will be brought down.

When Interlink Fault Feedback is unchecked the status of the VDSL interface
will not be passed to its Ethernet interface.

Default: unchecked

General >Switch Settings

Module

Unidirectional Ethernet: &) picapled

Map Priority to Egress Queue:

O Ethemnet to Interlink
O Interlink to Ethernet

x

Priority Queue
0
1
2
3
4
5
6
7
Unidirectional When enabled, this feature provides the ability to restrict the flow of data
Ethernet between the Ethernet and Interlink port.
Values:
® Disabled
o Ethernet to Interlink
® Interlink to Ethernet
Default: Disabled
Map Priority to This is the default egress priority mapping for both the Ethernet and Interlink

Egress Queue

port.

® Priority 0 (lowest priority)... Queue 0
® Priority 1... Queue 0
® Priority 2... Queue 1
® Priority 3... Queue 1
® Priority 4... Queue 2
® Priority 5... Queue 2
® Priority 6... Queue 3
® Priority 7... (highest priority)...Queue 3
Copy Settings
Slot 2 - eX-1CM1110-RJ
InterLink Port Ethernet Port Alert Log Advanced Slot
Name: eX-1CM1110-R)
Model: eX-1CM1110-RJ

Description: Ethemet Extender

Hardware Setup
Configuration Jumper: Auto &

Copy Settings. .. aff——

Current Switch Settings...
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Copy Module Settings x

Copy this module’s settings to other modules of the same type:

Copy Slot Name

1 eX-1CM110-RJ
Copy Module Copy this module’s settings to other modules of the same type.
Settings

Interlink Port > Properties

Interlink Port > Properties > Settings

m Ethernet Port | Alert Log | Advanced | Slot
*

Name: VDSL-lyn
Connector: RJ-45
Link Status: Up
Loopback: Off

Remote Loopback: Off

Role: Remaote (CPE}

Settings

Interlink Settings x

Settings Advanced Switch Features

Enable Port

Role:

Rate/Reach: High-Speed
Symmetry:

Fast Mode

Enable Port Enable/Disable Interlink port.
Default: Enabled

Name The name of the Interlink port.
Length: characters (1-8)
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Role

Rate/Reach

Symmetry

Fast Mode

eX-1CM110/1110 Modules Parameters

Auto: If at least one Ethernet Extender is configured for Auto mode, a
proprietary method of detection is implemented for each attempt to synchronize
one side of the link to local and the other side of the link to remote. However, it
is preferable to configure one Ethernet Extender to Local and the other Ethernet
Extender to Remote since this may result in slightly faster training times and
direct control over their roles.

Local (C0): This Ethernet Extender is set to the Local mode of operation.

Remote (CPE): This Ethernet Extender is set to the Remote mode of
operation.

Note: Ethernet Extender modules work in pairs. If both Ethernet Extenders are
not set to Auto, then one side of the link must be set to Local/Auto and the
other end must be set to Remote/CPE.

High Speed: In this mode, the VDSL connection will be optimized for
maximum attainable speeds.

Long Range: In this mode, the VDSL connection will be optimized for
distance and the achievable distance will be up to 1 mile (3 km).

Symmetric: Set this mode to Symmetric if your network data needs are almost
equal for uploads and downloads (both directions).

Asymmetric: Set this mode to Asymmetric if your network data needs are
primarily for downloads. Data direction is towards the remote Ethernet
Extender.

Fast mode reduces frame latency when using shorter cable distances.
Default: Enabled

Note: Using Interlink override values for upstream and downstream SNR
and/or INP may disable Fast Mode.

Note: The actual distance and rates may vary depending on the environment and type/gauge of
wire used. There will always be a compromise between speed and range. For more
information on hardware specifications see the Perle website at www.perle.com.
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Interlink Port > Properties > Settings > Advanced

Interlink Settings

%

Settings

# Select VDSL profile manually
(Override Rate and Symmetry)

© Select VDSL profile automatically
(Use Rate and Symmetry on Settings tab)

¥ Bitswapping

Profile: [32 - AnnexC_POTS_25-276 b ;l

¥ Override advanced VDSL profile settings

Upstream Downstream
Signal-to-Noise Ratio o xo1dB o0 x01d8
Minimum Datarate l125— kbps |128 kbps
Maximum Datarate W kbps W kbps
Maximum Interleave Delay lE_ ms l— ms
Minimum INP " "

" Low Bandwidth Alarm (upstream) kbps (1-90000)
" Low Bandwidth Alarm (downstream) kbps (1-90000)

@

o

Select VDSL Profile ' S¢lect VDSL profile automatically” to use the configured settings for Rate

Automatically

and Symmetry on the settings tab.

Select VDSL Profile "Select VDSL profile manually” to override the configured settings for Rate

Manually

Override advanced
VDSL profile
settings

Signal to Noise
Ratio

Minimum Data
Rate

Maximum Data
Rate

Maximum
Interleave Delay

and Symmetry on the settings tab. Then select a profile from the drop down
list. For a description of the VDSL profiles, refer to the ITU-T recommendation
G.993.2.

Select this checkbox to override specific parameters associated with the VDSL
line.

Note: Advanced settings for VDSL are only valid if your Ethernet Extender
has been configured with a role of Local.
Configure the value to be used for Signal to Noise Ratio.

The Ethernet Extender module will attempt to maintain the desired SNR value
by adjusting line settings. A larger dB number will result in less line errors and
a more stable connection, but may result in slower speeds.

If Rate/Reach is set to High Speed the default value is 90dB for both upstream
and downstream data.

If Rate/Reach is set to Long Range the default value is 60dB for both upstream
and downstream data.

Values: Upstream/Downstream: 30 - 240 (3 - 24 dB)

The minimum data rate of the VSDL link.
Values: Upstream/Downstream 128 - 101064 kbps

The maximum data rate of the VSDL link.

Values: Upstream/Downstream 128 - 101064 kbps

Interleaving is a method of taking packets, chopping them up into smaller bits
and then rearranging them so that once contiguous data is now spaced further

apart into a noncontinuous stream. This provides better noise protection but
increases latency.

Enter the maximum acceptable gap in the data.
Values: Upstream/Downstream 0-16 ms
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Minimum Impulse This is a measure of minimum amount of protection, in terms of the discrete
Noise Protection  multi-tone (DMT) symbols that can be recovered if impulse noise occurs in a

(INP) burst.
Fast Mode Values: Upstream/Downstream 1-18
Bitswapping As line conditions change, bit swapping allows the modem to swap bits around

different channels without retraining as each channel becomes more or less
capable. If bit swapping is disabled, the modem will need to retrain in order to
adapt to changing line conditions.

Low Bandwidth  When the Upstream link is established the Ethernet Extender module will
Alarm (up) check the low bandwidth value. If the data rate is below the threshold value, an
SNMP trap will be generated.

Values: 1-90000 kbps
Low Bandwidth  When the Downstream link is established the Ethernet Extender module will

Alarm (down) check the low'bandwidth value. If the data rate is below the threshold value, an
SNMP trap will be generated.

Values: 1-90000 kbps

Interlink Port > Properties > Settings > Switch Features > Priority

Interlink Settings E3

Settings Advanced
Rz i e g et

Use 802.1p Tag Priority

Use IP TOS Priority
Priority Precedence: © 802.1p O IP TOS

Congestion Policy: @ Strict Queueing O Weighted Queueing

Remap 802.1p Tag Priority:

Qriginal Priority ~ New Priority

0 0>

1 1%

2 2>

&l 3w

4 (4 %

5 5v

6 6 ¥

i 7>
Enable 802.1p When enabled, the media converter module will use IEEE 802.1p tagged frame
Priority priority control to assign ingress frames to the appropriate priority egress queue.

Default: Enabled

Enable IP TOS When enabled, the media converter module will use IPv4 Diffserv or IPv6 traffic
Priority class field to assign ingress frames to the appropriate priority egress queue.
Default: Enabled

Priority Precedence When both 802.1p priority and IP TOS priority are selected, you can select which
of the two priorities takes precedence.
Default: 802.1p
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Remap 802.1p Tag Remap IEEE 802.1p ingress frames with a new priority tag. This new priority tag

Priority

Congestion Policy

will be used to determine which queue the frame gets posted to.
Original Priority ----- > New Priority

Values: 0-7

Select a method to be used when determining the order by which frames are sent
from the four egress queues. Setting the congestion policy on either the Interlink
or Ethernet port will change the policy on both ports.

Strict Priority Queuing - The order is determined strictly by the priority of the
queue. Frames in higher priority queues are always sent ahead of frames in lower
priority queues.

Weighted Fair Queuing - This method allows lower priority frames to be inter-
mixed with higher priority frames in the ratio of (8, 4, 2, 1).

The ratio for 8 highest priority sent frames will be as follows:

8 highest priority frames from queue 3

4 frames from queue 2

2 frames from queue 1

1 frame from queue 0

Interlink Port > Properties > Settings > Switch Features > Rate

Limiting

Interlink Settings

Settings Advanced mﬁﬂﬁm
Priority Other

Ingress Rate Limit: | MNone

Egress Rate Limit: |MNone

v

v

x

Ingress Rate Limit Restricts ingress frames on the Interlink port.

Egress Rate Limit

Default: None
Data Options: none to 90 Mbps

Restricts egress frames on the Interlink port.
Default: None
Data Options: none to 90 Mbps

167



eX-1CM110/1110 Modules Parameters

Interlink Port > Properties > Settings > Switch Features > VLAN
Tagging

Interlink Settings x

Settings Advanced ﬁaﬂﬂﬂ
Priority Rate Limiting W

[ Discard Tagged Frames

[ Discard Untagged Frames
Default VLAN ID: 1 ]
Default Priority: 0 V

VLAN Tagging Action: & Normal C Untag © Tag O Double Tag

Discard Tagged When enabled, discards all VLAN tagged frames.
Frames Default: Off

Discard Untagged When enabled, discards all VLAN untagged frames.
Frames Default: Off

Default VLAN ID  Specify a default VLAN ID to insert when tagging frames.
Default: 1
Data Options: 0-4095

Default Priority ~ Specify a default VLAN priority to insert when tagging frames.
Default: 0
Data Options: 0-7

VLAN Tagging Define the VLAN tagging action to take on a egress frame.
Actions ® Normal -Take no action.

e Untag - Remove any existing tag.

® Tag
Insert tag with configured VLAN ID and VLAN priority if original
frame is untagged.

Replace tag with configured VLAN ID and VLAN priority if original
frame is tagged.

® Double tag - Append a tag with configured VLAN ID and VLAN priority.
Default: Normal

Interlink Port > Properties > Settings > Switch Features > Other

Interlink Settings

Settings Advanced mﬁﬂﬁﬂ

Priority Rate Limiting VLAN Tagging

o
d

[ Filter Unknown Multicast Frames

L1 Filter Unknown Unicast Frames

Filter Unknown When enabled, multicast frames with unknown destination addresses are not

Multicast Frames allowed to egress this port.
Default: Disabled

Filter Unknown When enabled, unicast frames with unknown destination addresses are not
Unicast Frames allowed to egress this port.
Default: Disabled
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Interlink Port - Advanced VDSL Status

Displays the current statuses for the VDSL port.

General |OICHEIIELUE Ethemet Port | Alert Log || Advanced | Slot

Upstream Downstream
Attainable Data Rate 17221 83470 kbps
Actual Data Rate 17221 83470 kbps
Previous Data Rate 0 0 kbps
Actual Signal-To-Noise Ratio 89 59 x01dB
uso 0 x0.1dB
US1DS1 89 60 x0.1dB
Us2DS2 0 58 x0.1dB
US3 DS3 0 0x01dB
US4 DS4 0 0x01dB
Actual Signal Attenuation 0 0x01dB
uso 20 x0.1dB
US1DS1 0 0x01dB
Us2DS2 0 0x01dB
US3 DS3 0 0x01dB
US4 DS4 0 0x01dB
Actual Line Attenuation 0 0x01dB
uso 20 x0.1dB
US1DS1 0 0x01dB
Us2DS2 0 0x01dB
US3 DS3 0 0x01dB
US4 Ds4 ] 0x01dB
Actual Interleave Delay 0 0 ms
Actual INP 0 0
Actual Interleaving Depth il il
Actual Interleaving Block 255 255
Actual Transmit Power 17 66 x 0.1 dBm
Maximum Data Rate 200000 200000 kbps
Minimum Data Rate 128 128 kbps
Target Signal-To-Noise Ratio 60 60 x 0.1dB
Maximum Interleave Delay 8 8 ms
Minimum INP 4 4
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Interlink Port - Statistics

w‘ Ethernet Port H Alert Log H Advanced | Slot

Properties | Advanced VDSL Status M

Basic

Bytes

Received (Good): 0
Received (Error): 0
Transmitted: 2216012

Detailed

Received Frames
Good Frames
Unicast Frames:
Broadcast Frames:
Multicast Frames:

Pause (Flow Control)
Frames:

Bad Frames
Undersized Frames:
Fragment Frames:
Oversized Frames:
Jabber Frames:
MAC Receive Errors:
FCS Errors:

VDSL
Period: | Since linkup hd
Full Init:
Code Violation:
Corrected:

Forward Error Correction Seconds:
Errored Seconds:

Severely Errored Seconds:

Loss Of Signal Seconds:
Unavailable Seconds:

Frames
Receive Filtered:

Transmit Filtered:

Receive Discards:

c oo o oo

Transmitted Frames
Good Frames
Unicast Frames:
Broadcast Frames:
Multicast Frames:

Pause (Flow Control)
Frames:

FCS Errors:
Deferred Frames:

Collisions (excluding
Late and Excessive):

Late Collisions:
Excessive Collisions:
Single Collisions:
Multiple Collisions:

Local Remote

@ o oo oo o
@ o oo oo o

33163
528

o o oo

Frame Lengths
64 Bytes:

65 to 127 Bytes:
128 to 255 Bytes:
256 to 511 Bytes:
512 to 1023 Bytes:

1024 to Maximum
Bytes:

32641
848

Reset Basic and Detailed Counters ]

Note: Resetting Basic and Detailed counters will not reset the VDSL counters. The VDSL counters

are automatically reset when the VDSL link is reset.

Ethernet Port > Properties

General || InterLink Port |SUEHERSLLEN Alert Log || Advanced | Slot

Settings

Properties a
Name: Ethernet
Connector: RJ-45
Link Status: Up
Auto Negotiation: Complete
Speed: 1 Gbps
Duplex: Full
Pause: Disabled
Link Partner Remote Fault Status: OK
Downshift Status: Mo
MDI/MDI-X: DI
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Ethernet Port > Properties > Settings
General || Interlink Port m: e — — "

Name: Ethernet

Connector: RJ-45

Link Status: Up

Auto Negotiation: Complete
Speed: 1000
Duplex: Full
Pause: Symmetrical

Link Partner Remote Fault Status: OK

Downshift Status: No

MDUMDI-X: MDI-X
Settings

Settings
Ethernet Port Settings E3

Settings Advanced Switch Features

Enable Port

Name: Ethernet

® Auto-negotiate speed and duplex
Advertise the following capabilities:
10 Mbps, Full Duplex 10 Mbps, Half Duplex
100 Mbps, Full Duplex 100 Mbps, Half Duplex

1000 Mbps, Full Duplex <-|— eX-1CM-1110 models
only

O set speed and duplex manually

Pause: Asymmetrical RX

MDUMDI-X: @ Auto O MDI O MDIX
Enable Port Enables/Disables the Ethernet port.

Default: Enable

Name The name of the Ethernet port.
Data Values: 1-8 characters

Auto Negotiate Define the Ethernet connection.
Speed and Duplex Data Options:

Auto—automatically detects the Ethernet interface speed and duplex
10 Mbps/Half Duplex

10 Mbps/Full Duplex

100 Mbps/Half Duplex

100 Mbps/Full Duplex

1000 Mbps/Half Duplex (applies to eX-1CM-1110 models only)

Default: Auto

Set Speed and When enabled, the following selections are available:
Duplex Manually  gpeed: 100 Mbps, 10 Mbps
Duplex: Full, Half
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Pause ‘When enabled, the Media Converter Module will advertise its Pause
capabilities.
MDI/MDI-X ® Auto-Detect— automatically detects the Ethernet’s cable polarity

® MDI —the cable’s polarity is straight-through
® MDI-X —the cable’s polarity is crossovered
Default: Auto

Ethernet Port > Properties > Settings > Set speed and duplex
manually

Copper Port x

SERIGER  Advanced

Enable Port

Name:

O Auto-negotiate speed and duplex

{%] Set speed and duplex manually
Speed: (& 100 Mbps O 10 Mbps
Duplex: @ Full O Half

Pause
MDI/MDI-X: @ Auto O mMDI O MDI-X

Set Speed and When enabled, the following selections are available:
Duplex Manually  gpeed: 100 Mbps, 10 Mbps
Duplex: Full, Half

Ethernet Port > Properties > Settings > Advanced

Ethernet Port Settings

Settings w

Downshift speed after 3| link attempts

10BASE-T Distance: @ Normal O Extended

Downshift speed When enabled, the number of retries the Media Converter Module will attempt
after number of  to establish a fiber connection at 1000 Mbps before attempting a lower speed.

link attempts Default: On
Link attempts: 1-8

10BASE-T Distance Normal: the Media Converter copper link is in normal operating mode.

Extended: the Media Converter will boost the signal strength on its copper
link.
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Ethernet Port > Properties > Settings > Switch Features >Priority

Ethernet Port Settings x

Settings Advanced mﬁﬂﬁm
mn oL AN =
s g

Use 802.1p Tag Priority

Use IP TOS Priority
Priority Precedence: ® 802.1p O IP TOS

Congestion Policy: @ Strict Queueing O Weighted Queueing

Remap 802.1p Tag Priority:

Criginal Priority ~ Mew Priority

0 0>

1 1v

2 2

3 3w

4 4

& v

6 6 ¥

7 T
Enable 802.1p When enabled, the media converter module will use IEEE 802.1p tagged frame
Priority priority control to assign ingress frames to the appropriate priority egress queue.

Default: Enabled

Enable IP TOS When enabled, the media converter module will use IPv4 Diffserv or IPv6 traffic
Priority class field to assign ingress frames to the appropriate priority egress queue.
Default: Enabled

Priority Precedence When both 802.1p priority and IP TOS priority are selected, you can select which
of the two priorities takes precedence.
Default: 802.1p

Remap 802.1p Tag Remap IEEE 802.1p ingress frames with a new priority tag. This new priority tag
Priority will be used to determine which queue the frame gets posted to.

Original Priority ----- > New Priority

Values: 0-7

Congestion Policy Select a method to be used when determining the order by which frames are sent
from the four egress queues. Setting the congestion policy on either the Interlink
or Ethernet port will change the policy on both ports.

Strict Priority Queuing - The order is determined strictly by the priority of the
queue. Frames in higher priority queues are always sent ahead of frames in lower
priority queues.

Weighted Fair Queuing - This method allows lower priority frames to be inter-
mixed with higher priority frames in the ratio of (8, 4, 2, 1).

The ratio for 8 highest priority sent frames will be as follows:

8 highest priority frames from queue 3

4 frames from queue 2

2 frames from queue 1

1 frame from queue 0
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Ethernet Port > Properties > Settings > Switch Features > Rate
Limiting

Settings Advanced mﬁﬂﬁm
Priority Qther

Ingress Rate Limit:
Egress Rate Limit:

Ingress Rate Limit Restricts ingress frames on the Interlink port.
Default: None
Data Options: none to 90 Mbps

Restricts egress frames on the Interlink port.
Default: None
Data Options: none to 90 Mbps

Egress Rate Limit

Ethernet Port > Properties > Settings > Switch Features > VLAN
Tagging

Ethernet Port Settings x

Settings Advanced ﬁaﬂﬂﬂ
Priority Rate Limiting

[ Discard Tagged Frames

[ Discard Untagged Frames

Default VLAN ID:
Default Priority:
VLAN Tagging Action: & Normal O Untag © Tag O Double Tag

Discard Tagged When enabled, discards all VLAN tagged frames.
Frames Default: Off

Discard Untagged When enabled, discards all VLAN untagged frames.
Frames Default: Off

Default VLAN ID Specify a default VLAN ID to insert when tagging frames.
Default: 1
Data Options: 0-4095
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Default Priority Specify a default VLAN priority to insert when tagging frames.
Default: 0
Data Options: 0-7

VLAN Tagging Define the VLAN tagging action to take on a egress frame.
Actions @ Normal -Take no action.

o Untag - Remove any existing tag.

e Tag
Insert tag with configured VLAN ID and VLAN priority if original
frame is untagged.

Replace tag with configured VLAN ID and VLAN priority if original
frame is tagged.

® Double tag - Append a tag with configured VLAN ID and VLAN priority.
Default: Normal

Ethernet Port > Properties > Settings > Switch Features > Other

Ethernet Port Settings x

Settings Advanced ﬁaﬂﬂﬂ

Priority Rate Limiting VLAN Tagging —_—

[ Filter Unknown Multicast Frames

[ Filter Unknown Unicast Frames

Filter Unknown When enabled, multicast frames with unknown destination addresses are not

Multicast Frames allowed to egress this port.
Default: Disabled

Filter Unknown When enabled, unicast frames with unknown destination addresses are not
Unicast Frames allowed to egress this port.
Default: Disabled

Alert Log

General InterLink Port Ethemnet Port W

:

Date ~ Description Severity

02/16/2013 21:54:35 eX-1CM1110-RJ (slot 2): VDSL (VDSL) port link status UP. Significant Event

02/16/2013 21:54:35 eX-1CM1110-RJ (slot 2): Ethernet (ethemet) port link status UP. Significant Event

02/16/2013 21:54:35 eX-1CM1110-RJ (slot 2): OK. Significant Event

02/16/2013 21:54:35 eX-1CM1110-RJ (slot 2): Has been inserted. Model=eX-1CM1110-RJ, S/N=207-042222222222. Significant Event
1

Displays the current local Alerts. The local Alert buffer contains the last 200 alerts and displays these
events in a wrap around fashion.
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Advanced

Slot

General | InterLink Port | Ethemet Port | Alert Log

Restart Module
Restart Remote Module
Reset to Factory Defaults

Diagnosti
Local Loopback:

Remote Loopback:
Virtual Cable Test
¥ Advanced Diagnostics

Restart Module

Restart Remote
Module

Reset to Factory
Defaults
Diagnostics

(Local)
Loopback

(Remote)
Loopback

Virtual Cable
Test

Advanced
Diagnostics,
Read/Write
Register

Restarts this Media Converter Module.

The local Ethernet Extender module sends a restart sequence to the remote
Ethernet Extender to restart.

Resets this Media Converter Module back to factory defaults.

In local loopback mode any data received on the VDSL line from the remote
Ethernet Extender module will be looped back to the remote Ethernet Extender
module.

In remote loopback mode any data received on the VDSL line from the local
Ethernet Extender module will be looped back to the local Ethernet Extender
module.

Performs a Virtual Cable Test to remotely and non-evasively diagnose the quality
and characteristics of the attached ethernet cable. This test can detect issues such
as cable opens, cable shorts or any impedance mismatch in the cable and then ac-
curately report (within one meter) the distance of the fault. In addition, this Vir-
tual Cable Test will detect pair swaps, pair polarity reversal and excessive pair
skew.

This feature should only be used if guided by a Perle Technical Support
Representative. Use of this feature without guidance from a Perle Technical
Support Representative could make your Media Converter Module inoperable.

General InterLink Port Ethemet Port Alert Log Advanced M

Slot Settings

Default Power State: @ On O Off

[[J Backup/Restore Module Configuration Automatically

Power

Immediately power the slot on or off. The current state of the slot is
highlighted in BLUE.

Press the "ON" button to immediately power the slot on.
Press the "OFF" button to immediately power the slot off.
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Default Power State This is the default power state of the slot when the chassis is powered up or

Backup/Restore

restarted.
Default: On

Enabled: The configuration information associated with this slot is saved on
the Management Module and will be downloaded to the Media Converter
Module whenever the Media Converter Module is inserted into this slot.

Disabled: The Media Converter Module configuration information is only kept
on this Module.

Default: Disabled
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CM-4GPT-DSFP Media
Converter Module

This module allows connections and cross connections of fiber networks of different types to each
other.

® protocol independent module using two standard SFP+ modules with speeds up to 4.25 Gbps.

CM-4GPT-DSFP Media Module Parameters

MCR1900 Chassis

Er'E MCR-MGT-100634 February 18, 2013 01:07:48 EST
p 172.16.28.55 User's Guide | User: admin | Logout
MCR-MGT-100634 [ | Slot 4 2 Hide Chassis

0 E g = m

Fees
a8l

Ena =

M M

006LHON

MCRMI

Slot 4 - CM-4AGPT

Port 1 Port 2 Alert Log Advanced Slot

Name:  CMA4GPT-DSFP \

Model: CMA4GPT-DSFP Cx-4GPT-DSFP

-DSFP

Description: Media Converter Managed Module. SFP Slot to SFP Slot

Hardware Setup
Configuration Jumper: Auto ¥  Current Switch Settings...

SMI Chassis

erie MCR-MGT-100634 February 18, 2013 20:49:41 EST
p 172.16.28 55 User's Guide | User: admin | Logout
MCR-MGT-100634 [» | Slot 2 SMIAGPT-DSFP A Hide Chassis

B - o«

Chassis Info..

PT

[0}

X4

=il CONSOLE)

Slot 2 - CM-4GPT-DSFP
Port 1 Port 2 Alert Log Advanced Slot

Name: CM-4GPT-DSFP l
Model: CM-4GPT-DSFP CM-4GPT-DSFP
Description: Media Converter Managed Module. SFP Slot to SFP Slot

(

Hardware Setup
7

Configuration Jumper: Auto @ Current Switch Ssttings_

MCR-MGT Management Module User’s Guide, Version 1.8
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General Tab
Field Descriptions

Slot 4 - CM-4GPT-DSFP
[ Goneral | tesrre et
Name:  CM4GPT-DSFP
Model:  CM4GPT-DSFP

Description: Media Converter Managed Module. SFP Slot to SFP Slot

Hardware Setup
Configuration Jumper: Auto @  Current Switch Settings. .

Name Displays the configured name for this Module.

Model Displays the module’s model information.

Description Displays a description of the Module that is inserted in this slot.
Configuration Auto: Use software configuration if present, otherwise use hardware DIP
Jumper switch settings.

Switch: Use hardware DIP switch settings.

For detailed information on hardware DIP switch settings, see the Hardware
Installation Guide.

Current Switch Displays the current DIP switch settings.

Settings For detailed information on hardware jumpers and DIP settings, see the

Hardware Installation Guide.
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Module Settings

Module Settings

Name: CM-4GPT-DSFP
Link Mode: |Smart Link Passthrough +

[ Fiber Fault Alert
Rate Select: |High +

Name

Link Mode

Fiber Fault Alert

Rate Select

Displays the configured name for this Module.

Smart Link Pass-Through: In this mode, the fiber link state on one fiber
connection is directly reflected through the media converter module to the
other fiber connection. Since this media converter module is protocol
independent, it monitors the Signal Detect indicator from the SFP and reflects
this on the TX port of the other SFP by turning off the transmitter. When the
signal (Link) gets restored and Signal Detect becomes active, the affected
transmitter will get re-enabled.

Standard Mode: In Standard Mode the media converter module will monitor
the fiber link in the same manner. If Signal Detect goes down the media
converter module will output a 25SMHz signal on the TX port of the other SFP.

Default: Smart-Link Passthrough

Enabled: If the media converter module detects a loss of fiber signal on its fiber
receiver, it will disable its fiber transmitter on the same SFP. This, in effect, no-
tifies the fiber link partner that an error condition exists on the fiber connection.
Disabled: The module will take no action when a loss of signal is detected.
Default: Disabled

Note: If two media converters are connected to each other, FFA should not be
enabled on both since this could create a "deadlock" state.

High Speed: when a multi-rate SFP is inserted, it is enabled for the higher
speed of operation.

Low Speed: when a multi-rate SFP is inserted, it is enabled for the slower
speed of operation.

Default: High
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Copy Settings
Port 1 Port 2 Alert Log Advanced Slot

Name:  CM4GPT-DSFP

Model: CM-4GPT-DSFP
Description: Media Converter Managed Module. SFP Slot to SFP Slot

Hardware Setup
Configuration Jumper: Auto '@ Current Switch Settings. -

Settings | Copy Settings -

Copy Module Settings x

Copy this module’s settings to other modules of the same type:

Copy Slot Name

4 CM-4GPT-DSFP

Copy Module Copy this module’s settings to other modules of the same type.
Settings

Port 1
Port 1 > Properties > Settings

Slot 4 - CM-4GPT-DSFP s |
General Port 2 || AlertLog || Advanced | Siot
SFP
Name:  Port 1

Connector: SFP
Link Status: Up

Settings

| Port settings x
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General Port 2 Alert Log Advanced Slot

Properties SFP

Information [-]

Connector: LC

Fiber Mode: Single-mode

Fiber Wavelength: 1310 nm

Nominal Signaling Rate: 2500 Mbps

Link Reach for 9/125 Single-mode Fiber: 20000 m

Serial Number: 122-101013¥10002
Manufacturer: Perle Systems

Status

Module Temperature: 48.969 °C  (Normal)
Transceiver Transmit Supply Voltage: 3.346 V  (Normal)
Transceiver Transmit Bias Current: 24.224 mA (Normal)
Transceiver Transmit Power: 0.606 mW (Normal)
Transceiver Receive Optical Power:  0.261 mW (Normal)

Alarm and Warning Thresholds

View Module Memory

Note: The View Module Memory feature should only be used if guided by a Perle Technical
Support Representative.

Port 2
Port 2 > Properties > Settings

General Port 1 Alert Log Advanced Slot

SFP

Name: Port 2

Connector: SFP
Link Status: Up

Settings

Port Settings x
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Port 2 SFP

General Port 1 Alert Log Advanced Slot

Properties SFP

Information

Connector:

Fiber Mode:

Fiber Wavelength:

Nominal Signaling Rate:

Link Reach for 9/125 Single-mode Fiber:
Serial Number:

Manufacturer:

LC

Single-mode

1310 nm

2500 Mbps

20000 m
122-101013Y10003
Perle Systems

Status

Module Temperature: 49.281°C (Normal)
Transceiver Transmit Supply Voltage: 3.344V  (Normal)
Transceiver Transmit Bias Current: 25936 mA (Normal)
Transceiver Transmit Power: 0.579 mW (Normal)
Transceiver Receive Optical Power:  0.042 mW (Normal)

Alarm and Warning Thresholds +!

View Module Memory

Note: The View Module Memory feature should only be used if guided by a Perle Technical
Support Representative.

Alert Log

General Port 1 Port 2 w

8|9 10 next> last=>

Date

> Description

Severity

02/18/2013 02:07:39
02/18/2013 02:07:39
02/18/2013 02:07:38
02/18/2013 02:07:37
02/18/2013 02:07:37
02/18/2013 02:07:36
02/18/2013 02:07:36
02/18/2013 02:07:35
02/18/2013 02:07:35
02/18/2013 02:07:34

CM-AGPT-DSFP (slot 4): Port 1 (fiber 1) port link status UP.

CM-AGPT-DSFP (slot 4): Port 1 (fiber 1) port link status DOWN.

CM-AGPT-DSFP (slot 4): Port 1 (fiber 1) port link status UP.

CM-AGPT-DSFP (slot 4): Port 1 (fiber 1) port link status DOWN.

CM-AGPT-DSFP (slot 4): Port 1 (fiber 1) port link status UP.

CM-AGPT-DSFP (slot 4): Port 1 (fiber 1) port link status DOWN.

CM-AGPT-DSFP (slot 4): Port 1 (fiber 1) port link status UP.

CM-AGPT-DSFP (slot 4): Port 1 (fiber 1) port link status DOWN.

CM-AGPT-DSFP (slot 4): Port 1 (fiber 1) port link status UP.

CM-AGPT-DSFP (slot 4): Port 1 (fiber 1) port link status DOWN.

Significant Event
Significant Event
Significant Event
Significant Event
Significant Event
Significant Event
Significant Event
Significant Event
Significant Event
Significant Event

12

[
=
e
=3
I~
=
Ko

10 | next > last »=

Displays the current local Alerts. The local Alert buffer contains the last 200 alerts and displays these
events in a wrap around fashion.
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Advanced Tab

General Port 1 Port 2 || Alert Log 4

Restart Module
Reset to Factory Defaults

Restart Module Restarts this Media Converter Module.

Reset Factory Resets this Media Converter Module back to factory defaults.
Defaults

Slot

General Port 1 Port2 | Alert Log Advanced m:

Slot Settings
Default Power State: & On O Off

[] Backup/Restore Module Configuration Automatically

Power State Immediately power the slot on or off. The current state of the slot is
highlighted in BLUE.

Press the "ON" button to immediately power the slot on.
Press the "OFF" button to immediately power the slot off.

Default Power State This is the default power state of the slot when the chassis is powered up or
restarted.

Default: On

Backup/Restore Enabled: The configuration information associated with this slot is saved on

Module the Management Module and will be downloaded to the Media Converter
Configuration Module whenever the Media Converter Module is inserted into this slot.
Automatically Disabled: The Media Converter Module configuration information is only kept

on this Module.
Default: Disabled
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A Alert Messages

Introduction
This appendix contains the list of alerts which can be generated by the MCR-MGT Management
Module.
The alerts are grouped in the following sections;
® Management Module alerts
Chassis alerts

® Power supply alerts
® Media converter alerts
® SFP related alerts

Format of alerts

Each alert consists of the following items;

Date alert occurred

Time alert occurred

Name of instance of object (i.e Media Converter Module name and slot number)

Description of event which triggered the alert

Severity of the alert

Severity levels

Alerts are assigned a specific severity level. This enables the user to set a filter for alerts at an
appropriate severity level.

The following are the severity levels defined on the MCR-MGT Management Module in decreasing
severity level. Also included is the syslog equivalent level.

Severity level Syslog equivalent
System Level Fault - Emergency

Module Level Fault - Alert

Persistent Error - Critical

One Time Error - Error

Significant Event - Warning

Normal Operation - Notice
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Alert Messages

Alert Messages

Management Module Alerts

Mgmt: Management module has been inserted in slot x,

Severity --> Significant Event
- Cold Start

Normal Operation

Mgmt: System boot
Severity -->
Mgmt :

System boot - Warm start,

Severity --> Normal Operation
Mgmt: Has been reset.

Severity --> Significant Event
Mgmt :
Severity --> Significant Event
Ethernet port link status UP.
Severity —--> Normal Operation
Ethernet port link status DOWN.

Severity --> Significant Event

Mgmt :

Mgmt :

Mgmt :

Severity --> Significant Event
Mgmt: Authentication SUCCESSFUL!
IP=Unknown.

Access

Severity --> Normal Operation
Mgmt: Authentication SUCCESSFUL!
Severity --> Normal Operation
Mgmt: Authentication SUCCESSFUL!
Severity --> Normal Operation
Mgmt: Authentication SUCCESSFUL!
Severity --> Normal Operation

Access

Access

Access

System crash

Has been reset to factory default.

Model=model, S/N=s/n.

(System diagnostic file available).

Console port monitored signal changed. DSR now inactive.

method=Serial Console, Originating

method=SNMP, Originating IP= ip.

method=Telnet, Originating IP= ip.

method=SSH, Originating IP= ip.

(System diagnostic file available).

Mgmt: Authentication SUCCESSFUL! Access method=WebManager (HTEMPP), Originating
IP= ip.

Severity --> Normal Operation
Mgmt: Authentication SUCCESSFUL! Access method=WebManager (HTEMPPS), Originating
IP= ip.

Severity --> Normal Operation
Mgmt: Authentication FAILED! Access method=Serial Console, Originating
IP=Unknown.

Severity --> One Time Error
Mgmt: Authentication FAILED! Access method=SNMP, Originating IP= ip.

Severity --> One Time Error
Authentication FAILED!
Severity --> One Time Error
Authentication FAILED!
Severity --> One Time Error
Authentication FAILED!

Mgmt : Access

Mgmt : Access

Mgmt :
ip.

Access

Severity --> One Time Error

Mgmt: Authentication FAILED! Access

ip.

method=Telnet,

method=WebManager (HTEMPP) ,

method=WebManager (HTEMPPS) ,

Originating IP= ip.

method=SSH, Originating IP= ip.
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Severity --> One Time Error

Mgmt: System date/time has been set. Current date/time is now mm dd, yyyy hh:mm:ss

tz (GMT -hhh).
Severity --> Significant Event

Mgmt: Communication with Secondary SNTP server ip recovered.
Severity --> Significant Event

Mgmt: Communication with Primary SNTP server ip FAILED.
Severity --> One Time Error

Mgmt: Communication with SNMP trap host 5 IP=ip recovered.
Severity --> Significant Event

Mgmt: Communication with SNMP trap host 2 IP=ip FAILED.
Severity --> One Time Error

Mgmt: Communication with email server ip recovered.
Severity --> Significant Event

Mgmt: Communication with email server ip FAILED.
Severity --> One Time Error

Mgmt: Configuration saved to flash.
Severity --> Normal Operation

Mgmt: System IP address has been dynamically changed from ip to ip.
Severity —--> Significant Event

Mgmt: TFTP file transfer of file fileNamel to remote host ip was successful.
Severity --> Normal Operation

Mgmt: TFTP file transfer of file fileName2 to remote host ip failed.
Severity --> One Time Error

Mgmt: TFTP file transfer of file fileName3 from remote host ip was successful.
Severity --> Normal Operation

Mgmt: TFTP file transfer of file fileName4 from remote host ip failed.
Severity --> One Time Error

Mgmt: Chassis configuration mismatch! Backup Media Converter Module

configurations reset to factory default.
Severity --> Significant Event

Chassis Alerts
Chassis: Has been reset.
Severity --> Significant Event
Chassis: High Temperature alarm cleared! Temperature temp C/F.
Severity --> Significant Event
Chassis: High temperature alarm! Temperature temp C/F, alarm threshold temp C/F.
Alarm Relay Engaged."
Severity --> System Level Fault
Chassis: Slot 5 has been powered ON. Model=model, S/N=s/n, Module name=name."

Severity --> Significant Event
Chassis: Slot 7 has been powered OFF.

Severity --> Significant Event
Chassis: OK.

Severity --> Significant Event

Chassis: Failed! Reason code=33. Alarm Relay Engaged.
Severity --> System Level Fault
Chassis: Communication with temperature sensor has been restored.
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Severity --> Significant Event
Chassis: Communication with temperature sensor failed.
Severity --> One Time Error

Power Supply Alerts

POWER SUPPLY A: Power Supply Monitoring Unit has been inserted. Model=model,
S/N=s/n."
Severity --> Significant Event
POWER SUPPLY A: Has been removed from chassis.
Severity --> Significant Event
POWER SUPPLY A: Power supply OK.
Severity --> Significant Event
POWER SUPPLY A: Power supply failed! Reason code=22. Alarm Relay Engaged.
Severity --> System Level Fault
POWER SUPPLY B: Voltage from power supply restored.
Severity --> Significant Event
POWER SUPPLY B: No voltage being supplied from power supply. Alarm Relay Engaged.
Severity --> System Level Fault
POWER SUPPLY B: Fan OK.
Severity --> Normal Operation
POWER SUPPLY B: Fan failed! Alarm Relay Engaged.
Severity --> System Level Fault

Media Converter Alerts

Mod. Name (slot x,): Has been inserted. Model=model, S/N=s/n."
Severity --> Significant Event
Mod. Name (slot x): Has been removed.
Severity --> Significant Event
Mod. Name (slot x): Has been reset.
Severity --> Significant Event
Mod. Name (slot x): Recovered communication with Management module.
Severity --> Significant Event
Mod. Name (slot x): No longer communicating with Management module.
Severity --> Module Level Fault
Mod. Name (slot x): OK.
Severity --> Significant Event
Mod. Name (slot x): Failed! Reason code=44.
Severity --> Module Level Fault
Mod. Name (slot x): Fiber port link status UP.
Severity --> Significant Event
Mod. Name (slot x): Copper port link status DOWN.
Severity --> Significant Event
Mod. Name (slot x): Configuration update failed.
Severity --> One Time Error
Mod. Name (slot x): Configuration update successful.
Severity --> Normal Operation
Mod. Name (slot x): Configuration mismatch resolved. Type inserted model, type
configured model.
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Mod.

Severity -->
Name

(slot x):

Significant Event
Backup media configuration mismatch. Module type inserted

model, module type configured model.

Severity -->

Persistent Error
Firmware update successful.

Severity --> Normal Operation

Firmware update failed!

Severity --> One Time Error

Module has been powered down due to detection of a hardware

Severity --> Module Level Fault

The image on this Media Converter Module is invalid.

Severity --> Module Level Fault

Module not fully supported. Please download latest firmware to

Severity —--> Significant Event

Mod. Name (slot x):
Mod. Name (slot x):
Mod. Name (slot x):
failure.

Mod. Name (slot x):
Mod. Name (slot x):

MCR-MGT module.

Mod. Name (slot Xx):

Module firmware is being updated.

Severity —--> Significant Event

SFP/XFP Alerts

Mod.

Mod.

Mod.

Mod.

Mod.

Name (slot x,
Severity -->
Name (slot x,
Severity -->
Name (slot x,
Severity -->

Name (slot x,

port y): SFP/XFP module has been inserted.
Significant Event

port y): SFP/XFP module has been removed.
Significant Event

port vy):
Significant Event

port y): Unable to communicate with SFP/XFP module.

Recovered communication with SFP/XFP module.

Severity --> Module Level Fault

Name (slot x,

port y): SFP/XFP DMI High temperature warning recovered.

Temperature temp C/F

Severity -->

Significant Event

Mod. Name (slot x, port y): SFP/XFP DMI High temperature warning. Temperature temp

C/F,

Mod.

warning threshold temp C/F."

Severity -->

Name (slot x,

Persistent Error

port y): SFP/XFP DMI High temperature alarm recovered.

Temperature temp C/F.

Mod.

C/F,

Mod.

Severity -->

Name (slot x,

Significant Event

port y): SFP/XFP DMI High temperature alarm! Temperature temp

alarm Threshold temp C/F."
Severity --> Module Level Fault

Name (slot x,

port y): SFP/XFP DMI Low temperature warning recovered.

Temperature temp C/F.

Mod.

Severity -->

Name (slot x,

Significant Event
port y): SFP/XFP DMI Low temperature warning. Temperature temp

C/F, warning threshold temp C/F."

Mod.

Severity -->
Name

(slot x,

Persistent Error

port y): SFP/XFP DMI Low temperature alarm recovered.

Temperature temp C/F.
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Severity --> Significant Event
Mod. Name (slot x, port y): SFP/XFP DMI Low temperature alarm! Temperature temp
C/F, alarm Threshold temp C/F."

Severity --> Module Level Fault
Mod. Name (slot x, port y): SFP/XFP DMI High voltage warning recovered. Voltage
value Volts.

Severity --> Significant Event
Mod. Name (slot x, port y): SFP/XFP DMI High voltage warning. Voltage value Volts,
warning threshold value Volts."

Severity --> Persistent Error
Mod. Name (slot x, port y): SFP/XFP DMI High voltage alarm recovered. Voltage
value Volts.

Severity --> Significant Event
Mod. Name (slot x, port y): SFP/XFP DMI High voltage alarm! Voltage value Volts,
alarm threshold value Volts."

Severity --> Module Level Fault
Mod. Name (slot x, port y): SFP/XFP DMI Low voltage warning recovered. Voltage
value Volts.

Severity --> Significant Event
Mod. Name (slot x, port y): SFP/XFP DMI Low voltage warning. Voltage wvalue Volts,
warning threshold value Volts."

Severity --> Persistent Error
Mod. Name (slot x, port y): SFP/XFP DMI Low voltage alarm recovered. Voltage value
Volts.

Severity --> Significant Event
Mod. Name (slot x, port y): SFP/XFP DMI Low voltage alarm! Voltage wvalue Volts,
alarm threshold value Volts."

Severity --> Module Level Fault
Mod. Name (slot x, port y): SFP/XFP DMI High TX bias current warning recovered. TX
Bias: value mA

Severity --> Significant Event
Mod. Name (slot x, port y): SFP/XFP DMI High TX bias current warning. TX Bias
value mA, warning threshold value mA."

Severity --> Persistent Error
Mod. Name (slot x, port y): SFP/XFP DMI High TX bias current alarm recovered. TX
Bias: value mA.

Severity --> Significant Event
Mod. Name (slot x, port y): SFP/XFP DMI High TX bias current alarm! TX Bias value
mA, alarm threshold value mA."

Severity --> Module Level Fault
Mod. Name (slot x, port y): SFP/XFP DMI Low TX bias current warning recovered. TX
Bias value mA.

Severity --> Significant Event
Mod. Name (slot x, port y): SFP/XFP DMI Low TX bias current warning. TX Bias value
mA, warning threshold value mA."

Severity --> Persistent Error
Mod. Name (slot x, port y): SFP/XFP DMI Low TX bias current alarm recovered. TX
Bias value mA.

Severity --> Significant Event
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Mod. Name (slot x, port y): SFP/XFP DMI Low TX bias current alarm! TX Bias value
mA, alarm threshold value mA."

Severity --> Module Level Fault
Mod. Name (slot x, port y): SFP/XFP DMI High TX power warning recovered. TX power
value mW.

Severity --> Significant Event
Mod. Name (slot x, Slot y): SFP/XFP DMI High TX power warning. TX power value mW,
warning threshold value mW."

Severity --> Persistent Error
Mod. Name (slot x, port y): SFP/XFP DMI High TX power alarm. TX power value mW,
alarm threshold value mw."

Severity --> Module Level Fault
Mod. Name (slot x, port y): SFP/XFP DMI High TX power alarm recovered. TX power
value mW.

Severity --> Significant Event
Mod. Name (slot x, port y): SFP/XFP DMI Low TX power warning recovered. TX power
value mW

Severity --> Significant Event
Mod. Name (slot x, port y): SFP/XFP DMI Low TX power warning. TX power value mW,
warning threshold value mwW."

Severity --> Persistent Error
Mod. Name (slot x, port y): SFP/XFP DMI Low TX power alarm recovered. TX power
2000.001 mw.

Severity --> Significant Event
Mod. Name (slot x, port y): SFP/XFP DMI Low TX power alarm. TX power value mW,
alarm threshold value mW."

Severity --> Module Level Fault
Mod. Name (slot x, port y): SFP/XFP DMI High RX power warning recovered. RX power
value mW.

Severity --> Significant Event
Mod. Name (slot x, port y): SFP/XFP DMI High RX power warning. RX power value mW,
warning threshold value mW."

Severity --> Persistent Error
Mod. Name (slot x, port y): SFP/XFP DMI High RX power alarm recovered. RX power
3000.001 mwW.

Severity --> Significant Event
Mod. Name (slot x, port y): SFP/XFP DMI High RX power alarm! RX power value mW,
alarm threshold value mw."

Severity --> Module Level Fault
Mod. Name (slot x, port y): SFP/XFP DMI Low RX power warning recovered. RX power
value mW.

Severity --> Significant Event
Mod. Name (slot x, port y): SFP/XFP DMI Low RX power warning. RX power value mW,
warning threshold value mW.

Severity --> Persistent Error
Mod. Name (slot x, port y): SFP/XFP DMI Low RX power alarm recovered. RX power
value mW.

Severity --> Significant Event
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Mod.

Name (slot x, port y): SFP/XFP DMI Low RX power alarm! RX power value mW,

alarm threshold value mW.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod

Mod.

Mod.

Mod.

Mod.

Mod.

Severity --> Module Level Fault

Name (slot x, port y): SFP/XFP module has been shutdown due to high
temperature.

Severity --> Module level Fault"

Name (slot x, port y): SFP/XFP module has been recovered from shutdown due to
high temperature.

Severity --> Significant Event

Name (slot x, port y): Module port XFP High APD Bias voltage warning. Voltage
value mV, warning threshold value mV.

Severity --> Persistent Error

Name (slot x, port y): Module port XFP High APD Bias voltage warning
recovered. Voltage value mV.

Severity --> Persistent Error

Name (slot x, port y): Module port XFP High APD Bias voltage alarm! Voltage
value mV, alarm threshold value mV.

Severity --> Module Level Fault

Name (slot x, port y): XFP High APD Bias voltage alarm recovered. Voltage
value mV.

Severity --> Significant Event

Name (slot x - port y): XFP Low APD Bias voltage warning. Voltage value mV,
warning threshold value mV.

Severity --> Persistent Error
Name (slot x, port y): XFP Low APD Bias voltage warning recovered. Voltage
value mV. Severity --> Persistent Error

Name (slot x, port y): XFP Low APD Bias voltage alarm! Voltage value mV,
alarm threshold value mV.

Severity --> Module Level Fault

Name (slot x, port y): XFP Low APD Bias voltage alarm recovered. Voltage
value mV.

Severity --> Significant Event
Name (slot x, port y): XFP High TEC current warning. Current value mA,
warning threshold value mA. Severity --> Persistent Error

Name (slot x, port y): XFP High TEC current warning recovered. Current value
mA.

Severity --> Persistent Error

Name (slot x, port y): XFP High TEC current alarm! Current value mA, alarm
threshold value mA. Severity —--> Module Level Fault

Name (slot x, port y: XFP High TEC current alarm recovered. Current value mA.

Severity --> Significant Event

Name (slot x, port y): XFP Low TEC current warning. Current value mA, warning
threshold value mA. Severity --> Persistent Error

Name (slot x, port y): XFP Low TEC current warning recovered. Current value
mA.

Severity --> Significant Event

Name (slot x, port y): XFP Low TEC current alarm! Current value mA, alarm

threshold value mA. Severity —--> Module Level Fault

Name (slot x, port y): XFP Low TEC current alarm recovered. Current value mA.
Severity --> Significant Event

Name (slot x, port y): XFP High Laser temperature warning. Temperature,
warning threshold.

Severity --> Persistent Error
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Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Name (slot x, port y): XFP High Laser temperature warning recovered.
Temperature Severity --> Significant Event

Name (slot x, port y): XFP High Laser temperature alarm! Temperature, alarm
threshold Severity --> Module Level Fault

Name (slot x, port y): XFP High Laser temperature alarm recovered.
Temperature. Severity --> Significant Event

Name (slot x, port y): XFP Low Laser temperature warning. Temperature,
warning threshold.

Severity --> Persistent Error

Name (slot x, port y): XFP Low Laser temperature warning recovered.
Temperature Severity --> Significant Event

Name (slot x, port y): XFP Low Laser temperature alarm! Temperature, alarm

threshold Severity --> Module Level Fault

Name (slot x, port y): XFP Low Laser temperature alarm recovered. Temperature
Severity -->Significant Event

Name (slot x, port y): XFP High Laser wavelength warning. Wavelength nm,
warning threshold nm.

Severity --> Persistent Error

Name (slot x, port y): XFP High Laser wavelength warning recovered.
Wavelength nm. Severity --> Persistent Error

Name (slot x, port y): XFP High Laser wavelength alarm! Wavelength nm, alarm
threshold nm.

Severity --> Module Level Fault

Name (slot x, port y): XFP High Laser wavelength alarm recovered. Wavelength

nm. Severity --> Significant Event

Name (slot x, port y): XFP Low Laser wavelength warning. Wavelength nm,
warning threshold nm.

Severity --> Persistent Error

Name (slot x, port y): XFP Low Laser wavelength warning recovered. Wavelength
nm. Severity --> Significant Event

Name (slot x, port y): XFP Low Laser wavelength alarm! Wavelength nm, alarm

threshold nm.

Severity --> Module Level Fault

Name (slot x, port y): XFP Low Laser wavelength alarm recovered. Wavelength
nm. Severity --> Significant Event

Name (slot x, port y): XFP High +5V supply voltage warning. Voltage value
Volts, warning threshold value Volts.

Severity --> Persistent Error
Name (slot x, port y): XFP High +5V supply voltage warning recovered. Voltage
value Volts. Severity --> Persistent Error

Name (slot x, port y): XFP High +5V supply voltage alarm! Voltage value
Volts, alarm threshold value Volts.

Severity --> Module Level Fault

Name (slot x, port y): XFP High +5V supply voltage alarm recovered. Voltage
value Volts. Severity --. Significant Event

Name (slot x, port y): XFP Low +5V supply voltage warning. Voltage value
Volts, warning threshold value Volts.

Severity --> Persistent Error
Name (slot x, port y): XFP Low +5V supply voltage warning recovered. Voltage
value Volts. Severity --> Persistent Error

Name (slot x, port y): XFP Low +5V supply voltage alarm! Voltage value Volts,
alarm threshold value Volts.
Severity --> Module Level Fault
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Mod. Name (slot x, port y): XFP Low +5V supply voltage alarm recovered. Voltage
value Volts. Severity --> Significant Event

Mod. Name (slot x, port y): XFP High +3.3V supply voltage warning. Voltage value
Volts, warning threshold value Volts.
Severity --> Persistent Error

Mod. Name (slot x, port y): XFP High +3.3V supply voltage warning recovered.
Voltage value Volts. Severity --> Significant Event

Mod. Name (slot x, port y): XFP High +3.3V supply voltage alarm! Voltage value
Volts, alarm threshold value Volts.
Severity --> Module Level Fault

Mod. Name (slot x, port y): XFP High +3.3V supply voltage alarm recovered. Voltage
value Volts. Severity --> Significant Event

Mod. Name (slot x, port y): XFP Low +3.3V supply voltage warning. Voltage value
Volts, warning threshold value Volts.
Severity --> Persistent Error

Mod. Name (slot x, port y): XFP Low +3.3V supply voltage warning recovered.
Voltage value Volts. Severity Significant Event

Mod. Name (slot x, port y): XFP Low +3.3V supply voltage alarm! Voltage wvalue
Volts, alarm threshold value Volts.
Severity --> Module Level Fault

Mod. Name (slot x, port y): XFP Low +3.3V supply voltage alarm recovered. Voltage
value Volts. Severity --> Significant Event

Mod. Name (slot x, port y): XFP High +1.8V supply voltage warning. Voltage value
Volts, warning threshold value Volts.
Severity --> Persistent Error

Mod. Name (slot x, port y): XFP High +1.8V supply voltage warning recovered.
Voltage value Volts. Severity --> Significant Event

Mod. Name (slot x, port y): XFP High +1.8V supply voltage alarm! Voltage value
Volts, alarm threshold value Volts.
Severity --> Module Level Fault

Mod. Name (slot x, port y): XFP High +1.8V supply voltage alarm recovered. Voltage
value Volts. Severity --> Significant Event

Mod. Name (slot x, port y): XFP Low +1.8V supply voltage warning. Voltage value
Volts, warning threshold value Volts.
Severity --> Persistent Error

Mod. Name (slot x, port y): XFP Low +1.8V supply voltage warning recovered.
Voltage value Volts. Severity --> Significant Event

Mod. Name (slot x, port y): XFP Low +1.8V supply voltage alarm! Voltage wvalue
Volts, alarm threshold value Volts.
Severity --> Module Level Fault

Mod. Name (slot x, port y): XFP Low +1.8V supply voltage alarm recovered. Voltage
value Volts. Severity --. Significant Event

Mod. Name (slot x, port y): XFP High -5.2V supply voltage warning. Voltage value
Volts, warning threshold value Volts.

Severity --> Persistent Error
Mod. Name (slot x, port y): XFP High -5.2V supply voltage warning recovered.
Voltage value Volts. Severity --> Persistent Error

Mod. Name (slot x, port y): XFP High -5.2V supply voltage alarm! Voltage value
Volts, alarm threshold value Volts.
Severity --> Module Level Alert

Mod. Name (slot x, port y): XFP High -5.2V supply voltage alarm recovered.
Voltages value Volts. Severity --. Significant Event

Mod. Name (slot x, port y): XFP Low -5.2V supply voltage warning. Voltage value
Volts, warning threshold value Volts.
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Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Severity --> Persistent Error

Name (slot x, port y): XFP Low -5.2V supply voltage warning recovered.
Voltage value Volts. Severity --> Significant Event

Name (slot x, port y): XFP Low -5.2V supply voltage alarm! Voltage value
Volts, alarm threshold value Volts.

Severity --> Module Level Fault

Name (slot x, port y): XFP Low -5.2V supply voltage alarm recovered. Voltage
value Volts. Severity --> Significant Event

Name (slot x, port y): XFP High +5V supply current warning. Current value ma,
warning threshold value mA.

Severity --> Persistent Error
Name (slot x, port y): XFP High +5V supply current warning recovered. Current
value mA. Severity --> Significant Event

Name (slot x, port y): XFP High +5V supply current alarm! Current value mA,
alarm threshold value mA.

Severity --> Module Event Error
Name (slot x, port y): XFP High +5V supply current alarm recovered. Current
value mA. Severity --> Significant Error

Name (slot x, port y): XFP High +5V supply current warning. Current value ma,
warning threshold value mA.

Severity --> Persistent Error
Name (slot x, port y): XFP High +5V supply current warning recovered. Current
value mA. Severity --> Significant Event

Name (slot x, port y): XFP High +5V supply current alarm! Current value mA,
alarm threshold value mA.

Severity --> Module Level Fault

Name (slot x, port y): XFP High +5V supply current alarm recovered. Current
value mA. Severity --> Significant Event

Name (slot x, port y): XFP High +3.3V supply current warning. Current value
mA, warning threshold value mA.

Severity --> Persistent Error
Name (slot x, port y): XFP High +3.3V supply current warning recovered.
Current value mA. Severity —--> Significant Event

Name (slot x, port y): XFP High +3.3V supply current alarm! Current value ma,
alarm threshold value mA.

Severity --> Module Level Fault

Name (slot x, port y): XFP High +3.3V supply current alarm recovered. Current
value mA. Severity --> Significant Event

Name (slot x, port y): XFP High +3.3V supply current warning. Current value
mA, warning threshold value mA.

Severity --> Persistent Error
Name (slot x, port y): XFP High +3.3V supply current warning recovered.
Current value mA. Severity —--> Significant Event

Name (slot x, port y): XFP High +3.3V supply current alarm! Current value ma,
alarm threshold value mA.

Severity --> Module Level Fault

Name (slot x, port y): XFP High +3.3V supply current alarm recovered.
Currents value mA. Severity --> Significant Event

Name (slot x, port y): XFP High +1.8V supply current warning. Current value
mA, warning threshold value mA.

Severity --> Persistent Error
Name (slot x, port y): XFP High +1.8V supply current warning recovered.
Current value mA. Severity --> Significant Events
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Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Name (slot x, port y): XFP High +1.8V supply current alarm! Current value ma,
alarm threshold value mA.

Severity --> Module Level Fault

Name (slot x, port y): XFP High +1.8V supply current alarm recovered. Current
value mA. Severity -->Significant Event

Name (slot x, port y): XFP High +1.8V supply current warning. Current value
mA, warning threshold value mA.

Severity --> Persistent Error
Name (slot x, port y): XFP High +1.8V supply current warning recovered.
Current value mA. Severity —--> Significant Event

Name (slot x, port y): XFP High +1.8V supply current alarm! Current value ma,
alarm threshold value mA.

Severity --> Module Level Fault

Name (slot x, port y): XFP High +1.8V supply current alarm recovered. Current
Value mA. Severity --> Significant Event

Name (slot x, port y): XFP High -5.2V supply current warning. Current value
mA, warning threshold value mA.

Severity --> Persistent Error
Name (slot x, port y): XFP High -5.2V supply current warning recovered.
Current value mA. Severity —--> Significant Event

Name (slot x, port y): XFP High -5.2V supply current alarm! Current value ma,
alarm threshold value mA.

Severity --> Module Level Fault

Name (slot x, port y): XFP High -5.2V supply current alarm recovered. Current
value mA. Severity --> Significant Event

Name (slot x, port y): XFP High -5.2V supply current warning. Current value
mA, warning threshold value mA.

Severity --> Persistent Error
Name (slot x, port y): XFP High -5.2V supply current warning recovered.
Current value mA. Severity —--> Significant Event

Name (slot x, port y): XFP High -5.2V supply current alarm! Current value ma,
alarm threshold value mA.

Severity --> Module Level Fault

Name (slot x, port y): XFP High -5.2V supply current alarm recovered. Current
value mA. Severity --> Significant Event

Name (slot x, port y): XFP High +5V supply voltage warning

Severity --> Persistent Error

Name (slot x, port y): XFP High +5V supply voltage warning recovered.
Severity --> Significant Event

Name (slot x, port y): XFP High +5V supply voltage alarm!

Severity --> Module Level Fault

Name (slot x, port y): XFP High +5V supply voltage alarm recovered.

Severity --> Significant Event
Name (slot x, port y): XFP Low +5V supply voltage warning.
Severity --> Persistent Error

Name (slot x, port y): XFP Low +5V supply voltage warning recovered.
Severity --> Significant Event

Name (slot x, port y): XFP Low +5V supply voltage alarm!

Severity --> Module Level Fault

Name (slot x, port y): XFP Low +5V supply voltage alarm recovered.
Severity --> Significant Event

Name (slot x, port y): XFP High +3.3V supply voltage warning

Severity -->Persistent Error

Name (slot x, port y): XFP High +3.3V supply voltage warning recovered.
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Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Mod.

Severity --> Significant Event
Name (slot x, port y):

Severity --> Module Level Fault
Name (slot x, port y):

Severity --> Significant Error
Name (slot x, port y): XFP Low
Severity --> Persistent Error

Name (slot x, port y): XFP Low
Severity --> Significant Event
Name (slot x, port y): XFP Low
Module Level Fault

Name (slot x, port y): XFP Low
Severity --> Significant Event
Name (slot x, port y): XFP High +1
Severity --> Persistent Error

Name (slot x, port y): XFP High +1

Severity --> Significant Event

Name (slot x, port y): XFP High +1
Module Level Fault

Name (slot x, port y): XFP High +1
Severity --> Significant Event
Name (slot x, port y): XFP Low
Persistent Error

Name (slot x, port y): XFP Low
Severity --> Significant Event
Name (slot x, port y): XFP Low
Module Level Fault

Name (slot x, port y): XFP Low
Severity --> Significant Event
Name (slot x, port y): XFP High -5
>Persistent Error

Name (slot x, port y): XFP High -5
Severity --> Significant Event
Name (slot x, port y): XFP High -5
Severity --> Module Level Fault
Name (slot x, port y): XFP High -5
Severity --> Significant Event
Name (slot x, port y): XFP Low
Severity --> Persistent Error

Name (slot x, port y): XFP Low
Severity --> Significant Event
Name (slot x, port y): XFP Low
Module Level Fault

Name (slot x, port y): XFP Low
Severity --> Significant Event
Name (slot x, port y):

Severity --> Significant Event
Name (slot x, port y):

Severity --> Significant Event
Name (slot x, port y):

Severity --> Significant Event
Name (slot x, port y):

Severity --> Significant Event

+3.3V
+3.3V
+3.3V

+3.3V

.8V supply voltage alarm!

+1.8V
+1.8V
+1.8V

+1.8V

-5.2V
-5.2V
-5.2V

-5.2V

XFP High +3.3V supply voltage alarm!

XFP High +3.3V supply voltage alarm recovered.

supply voltage warning.
supply voltage warning recovered.
Severity -->

supply voltage alarm!

supply voltage alarm recovered.

.8V supply voltage warning

.8V supply voltage warning recovered.

Severity -->

.8V supply voltage alarm recovered.

supply voltage warning.
supply voltage warning recovered.
Severity -->

supply voltage alarm!

supply voltage alarm recovered.

.2V supply voltage warning Severity --
.2V supply voltage warning recovered.
.2V supply voltage alarm!

.2V supply voltage alarm recovered.

supply voltage warning.
supply voltage warning recovered.
Severity -->

supply voltage alarm!

supply voltage alarm recovered.

SFP/XFP module has been inserted.

SFP/XFP module has been removed.

Unable to communicate with SFP/XFP module.

Recovered communication with SFP/XFP module.
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Name (slot x, port y): SFP/XFP DMI High temperature warning. Temperature,
warning threshold.

Severity --> Persistent Error
Name (slot x, port y): SFP/XFP DMI High temperature warning recovered.
Temperature. Severity --> Significant Event

Name (slot x, port y): SFP/XFP DMI High temperature alarm! Temperature, alarm
Threshold.

Severity --> Module Level Faults

Name (slot x, port y): SFP/XFP DMI High temperature alarm recovered.
Temperature. Severity --> Significant Event

Name (slot x, port y): SFP/XFP DMI Low temperature warning. Temperature,
warning threshold.

Severity --> Persistent Error

Name (slot x, port y): SFP/XFP DMI Low temperature warning recovered.
Temperature. Severity --> Significant Event

Name (slot x, port y): SFP/XFP DMI Low temperature alarm! Temperature, alarm
Threshold.

Severity --> Module Level Fault

Name (slot x, port y): SFP/XFP DMI Low temperature alarm recovered.
Temperature Severity --> Significant Event

Name (slot x, port y): SFP/XFP DMI High voltage warning. Voltage value Volts,
warning threshold value Volts.

Severity --> Persistent Error

Name (slot x, port y): SFP/XFP DMI High voltage warning recovered. Voltage
value Volts.

Severity --> Significant Event

Name (slot x, port y): SFP/XFP DMI High voltage alarm! Voltage value Volts,
alarm threshold value Volts.

Severity --> Module Level Fault

Name (slot x, port y): SFP/XFP DMI High voltage alarm recovered. Voltage
value Volts. Severity --> Significant Event

Name (slot x, port y): SFP/XFP DMI Low voltage warning. Voltage value Volts,
warning threshold value Volts.

Severity --> Persistent Error

Name (slot x, port y): SFP/XFP DMI Low voltage warning recovered. Voltage
value Volts. Severity --> Significant Event

Name (slot x, port y): SFP/XFP DMI Low voltage alarm! Voltage value Volts,
alarm threshold value Volts.

Severity —--> Module Level Fault

Name (slot x, port y): SFP/XFP DMI Low voltage alarm recovered. Voltage value
Volts.

Severity -->Significant Event

Name (slot x, port y): SFP/XFP DMI High TX bias current warning. TX Bias
value mA, warning threshold value mA."

Name (slot x, port y): SFP/XFP DMI High TX bias current warning recovered. TX
Bias: value mA Severity --> Significant Event

Name (slot x, port y): SFP/XFP DMI High TX bias current alarm! TX Bias value
mA, alarm threshold value mA.

Severity —--> Module Level Fault

Name (slot x, port y): SFP/XFP DMI High TX bias current alarm recovered. TX
Bias: value mA. Severity --> Significant Event

Name (slot x, port y): SFP/XFP DMI Low TX bias current warning. TX Bias value
mA, warning threshold value mA.

Severity —--> Persistent Error
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Name (slot x, port y): SFP/XFP DMI Low TX bias current warning recovered. TX
Bias value mA. Severity --> Significant Events

Name (slot x, port y): SFP/XFP DMI Low TX bias current alarm! TX Bias value
mA, alarm threshold value mA.

Severity --> Module Level Fault

Name (slot x, port y): SFP/XFP DMI Low TX bias current alarm recovered. TX
Bias value mA. Severity --> Significant Event

Name (slot x, port y): SFP/XFP DMI High TX power warning. TX power, warning
threshold Severity --> Persistent Error

Name (slot x, port y): SFP/XFP DMI High TX power warning recovered. TX power.
Severity --> Significant Event

Name (slot x, port y): SFP/XFP DMI High TX power alarm. TX power, alarm
threshold. Severity --> Module Level Fault

Name (slot x, port y): SFP/XFP DMI High TX power alarm recovered. TX power.
Severity --> Significant Event

Name (slot x, port y): SFP/XFP DMI Low TX power warning. TX power, warning
threshold Severity --> Persistent Error

Name (slot x, port y): SFP/XFP DMI Low TX power warning recovered. TX power
Severity --> Significant Event

Name (slot x, port y): SFP DMI Low TX power alarm. TX power, alarm threshold.
Severity --> Module Level Fault

Name (slot x, port y): SFP/XFP DMI Low TX power alarm recovered. TX power.
Severity --> Significant Event

Name (slot x, port y): SFP/XFP DMI High RX power warning. RX power, warning
threshold

Severity --> Persistent Error

Name (slot x, port y): SFP/XFP DMI High RX power warning recovered. RX power
Severity --> Significant Event

Name (slot x, port y): SFP/XFP DMI High RX power alarm! RX power, alarm
threshold Severity --> Module Level Fault

Name (slot x, port y): SFP/XFP DMI High RX power alarm recovered. RX power
Severity --> Significant Event

Name (slot x, port y): SFP/XFP DMI Low RX power warning. RX power, warning
threshold

Severity --> Persistent Error

Name (slot x, port y): SFP/XFP DMI Low RX power warning recovered. RX power
Severity --> Significant Event

Name (slot x, port y): SFP/XFP DMI Low RX power alarm! RX power, alarm
threshold

Severity --> Module Level Fault

Name (slot x, port y): SFP/XFP DMI Low RX power alarm recovered. RX power
Severity --> Significant Event

Name (slot x,): Speed Mismatch between SFP and the other SFP/XFP module
Severity --> Persistent Error

Name (slot x,): SFP speed mismatch has recovered.

Severity --> Significant Event

Name (slot x,): An XFP module’s power requirements has exceeded card capacity
Severity --> Module Level Fault

Name (slot x,): XFP excessive power alarm has recovered

Severity --> Significant Event

Name (slot x, port y): Low upstream bandwidth alarm! Bandwidth (Upstream
Bandwidth kbps) dropped below threshold (UpstreamBandwidthThreshold kbps) .
Severity --> Persistent Error

Name (slot x, port y): Recovered from low upstream bandwidth condition.
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Severity --> Significant Error

Mod. Name (slot x, port y): Low downstream bandwidth alarm! Bandwidth
(DownstreamBandwidth kbps) dropped below threshold
(DownstreamBandwidthThreshold kbps) .

Severity --> Persistent Error
Mod. Name (slot x, port y): Recovered from low downstream bandwidth condition.
Severity --> Significant Error

VDSL Line Alerts

Mod. Name (slot x,): Peer was reset
Severity --> Significant Event
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B SSL/TLS Ciphers

Valid SSL/TLS Ciphers

SSL Key- Key-

Full Name Ver. Exchange Authentication Encryption Size HMAC

ADH-AES256-SHA SSLv3 Kx=DH Au=None Enc=AES 256  Mac=SHAI1
DHE-RSA-AES256-SHA SSLv3 Kx=DH Au=RSA Enc=AES 256  Mac=SHAIl
DHE-DSS-AES256-SHA SSLv3 Kx=DH Au=DSS Enc=AES 256  Mac=SHAI1
AES256-SHA SSLv3 Kx=RSA Au=RSA Enc=AES 256  Mac=SHAI1
EDH-RSA-DES-CBC3-SHA SSLv3 Kx=DH Au=RSA Enc=3DES 168 Mac=SHAI
EDH-DSS-DES-CBC3-SHA SSLv3 Kx=DH Au=DSS Enc=3DES 168 Mac=SHAI
DES-CBC3-SHA SSLv3 Kx=RSA Au=RSA Enc=3DES 168 Mac=SHAI
DES-CBC3-MDS5 SSLv2 Kx=RSA Au=RSA Enc=3DES 168 Mac=MD5
ADH-AES128-SHA SSLv3 Kx=DH Au=None Enc=AES 128  Mac=SHAI
DHE-RSA-AES128-SHA SSLv3 Kx=DH Au=RSA Enc=AES 128  Mac=SHAI1
DHE-DSS-AES128-SHA SSLv3 Kx=DH Au=DSS Enc=AES 128  Mac=SHAI1
AES128-SHA SSLv3 Kx=RSA Au=RSA Enc=AES 128  Mac=SHAI1
RC2-CBC-MD5 SSLv2 Kx=RSA Au=RSA Enc=RC2 128  Mac=MDS5
DHE-DSS-RC4-SHA SSLv3 Kx=DH Au=DSS Enc=RC4 128  Mac=SHAI1
RC4-SHA SSLv3 Kx=RSA Au=RSA Enc=RC4 128  Mac=SHAI
RC4-MDS5 SSLv3 Kx=RSA Au=RSA Enc=RC4 128  Mac=MDS5
RC4-MDS5 SSLv2 Kx=RSA Au=RSA Enc=RC4 128  Mac=MDS5
RC4-64-MD5 SSLv2 Kx=RSA Au=RSA Enc=RC4 64 Mac=MD5
EDH-RSA-DES-CBC-SHA SSLv3 Kx=DH Au=RSA Enc=DES 56 Mac=SHA1
EDH-DSS-DES-CBC-SHA SSLv3 Kx=DH Au=DSS Enc=DES 56 Mac=SHA1
DES-CBC-SHA SSLv3 Kx=RSA Au=RSA Enc=DES 56 Mac=SHA1
DES-CBC-MD5 SSLv2 Kx=RSA Au=RSA Enc=DES 56 Mac=MD5
EXP-EDH-RSA-DES-CBC-SHA SSLv3 Kx=DH(512) Au=RSA Enc=DES 40 Mac=SHA1
EXP-EDH-DSS-DES-CBC-SHA SSLv3 Kx=DH(512) Au=DSS Enc=DES 40 Mac=SHA1
EXP-DES-CBC-SHA SSLv3 Kx=RSA(512) Au=RSA Enc=DES 40 Mac=SHA1
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Valid SSL/TLS Ciphers

SSL Key- Key-

Full Name Ver. Exchange Authentication Encryption Size HMAC
EXP-RC2-CBC-MD5 SSLv3 Kx=RSA(512) Au=RSA Enc=RC2 40 Mac=MD5
ADH-DES-CBC3-SHA SSLv3 Kx=DH Au=None Enc=3DES 168 Mac=SHAI
ADH-DES-CBC-SHA SSLv3 Kx=DH Au=None Enc=DES 56 Mac=SHA1
EXP-ADH-DES-CBC-SHA SSLv3 Kx=DH(512)  Au=None Enc=DES 40 Mac=SHA1
ADH-RC4-MD5 SSLv3 Kx=DH Au=None Enc=RC4 128  Mac=MD5
EXP-ADH-RC4-MD5 SSLv3 Kx=DH(512)  Au=None Enc=RC4 40 Mac=MD5
EXP-RC2-CBC-MD5 SSLv2 Kx=RSA(512) Au=RSA Enc=RC2 40 Mac=MD5
EXP-RC4-MD5 SSLv3 Kx=RSA(512) Au=RSA Enc=RC4 40 Mac=MD5
EXP-RC4-MD5 SSLv2 Kx=RSA(512) Au=RSA Enc=RC4 40 Mac=MD5
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Pinouts and Cabling
Diagrams

Console Port Pinout

The RJ-45 console port on the MCR-MGT Management Module has a standard “Cisco” pinout as
defined below.

Pin order:

Pin 1 Pin 8

s

Pin#  Pin Description
1 RTS (out)

DTR (out)

TxD (out)

GND

GND

RxD (in)

DSR (in)

CTS (in)

Pinout:

(eI B LY, B N VS I (O]
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Auto-Config Switch

The default jumper setting is Auto mode. Jumper the top and middle Pin to select Auto mode. Jumper
the middle and bottom Pin to select SW mode.
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Troubleshooting

General Troubleshooting

o Ensure that any Media Converter Modules and MCR-MGT Management Modules are securely
seated in the Chassis of the MCR1900 or the SMI Media Converter.

® If the media converter module is a managed module and it is detected as an unmanaged module,
then carefully pull the module out of the chassis and re-insert the module securing it to the front
face plate of the chassis.

Ensure all cabling is of the correct type and is in good working order.

Ensure the remote device’s fiber connection type is compatible with the Media Converter
Module. If using a simplex fiber connection, ensure that you have both an Upstream (U) and
Downstream (D) Media Converter Module.

® For duplex fiber connections, ensure the RX and TX has been reversed between the two Media
Converter Modules.

No Connectivity

If unable to get full connectivity with the Media converter Modules and all their DIP switches are in
the UP position, then this procedure is recommended for troubleshooting.

Method 1

1. Set the Link mode to Standard to ON on both Media Converter Modules. Leave all other
switches in the UP position.

2. Connect the near end device to the copper connection. The LKC LED indicates good copper
connection. If the LKC LED is not lit, then check the copper cable and the attached device.
Repeat for the far end Media Converter Module.

Connect the fiber cable to both Media Converter Modules. The LKF LED indicates good fiber
connection. If no LKF LED then check the fiber cabling. Ensure the transmitter and receiver
pairs are crossed.

5. Return modules to their desired configuration.

Method 2

The fiber connection can also be verified by configuring the remote Media Converter Module for
loopback mode. The LKF LEDs on both Media Converter Modules should be lit. Data should pass
through the local converter, over the fiber connection to the remote Media Converter. At the remote
Media Converter Module, the data will be looped back and passed through the fiber, back to the local
Media Converter Module and passed to the copper link.
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Communication Issues

Communication Issues

‘Webmanager screen appears garbled.
® Press and hold Ctrl, then press F5 or clear the cache memory on your browser.
General communication checks and practices are as follows:

® Are your cables connected and correctly configured? If you are using EIA-232, see to verify that
your cables are correctly configured.

® Can you ping your host? If you can ping but packet loss is reported, ping another host/device on
the same network. This will tell you whether the problem is specific to the host/device or general
to the network.

e After entering or changing IP information for your MCR-MGT Management Module, reboot the
MCR-MGT Management Module does not apply when using BOOTP or DHCP). Once the
Management Module has rebooted, other network devices should be able to communicate with it
(ping, telnet, etc.). Also, protocols such as ARP and proxy-ARP will work properly.

Use the show routes command (command line only). Is there a route to the host?

If the MCR Web Manager cannot communicate with the Management Module, verify that the
service is enabled under Administration, Access, HTTP and/or HTTPS are enabled for the MCR
Web Manager. If you are using only HTTPS, the connection URL must start with https://.

Host Problems

Cannot access a host by name:

e Ifusing DNS or if DNS is required, ensure a nameserver is configured on your MCR-MGT
Management Module and is accessible (ping it).

® If not using DNS, verify that the host is configured in the Host Table. Check access to the host
by pinging it using the host’s IP address.

Cannot access a host on a local network, verify:

® The network address is correct.

® The subnet mask is set correctly and reflects the network configuration.

® The broadcast address is set correctly and reflects the network configuration.
Cannot access a host on a remote network:

® Use the show route command to verify that there is a route to the remote host. If no gateway is
specified, verify that a default gateway is specified. Ping the default gateway to check if it is
working.

e Consider the situation beyond the gateway; for example, are intermediate gateways and the
remote host available? Also, check the messages returned by the ping command; for example,
that a particular host or gateway is unreachable.

Access to host lost after a few minutes.

e If the route to this host goes through routers, make sure those routers are all sending RIP packets
across the networks.

RADIUS Authentication Problems

User is waiting up to 60 seconds before login is accepted or denied and Authentication is set to
RADIUS. User has entered User Name and Password, and has pressed Enter.

® Check RADIUS configuration of primary and secondary authentication/accounting hosts
specified, if you have retry and timeout values greater than the default, the Management Module
be spending time trying each of these hosts and keeping the user waiting.
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Unknown IP Address

Adjust RADIUS configuration: specify just one host, reduce Timeout and Retry values to the
default or less than default.

You cannot progress beyond the login and password prompts when authentication is set to
RADIUS:

On the RADIUS host, check the secret (password), you should see it displayed in clear text in the
RADIUS clients file. If you are unsure whether it is the same secret which you entered in the
Management Module, go to the Management Module and re-enter a new secret.

On the RADIUS host, verify that there is only one entry for a particular user; do not have
multiple entries of the same user name (even if the passwords are different).

Unknown IP Address

You don’t know the IP address of the Management Module so you cannot obtain a successful
login.

SSL/TLS

Review Chapter 2, "Setting IP Addresses".

Could not obtain peer's certificate.

You have selected a cipher key exchange of ADH (anonymous Diffie-Hellman) and enabled Peer
verification. ADH does not use certificates so they will not be sent in an SSL/TLS handshake.
Disable Peer Verification or change to a cipher suite that uses certificates.

You have selected Peer Verification on the configured SSL/TLS server and have not configured
a certificate for the client. Either disable peer verification on the SSL/TLS server or configure a
certificate for the SSL/TLS client.

Certificate did not match configuration

The message is displayed when Validate Peer Certificate has been enabled, but the configured
Validation Criteria does not match the corresponding data in the certificate received from the
peer. The data configured must match exactly to the data in the certificate. The data is also case
sensitive.

tlsvl alert handshake failure or sslv3 alert handshake failure

The remote site has an SSL/TLS error and is sending this message with an alert message. Look at
the error messages on the remote end and fix the problem indicated.

IPv6 Issues

You are not seeing the IPv6 address value when you attempt to connect to the MCR-MGT
Management Module.

Windows Vista and Server 2008 operating systems have IPv6 support already enabled, however, you
will have to install IPv6 support for Windows XP.

To install IPv6 support in Windows XP, do the following:

AN I S e

In Control Panel, double-click the Network Connections icon.

Double-click the Local Area Connection entry.

In the Local Area Connection Status window, click the Properties button on the General tab.
In the Local Area Connections window, click the Install button on the General tab.

In the Select Network Component Type window, select Protocol and click the Add button.

In the Select Network Protocol window, select Microsoft TCP/IP version 6 and click the OK
button.
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Contacting Technical Support

Contacting Technical Support

Making a Technical Support Query

Contact information for the Perle Technical Assistance Center (PTAC) can be found at the link
below. A Technical Support Query may be made via this web page.

http://www.perle.com/support_services/support_request.shtml

Warranty / Registration

Perle’s standard Lifetime Warranty provides customers with return to factory repairs for Perle
products that fail under the conditions of the warranty coverage. Details can be found at

http://www.perle.com/support_services/warranty.shtml

Feedback on this Manual

If you have any comments or suggestions for improving this manual please email Perle using the
following address:

Email: ptac@perle.com

Please include the title, part number and date of the manual (you can find these on the title page at
the front of this manual).
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Symmetric Key File

Symmetric Key File

This section defines the layout of the SNTP Symmetric Key file that must be downloaded to the
management card in order to use the SNTP server authentication feature. Each line of the SNTP
symmetric key file consists of three fields: a key ID in the range 1 to 65,534, inclusive, a key type

and a message digest key consisting of a printable ASCII string equal to or less than 20 characters or
a 40 character hex digit string.

key ID key type

message digest key

1

o NN AN W B W

MD5
MD5
MD5
MD5
SHA1
SHA1
SHA1
SHA1

CeR{+’9LRTY:a0=P?GOA
POE)+’9KRMY:P0-PZOQ

E)+’9KRRTS {+’9LRTpp
ECeE)+’9KRDSRuurQPiw
0e9e44502940294fa788aafaac34ccb126347d34
f4e9e4454¢9¢4450294faccb126309ff4ccb1200
€9¢44502949¢4450294ccb12634e9e¢447d3489
402941a7894faccb126502944fac4e9e788aataa

ascii string
ascii string
ascii string
ascii string
hex digit string
hex digit string
hex digit string
hex digit string

Note:

Note:1-10 key ID entries are allowed in this SNTP key file. Both MD5 and SHA1 are

supported. Key ID 0 is excluded.
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